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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may 
only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

Part of the software embedded in this product is gSOAP software.

Portions created by gSOAP are Copyright (C) 2001-2004 Robert A. van Engelen, Genivia inc. All Rights Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This document is protected under copyright law. An authorized licensee of Avid ISIS | 7500 - 7000 may reproduce this publication for 
the licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, 
for commercial purposes, such as selling copies of this document or providing support or educational services to others. This 
document is supplied as a guide for Avid ISIS | 7500 - 7000. Reasonable care has been taken in preparing the information it 
contains. However, this document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does 
not accept responsibility of any kind for customers’ losses due to the use of this document. Product specifications are subject to 
change without notice.

Copyright © 2014 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is 
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the 
software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or 
publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, 
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING 
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are 
duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and 
use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be 
used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS 
PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

http://www.avid.com/US/about-avid/legal-notices/patent-marking
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Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the 
above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting 
documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software 
without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any 
purpose. It is provided "as is" without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire 
notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the 
supporting documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, 
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable 
for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of 
reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or 
consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s products or the 
software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised, 
knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this 
software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source 
Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party 
Software directory on the installation CD.

http://www.apache.org/
http://jcifs.samba.org/
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Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection 
with Avid Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a 
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the 
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, Assistant 
Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid 
DNxHD, Avid DS Assist Station, Avid Ignite, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, Avid Mojo, Avid 
Remote Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, Beat Detective, Beauty 
Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Bruno, C|24, CaptureManager, ChromaCurve, 
ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, Command|24, Command|8, 
Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, D-Command, D-Control, Deko, DekoCast, D-Fi, D-fx, Digi 002, Digi 003, 
DigiBase, Digidesign, Digidesign Audio Engine, Digidesign Development Partners, Digidesign Intelligent Noise Reduction, 
Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial, DigiSnake, DigiSystem, Digital 
Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange, Do More, DPP-1, D-Show, DSP 
Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, Euphonix, EUCON, EveryPhase, Expander, 
ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame Chase, FXDeko, 
HD Core, HD Process, HDpack, Home-to-Hollywood, HYBRID, HyperSPACE, HyperSPACE HDCAM, iKnowledge, Image 
Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS ControlAir, InGame, Instantwrite, Instinct, Intelligent Content 
Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, Intelli-sat Broadcasting Recording Manager, InterFX, 
Interplay, inTONE, Intraframe, iS Expander, iS9, iS18, iS23, iS36, ISIS, IsoSync, LaunchPad, LeaderPlus, LFX, Lightning, Link & 
Sync, ListSync, LKT-200, Lo-Fi, MachineControl, Magic Mask, Make Anything Hollywood, make manage move | media, Marquee, 
MassivePack, Massive Pack Pro, Maxim, Mbox, Media Composer, MediaFlow, MediaLog, MediaMix, Media Reader, Media 
Recorder, MEDIArray, MediaServer, MediaShare, MetaFuze, MetaSync, MIDI I/O, Mix Rack, Moviestar, MultiShell, NaturalMatch, 
NewsCutter, NewsView, NewsVision, Nitris, NL3D, NLP,  NSDOS, NSWIN,  OMF, OMF Interchange, OMM, OnDVD, Open Media 
Framework, Open Media Management,  Painterly Effects, Palladium, Personal Q, PET, Podcast Factory, PowerSwap, PRE, 
ProControl, ProEncode, Profiler, Pro Tools, Pro Tools|HD, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, QuickPunch, 
QuietDrive, Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket 
Surfer, Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, ScriptSync, 
SecureProductionEnvironment, Serv|GT, Serv|LT,  Shape-to-Shape, ShuttleCase, Sibelius, SimulPlay, SimulRecord, Slightly Rude 
Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, SoundReplacer, SPACE, SPACEShift, SpectraGraph, SpectraMatte, 
SteadyGlide, Streamfactory, Streamgenie, StreamRAID, SubCap, Sundance, Sundance Digital, SurroundScope, Symphony, SYNC 
HD, SYNC I/O, Synchronic, SynchroScope,  Syntax, TDM FlexCable, TechFlix, Tel-Ray, Thunder, TimeLiner, Titansync, Titan, TL 
Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, 
tools for storytellers, Transit, TransJammer, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Video the Web Way, VideoRAID, 
VideoSPACE, VTEM, Work-N-Play, Xdeck, X-Form, Xmon and XPAND! are either registered trademarks or trademarks of Avid 
Technology, Inc. in the United States and/or other countries.

Apple, Macintosh, and Safari are either registered trademarks or trademarks of Apple Computer, Inc., registered in the U.S. and 
other countries. HP is a registered trademark of Hewlett-Packard Company. Intel is a registered trademark of Intel Corporation. Java 
is a trademark of Sun Microsystems in the United States and/or other countries. Kingston is a registered trademarks of Kingston 
Technology Corporation. All other marks may be the property of their respective titleholders. Windows is either a registered 
trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other trademarks contained herein 
are the property of their respective owners. 

Avid ISIS | 7500 - 7000 Setup Guide • 0175-30978-00 Rev. E • October 2014 • Revised 10/30/14



5

Contents

Using This Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  12

Symbols and Conventions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  12

If You Need Help. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13

Accessing the Online Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13

Avid Training Services  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  14

Chapter 1 Avid ISIS | 7500 - 7000 System Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . .  15

Hardware Overview and Naming Convention . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15

System Director. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17

System Director Front Panel  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  18

System Director Rear Panel. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19

Second System Director. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20

Engine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20

Engine Front View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20

Engine Rear View. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21

Power Supplies  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  22

Integrated Ethernet Switches . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  22

Storage Configurations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23

Storage Group Size . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  24

Chunk Size Support With ISB . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  24

Adding an ISB to the File System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  24

Adding or Removing ISBs (Mirrored or RAID). . . . . . . . . . . . . . . . . . . . . . . . . .  24

Mirrored Storage Groups, Single ISB Failure  . . . . . . . . . . . . . . . . . . . . . . . . . .  25

RAID-6 Storage Groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  25

RAID-6 Storage Groups, Single ISB Failure . . . . . . . . . . . . . . . . . . . . . . . . . . .  26

RAID-6 Storage Groups, Dual ISB Failure  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27

Automatic Redistribution on Disk Failure  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27

Client . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28

Network Zone Configurations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28

Zone 1 Clients (Direct Connected) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29



6

10 Gb Client Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31

Zone 2 Clients (Indirect Connect) Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . .  31

Zone 1 and Zone 2 Clients Mixed Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . .  33

Zone 3 and Zone 4 Client Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  34

Link Aggregation Support. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  35

Cabling  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  35

Connecting the Engine CX-4 Cable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  36

Removing the Avid Engine Interconnect Cable . . . . . . . . . . . . . . . . . . . . . . . . . . . .  36

 10 Gb Link Aggregation Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37

Link Aggregation Support. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37

Load Balancing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  38

Failover. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  38

Recommended Topologies  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39

Supported Functionality . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39

Other Functionality . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39

Chapter 2 Avid Software and Hardware Install Checklist . . . . . . . . . . . . . . . . . . . . . . .  40

Software Upgrade . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40

Hardware Upgrade . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  42

New System Director and Engine Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  42

Switch and ISB Upgrade Utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44

Recreating a File System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44

Chapter 3 Installing the ISIS System. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  46

Rack-Mounting the Equipment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  46

Rack-Mounting Examples  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  46

Installing Rack-Mount Rails and Brackets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  49

Rack-mount Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  50

Positioning the System Director in the Rack . . . . . . . . . . . . . . . . . . . . . . . . . . .  51

Separating the Slide Rails . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  51

Attaching Inner Slide Rails to the System Director . . . . . . . . . . . . . . . . . . . . . .  52

Attaching the Outer Rails to a Square-Hole Rack . . . . . . . . . . . . . . . . . . . . . . .  53

Attaching the Outer Rails to a Round-Hole Rack  . . . . . . . . . . . . . . . . . . . . . . .  55

Securing the System Director in a Rack . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  57

Mounting the Engine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  58



7

Installing Blades and Power Supplies . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59

Installing IXS and ISS Switches . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  60

Connecting a Keyboard, Monitor, and Mouse. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  61

Connecting the Optional Application Key . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  62

Connecting Power to Equipment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  62

Connecting Power Cords . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  63

Three 20 Amp V AC Circuits for Three Engines. . . . . . . . . . . . . . . . . . . . . . . . . . . .  63

Three 20 Amp V AC Circuits for Two Engines . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  64

Two 20 Amp V AC Circuits for Two Engines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  65

Turning System On and Off . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  65

Connecting ISIS Hardware . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  66

Engine Configuration v2.x Hardware Guidelines . . . . . . . . . . . . . . . . . . . . . . . . . . .  67

Setting Up Network Addresses In the Stack  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  67

Two-Engine Stacking . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  69

Three- to Twelve-Engine Stacking Summary With v2.x Switches . . . . . . . . . . . . . .  71

Three- to Twelve-Engine Connections With v2.x Switches . . . . . . . . . . . . . . . . . . .  73

Hi-Gig Link Aggregation Group  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  79

Chapter 4 Installing Software and Configuring 10 Gb Link Aggregation  . . . . . . . . . .  80

IP Addressing Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  80

Configuration Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  83

Software Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  84

Loading the Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  84

Activating the License Key . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  85

Installing the Optional Application Key . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  86

Creating an Active File System on the System Director. . . . . . . . . . . . . . . . . . . . . .  86

Binding the Storage Managers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  88

Checking the Status of the System Director. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  89

Installing Software on the Engines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  90

Engine Does Not Appear in Add Engine List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  93

Check Switch IP Address . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  93

Loading Client Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  94

Configuring a 10 Gb Link Aggregation Group . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  94



8

Chapter 5 Avid ISIS Software Licensing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97

What You Need to Activate the ISIS Software License. . . . . . . . . . . . . . . . . . . . . . . . . .  98

License Activation Using an Internet Connection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  98

License Activation Without an Internet Connection. . . . . . . . . . . . . . . . . . . . . . . . . . . .  100

Deactivating the License . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  103

License Requirement with Host Name Change  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  103

Chapter 6 Configuring Two Stacks of ISIS Engines  . . . . . . . . . . . . . . . . . . . . . . . . . .  104

ISIS Two Stack Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  105

External Switch Link Aggregation Connection Guidelines . . . . . . . . . . . . . . . . . . .  107

IP Address Classes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  108

IP Addressing With Two Stacks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  108

Static IP Addresses Available . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  110

Connecting Two Stacks of Engines  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  110

Setting Up Two Stacks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  111

Reconfiguring One Stack into Two Stacks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  111

Chapter 7 Configuring System Director Failover. . . . . . . . . . . . . . . . . . . . . . . . . . . . .  114

System Director Failover. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  114

Enabling a System Director . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  115

Setting IP Addresses for Crossover Link  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  116

Configure a Failover Connection. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  116

Stopping and Restarting the System Directors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  122

Chapter 8 Status LEDs and Stacking Problems  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  124

LED Locations and Colors  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  124

LED Summaries  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  125

Recovering from Stacking Problems. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  127

Set One Switch Back to Default . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  127

Rebuilding the Stack  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  128

Chapter 9 Avid ISIS | 7500 - 7000 Pre-Upgrade Information . . . . . . . . . . . . . . . . . . . .  130

Zone 2 Switch Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  130

System Director Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  131

ISIS Engine/Switch Information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  131

On Site Spares . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  134

Spares Checklist . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  135



9

Additional spares for a comprehensive spares parts list: . . . . . . . . . . . . . . . . . . . .  135

Chapter 10 Avid ISIS | 7500 - 7000 Upgrade Guidelines . . . . . . . . . . . . . . . . . . . . . . . .  136

Health Check. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  136

Software Upgrade . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  137

Component Requirements From Previous ISIS | 7500 - 7000 Releases . . . . . . . .  138

ISIS | 7500 - 7000 Upgrades . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  138

Copying the Metadata to the New Default Location On the System Director  . . . .  140

Avid ISIS Software Installation From the USB Flash Drive  . . . . . . . . . . . . . . . . . .  142

Intel Network Driver and BIOS Update. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  143

64-bit System Director BIOS Upgrade. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  143

Intel RAID Controller Driver Update  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  144

Record IP Addresses on the System Director . . . . . . . . . . . . . . . . . . . . . . . . . . . .  146

System Director Intel Pro Driver Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . .  146

Post Upgrade System Verification  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  147

Chapter 11 Avid ISIS Upgrade Utility  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  151

Overview and Requirements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  151

Functional Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  151

Software Component Design . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  152

Software Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  153

FTP Server Section  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  154

Install Control Section  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  154

Monitoring Section . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  155

Running the Avid ISIS Upgrade Utility  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  155

Chapter 12 Avid ISIS Recommended Maintenance . . . . . . . . . . . . . . . . . . . . . . . . . . . .  157

Minimum Storage Space Requirement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  157

Daily Maintenance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  158

Weekly Maintenance. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  159

Monthly Maintenance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  160

Redistribution Guidelines  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  160

Windows Event Logs. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  161

Layer 2 and Layer 3 Switch Error Status  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  161

Local System Director Drives . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  162

Saving ISIS Metadata . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  162



10

Available Utilities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  163

Client Manager Maintenance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  163

Status Indicators and Troubleshooting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  163

Complete Server Room Shutdown. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  163

False Link Aggregation Alerts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  164

Symptoms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  164

Displayed Link Alert Message . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  164

Restart All Procedure  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  165

10 GbE Link Aggregation Maintenance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  167

Disabling Link Aggregation During Engine Maintenance or Reboots . . . . . . .  168

Chapter 13 Adding and Replacing Hardware . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  169

Adding Hardware  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  169

Adding an Engine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  170

Replacing an Engine Switch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  171

Replacing an Engine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  172

Replacing the System Director . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  174

Replacing the Network Switch  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  178

Appendix A Using the Product Recovery USB for 64-bit System Directors. . . . . . . . .  180

Reinstalling the Windows Storage Server 2008 R2 Operating System  . . . . . . . . . . . .  181

Configuring the System Drive Using Windows 2008 Storage Server Setup . . . . . . . . .  182

Appendix B Specifications and Notices. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  184

Dimensions and Weight  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  184

Environmental . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  184

Electrical . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  185

Uninterruptible Power Supply (UPS). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  185

Supported Cabling  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  185

Appendix C Safety and Regulatory Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  189

Warnings and Cautions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  190

Proposition 65 Warning. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  190

FCC Notice . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  190

Class A Equipment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  191

Modifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  191

Cables  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  191



11

Canadian Notice (Avis Canadien) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  191

Class A Equipment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  191

LED Safety Notices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  191

European Union Declaration of Conformity. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  192

Disposal of Waste Equipment by Users in the European Union . . . . . . . . . . . . . . . . . .  194

Argentina Conformity  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  194

Australia and New Zealand EMC Regulations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  195

Japan EMC Regulations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  195

Class A Equipment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  195

Korean EMC Regulations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  195

Class A Equipment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  195

Class B Equipment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  196

Taiwan EMC Regulations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  196

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  201



Using This Guide

The Avid ISIS® media network provides a high-performance distributed file system that contains 
high-capacity shared media storage for workgroups of connected Avid® editing workstations.

n This document describes the features for all Avid ISIS | 7500 - 7000 shared storage networks. 
Therefore, your system might not contain certain features that are covered in the documentation.

Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in this document or on the unit itself when 
handling electrical equipment.

> This symbol indicates menu commands (and subcommands) in the 
order you select them. For example, File > Import means to open the 
File menu and then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

(Windows) or (Macintosh) This text indicates that the information applies only to the specified 
operating system, either Windows or Macintosh OS X.

Bold font Bold font is primarily used in task instructions to identify user interface 
items and keyboard sequences.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.
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If You Need Help
If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is 
especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation was 
published.

Always check online for the most up-to-date release notes or ReadMe because the 
online version is updated whenever new information becomes available. To view the 
online versions, visit the Knowledge Base at www.avid.com/US/support.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/US/support. Online services are 
available 24 hours per day, 7 days per week. Search this online Knowledge Base to find 
answers, to view error messages, to access troubleshooting tips, to download updates, and to 
read or join online message-board discussions.

Accessing the Online Documentation

The Avid ISIS online documentation contains all the product documentation in PDF format. You 
can access the documentation in the AvidISISDocumentation folder on the Avid ISIS installer 
kit. Download and install Acrobat Reader on your Avid ISIS before you can access the PDF 
documentation.

To access the online documentation from the installer kit:

1. Insert your Avid ISIS USB flash drive with the Avid ISIS software kit into the USB port.

2. Navigate to the [USB flash drive]:\.AvidISISDocumentation folder, and double-click the 
PDF file for the document you want to view.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the 
mouse action. For example, Command+Option+C or Ctrl+drag.

Symbol or Convention Meaning or Action

http://www.avid.com/US/support
http://www.avid.com/US/support
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Avid Training Services
Avid makes lifelong learning, career advancement, and personal development easy and 
convenient. Avid understands that the knowledge you need to differentiate yourself is always 
changing, and Avid continually updates course content and offers new training delivery methods 
that accommodate your pressured and competitive work environment.

For information on courses/schedules, training centers, certifications, courseware, and books, 
please visit www.avid.com/support and follow the Training links, or call Avid Sales at 
800-949-AVID (800-949-2843).

http://www.avid.com/support


1 Avid ISIS | 7500 - 7000 System Overview

The Avid ISIS® system enables multiple clients to capture, play, and edit video and audio media. 
This chapter provides an overview of the Avid ISIS | 7500 - 7000 system and the basic function 
of each Avid hardware component within the system. 

This guide describes how to connect cables between components that create a basic system and 
then how to connect more than one basic system together to create a larger, redundant system.

n To prepare your site for installation of an Avid ISIS system, see the Avid Products and Network 
Site Preparation Guide on the Avid Knowledge Base or included in the documentation folder on 
the top level of the Avid ISIS installer software installer kit.

Hardware Overview and Naming Convention

Each system component has a specific Avid name that defines its function. Become familiar with 
these terms while using the documentation. The following table, used in conjunction with the 
figure that follows the table, provides the actual nomenclature and the terms used in this guide to 
describe that nomenclature:

Product name Term used and description

Avid ISIS shared storage network System or shared network storage environment

The Avid ISIS consists of the hardware, Avid software, 
and other hardware supplied by the customer, such as 
external Ethernet® switches. 
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Although there are many components in Avid ISIS shared storage network, the basic 
components needed to create the system are a System Director, an engine containing ISIS 
Integrated Switch (ISS), ISIS Expansion Switch (IXS), ISIS Storage Blades (ISB), and one or 
more clients.

The second generation ISIS switches are branded with an IXS2000 and ISS2000 silk-screen. If 
your IXS and ISS switches are not labeled, consider them the earlier versions.

c You cannot mix new switches (labeled IXS2000 and ISS2000) with original switch 
hardware (labeled IXS1000 and ISS1000). All switches in the engine, and engines in the 
stack must be from the same generation of hardware.

Avid ISIS client Client, defined as a user’s workstation or server with 
Avid ISIS client software that allows that system to 
mount workspaces

Avid ISIS storage blade 
(labeled i500, i1000, i2000, i4000, i8000)

ISIS Storage Blade (ISB)

This hot swappable sled is accessible from the front of 
the ISIS engine and contains two SATA drives. 

Avid ISIS Integrated Ethernet switch blade ISIS Integrated Switch (ISS) 

This hot swappable switch is accessible from the rear of 
the ISIS engine and connects 1 Gb and 10 Gb clients. The 
ISS2000 indicates second generation hardware; first 
generation hardware is labeled ISS1000.

Avid ISIS Expansion Integrated Ethernet 
switch blade

ISIS Expansion Switch (IXS) 

This hot swappable switch is accessible from the rear of 
the ISIS engine and is used to stack multiple ISIS 
engines. The IXS2000 indicates second generation 
hardware; first generation hardware is labeled IXS1000.

Integrated power supply and cooling fans Power supplies

Three hot swappable power supplies are accessible from 
the rear of the ISIS engine.Two power supplies are 
required to power the ISIS engines.

Avid ISIS engine Called Chassis in the software interface

Contains the ISBs, ISSs, IXSs, power supplies, and an 
internal midplane.

Avid ISIS System Director (Active and 
Standby)

System Director, a server connected to the ISIS engine to 
manage the data and portions of the metadata

Product name Term used and description
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The Avid ISIS documentation refers to IXS2000 and ISS2000 switches as v2.x hardware and 
IXS1000 and ISS1000 switches as v1.x hardware. 

Basic Avid ISIS | 7500 - 7000 Shared Storage Network Hardware

System Director

The System Director is 1U in size (see “System Director Front Panel” on page 18) and manages 
the metadata by storing directory information and file attributes. The System Director does not 
store the data used by share clients (for example media files); these data files are stored on the 
ISBs within the engine. 

n The System Director password is preset to is-admin. The System Director Web Page 
Administrator user has no default password (password is blank).

You can have two System Directors configured in a redundant configuration, one Active and the 
other Standby. If the Active System Director goes down, the Standby System Director takes over. 
You need at least one System Director to run the Avid ISIS system.

System Directors, workgroup servers, and clients must all be synchronized with a common time 
of day. For information on setting the Network Time Protocol (NTP), see “Setting Up Network 
Addresses In the Stack” on page 67.

System Director front view

Rear view Front view

ISIS Integrated Switch (ISS)

ISIS Integrated Expansion Switch (IXS)

ISIS Storage Blade (ISB)

Power supply

Engine

ID
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The System Director provides a location to coordinate file access modes (read/write), file 
locking, range locking, performance data collection, logging, file lookup, and directory change 
tracking for client systems. The System Director provides:

• Identity of all storage elements connected to the system

• Information about the ISS and IXS modules in the configuration.

• List of workspaces including names and unique ID numbers

• List of users and groups within the system

• Identity of all System Directors in the system (if more than one)

System Director Front Panel

The following figure shows the front view and control panel of the System Director.

System Director Front View 

The following table describes the control panel shown in the previous figure.

System disk (ID 1)System disk (ID 0)

ID

ID

Control panel

B CA G HD FE

HALT RST

System Control Panel

Letter Component Description

A Universal Serial Bus (USB) port USB 2.0 device port on the front of the system supports one USB 
device. Recommended for use when re-imaging the system drives or 
loading software. Two more USB ports are located on the back of the 
system.

B Halt or Non-maskable interrupt 
(NMI) button

The halt or NMI signal halts the processor, which effectively halts 
the server. An NMI is the highest priority interrupt and cannot be 
masked by software. 

c If the Halt/NMI button is pressed, the NMI signal locks the 
system and the system must be restarted to clear the 
interrupt.
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System Director Rear Panel

The following figure shows the rear panel of the System Director and the function of each 
connection.

System Director Rear View 

C System reset button Preforms a soft reset when pressed. Do not use this button unless the 
system has had a fatal error and must be restarted. A soft reset 
restarts the system; it clears all active program memory (you lose 
unsaved work) and shuts down all active programs.

D Four green network activity 
LEDs

Illuminates green when a good network connection is established and 
blinks when there is network activity on the four built-in 1 GB 
network ports.

The number beside the LED corresponds with the number beside the 
network port on the rear of the enclosure. For example, Connector 1 
is LED 1 on the front. See “System Director Rear Panel” on page 19.

E Red System error LED Illuminates red when an error is detected with the system (fan, power 
supply, temperature, voltage).

F System Drive activity LED Indicates drive activity from the onboard SATA controller and blinks 
when either of the system drives is being accessed.

G System ID button When pressed it illuminates (blinks) blue and also illuminates an 
LED on the rear of the enclosure. The rear LED is also blue and is 
visible on the lower left-hand side of the Ethernet ports inside of the 
enclosure. This LED helps you to identify a system for servicing 
when it is installed in a high-density rack/cabinet populated with 
several other similar systems.

H Power button Press to turn on the enclosure. Power button illuminates green when 
the power is on.

System Control Panel

Letter Component Description

Power supplies Slots not used

Serial 1 Gb Ethernet VideoUSB
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Second System Director

You can purchase a second System Director and configure it on the same subnets as the original 
System Director. This provides a redundant System Director that is in constant contact with the 
original System Director. The second System Director automatically takes over if the original 
System Director fails (called failover). 

n For true redundancy connect the second System Director to a different engine than the first 
System Director. The Active and the Standby System Directors must be the same model server; 
you cannot mix SR2500 and AS3000 servers.

Engine

The engine contains the ISBs, ISSs, IXSs, power supplies, and an internal midplane. The engine 
stores the data created and shared by the clients. The data is passed in and out of the engine 
through the switches. 

The engine components have the following properties and functions:

• ISBs can support either 250 GB, 500 GB, 1 terabyte (TB), 2 terabyte, or 4 terabyte drives, 
with two drives in each ISB. The drive size is identified by the label on the front of the ISB 
(i500, i1000, i2000, i4000, i8000). As technology advances, the storage capacity of the 
drives could increase, allowing the total storage per ISB/engine to increase. 

• An ISS provides connections for clients though 1000BASE-T Ethernet ports. A 10 Gb 
Ethernet port using SFP+ transceivers connects clients or serves as an uplink port. The ISS 
has an engine interconnect port and a management port for configuration. See “Integrated 
Ethernet Switches” on page 22.

• An IXS connect multiple engines (one IXS for each subnet), providing up to 384 TB of 
storage, or 192 TB of mirrored storage. See “Integrated Ethernet Switches” on page 22.

Engine Front View

The front of the engine allows access to the 16 ISBs. The first is in the upper left portion of the 
front and the last ISB is in the lower right.
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Each ISB can be removed and replaced separately with the power on. 

n If you replace an ISB with power on, the LEDs in all of the ISBs go off momentarily. This does 
not represent a problem. All functions are still active and working properly.

Engine Rear View

The following figure shows the rear of the engine in a configuration that contains the following: 

• Three power supplies (with fans)

• Integrated Switch blade (ISS)

• Integrated Expansion Switch blade (IXS) 

n In a basic configuration containing two engines, each of the engines contains two ISS modules. 
The IXS module is used with an ISS module in an engine only when the configuration exceeds 
two engines.

Fifth ISB

First ISB

Power 
supplies

IXS moduleISS module

1 2 3 4 5 6 7 8

1 2  3 4 5  6

7  8 9 10 11
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Power Supplies

The power supplies are turned on when the power cord is plugged in; they do not have power 
switches. The power supplies not only provide power, but they also contain fans that cool the 
system. The system only needs two of three power supplies to supply the needed power to 
function properly. You can remove and replace a power supply temporarily while the system is 
running if one fails.

c Do not remove the failing supply until immediately before you replace it. Replace the 
power supply as soon as possible to maintain the proper airflow. 

w Only trained Avid technicians should remove and replace the power supply while the 
system is running. Since power to the system is still applied internally to the midplane 
always keep your hands outside the engine when a power supply is missing.

Integrated Ethernet Switches

The two integrated Ethernet switches, ISS and IXS, serve different purposes and contain 
different types of connections. You must have at least two switches in each engine for the system 
to operate.

ISS Module

The connections on the ISS module are used for the following:

• Management connection — used to configure the Avid engine hardware during installation. 
This information is used by Avid representatives to originally configure your system before 
turning it over to you.

• 1 Gb (RJ-45 cable) — direct connect for clients and the System Directors.

• High speed engine interconnect (CX-4 cable) — proprietary Avid bus that connects switch 
blades between engines allowing subnets to connect between the engines. 

• 10 Gb XFP or SFP+ MSA form factor transceiver (for Optical cable) — used for a 10 Gb 
connection to a switch or 10 Gb Ethernet clients.

w Use only an Avid recommended SFP+ transceiver in the 10 Gb XFP connection, and only 
Avid trained representatives should remove and replace the XFP transceiver. Avid 
currently supports Picolight XFP, Dell Networking XFP, and Foundry® XFP.
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IXS Module

The IXS is needed only if you are connecting three or more engines. When connecting three or 
more engines, two IXS modules are installed in one engine. The IXS offers the following 
connections:

• Management connection — used to configure the switch during installation and to monitor 
switch functions.

• High speed engine interconnect (Hi-Gig) — proprietary Avid interconnection that stacks the 
switches to create one large virtual switch.

n In a basic configuration containing one or two engines, each of the engines contains two ISS 
modules. The IXS module is used with an ISS module in an engine only when the configuration 
exceeds two engines.

Storage Configurations

A maximum of twelve Avid ISIS Engines can be stacked and populated with either 250 GB, 
500 GB, 1 terabyte (TB), 2 terabyte or 4 terabyte SATA drives. A fully populated Avid ISIS 
system with 1 TB drives provides up to 384 terabytes (TB) of storage, or 192 TB of mirrored 
storage. 

High speed engine 
interconnect (Hi-Gig)

Link

Activity

Management 
connection

Link
Activity

10-Gb connection1-Gb connections

Status

1 2 3 4 5 6 7 8

ACT LINK 10 GIG

Engine interconnections

Link

Activity

Management 
connection

1 2 3 4 5 6

7 8 9 1010 1111
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You can have mixed ISB drive sizes in an engine (250 GB, 500 GB, 1 TB, 2 TB, and 4 TB 
drives). You can even mix different size ISBs in a Storage Group. However, the larger ISBs in 
the mixed Storage Group use only the amount of storage that is available in the smaller ISBs.

Storage Group Size

Storage elements are combined to create Storage Groups in the ISIS file system. These Storage 
Groups can be configured to operate using 512 KB (default) or 256 KB chunk sizes. For more 
information about setting the chunk size, see the Avid ISIS Administration Guide.

n Avid ISIS switch hardware shipped with v1.x (ISS1000 and IXS1000) does not support 512 KB 
chunk sizes. If you have Avid ISIS v2.x software running on v1.x switches, you must select the 
256KB chunk size when adding storage elements to the file system to create Storage Groups.

You cannot change the chunk size of a Storage Group after it has been created. To use a different 
chunk size, you must delete the Storage Group and create a new one with the desired chunk size. 
The chunk size selection is available only when adding the storage elements. 

c When you delete Storage Groups all data on that Storage Group is lost.

Chunk Size Support With ISB

All ISBs (i500, i1000, and i2000, i4000 and i8000) with the latest v2.x switch hardware 
(ISS2000 and IXS2000) support the 512 KB chunk size. 

Adding an ISB to the File System

If you add an ISB (displays as an available storage element) to your file system, make sure you 
match the chunk size of the new storage element to the chunk size of the existing Storage Group. 
New storage elements are added with a default chunk size of 512 KB. You cannot mix chunk 
sizes within a Storage Group. To change the chunk size of an ISB, you must remove the new 
storage element from the file system and add the storage element again choosing the correct 
chunk size.

Adding or Removing ISBs (Mirrored or RAID)

When permanently adding or removing ISBs from an ISIS Storage Group it is recommended to 
do a full redistribution for all workspaces in the Storage Group, after the ISB add or remove is 
complete. Examples of permanent changes include adding or removing an engine to the storage 
stack.
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The full redistribution makes sure all blocks in the Storage Group are optimally distributed based 
on the new permanent configuration. Doing a full redistribution immediately after the change 
minimizes the chances of running into issues if a full redistribution is required in the future, such 
as the storage blades becoming full during a full redistribution and requiring you to delete files to 
allow the redistribution to complete.

This recommendation does not apply to the case of removing and then replacing failed storage 
blades. For other examples of symmetric and non-symmetric redistributions, see the Avid ISIS 
Performance and Redistribution Guide on the Knowledge Base at www.avid.com/US/support. 

Mirrored Storage Groups, Single ISB Failure

An “unprotected state” exists if you have a single ISB failure in a mirrored Storage Group. In an 
unprotected state with no additional failures, read operations continue to function normally.

However, in an unprotected state a subsequent or infrastructure failure will cause operational 
issues which could result in failures when writing new data or prevent you from accessing data 
in the Storage Group. An additional ISB failure compromises data accessibility. Networking 
issues, on the other hand, will not cause accessibility issues on previously written data but might 
prevent the successful completion of the active write operation.

This issue only applies when the Storage Group is in an unprotected state and the remove 
redistribution process on the failed ISBs has not been initiated. Therefore, Avid highly 
recommends initiating the remove redistribution process immediately upon confirmation of any 
ISB failure. This ensures immediate protection (RAID or mirroring) of new data being written, 
and full protection of all stored data at the earliest possible time.

RAID-6 Storage Groups

Avid ISIS | 7500 supports two types of data protection: mirrored and RAID-6 (redundant array of 
independent disks). RAID storage provides more storage at a lower cost per GB. Using the Avid 
Interplay Copy/Move service, data files can be moved between mirrored Storage Groups and 
RAID Storage Groups. RAID Storage Groups have the following advantages:

• Migration from mirrored to RAID workspaces can become part of your normal workflow. 
You can move data that is no longer used in the mirrored workspaces to RAID workspaces 
for longer term storage. This frees up faster storage elements (mirrored) for higher 
performance work. 

• RAID Storage Groups allow you to work on a lower resolution workflow at less cost.

• RAID Storage Groups increase available GB per physical engine from 50% of installed 
capacity in mirrored to 75% in RAID.

http://www.avid.com/US/support


Storage Configurations

26

RAID workspaces have the following restrictions:

• Requires a Storage Group with a 512 KB chunk size (256 KB chunk sizes are not 
supported).

• Requires ISIS v2.x generation switches (ISS2000/IXS2000) in the ISIS Engines (these 
switches are also required for 512 KB chunk sizes).

• Avid recommends RAID Storage Groups have a minimum of 16 ISBs (one engine). The 
Management Console allows you to create and use RAID Storage Groups with eight ISBs 
but in a RAID Storage Group of eight, you must add an ISB before you can remove an ISB.

• Avid ISIS client software versions before v2.1.1 are not supported with RAID.

• RAID workflows require specific releases of Avid products that support the workflow 
(AirSpeed Multi Stream, Avid editing applications, and Interplay); see the Avid ISIS 
ReadMe.

• Supports only resolutions that draw 16 MB/s (50 Mb/s) or less.

n For example, you can run two streams of DV 50 or DNxHD 36. Bandwidths are listed by 
resolution and number of streams on the Avid Knowledge Base. Search the Avid Knowledge Base 
for the Avid ISIS Performance and Redistribution Guide. 

• If a RAID Storage Group experiences two disk failures, no writes to any of the workspaces 
in that Storage Group are supported until the error condition is corrected.

• To do a non-symmetrical full redistribution, limit the bandwidth used by your clients in that 
Storage Group. For more detailed guidance, see the Avid ISIS Performance and 
Redistribution Guide on the Knowledge Base at www.avid.com/US/support. 

c Avid does not recommend a non-symmetric redistribution when your RAID Storage Group 
capacity exceeds 80%.

RAID-6 Storage Groups, Single ISB Failure

When a single ISB fails in an ISIS Storage Group configured with RAID protection, the Storage 
Group continues to function normally at a lower bandwidth. For more information see “Mirrored 
Storage Groups, Single ISB Failure” on page 25.

After confirming the failure of an ISB, initiate the remove redistribution process of the failed 
ISB immediately. There are two benefits to doing this: 

• All new writes to the Storage Group have the full benefit of RAID-6 protection (dual-parity 
protection). 

• Upon completion of the remove redistribution process, existing data in the Storage Group is 
once again fully protected. Prior to completion, if another ISB were to fail, the Storage 
Group would be in an unprotected state (though no data would be lost).

http://www.avid.com/US/support
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RAID-6 Storage Groups, Dual ISB Failure

An “unprotected state” exists if there are two failed ISBs in a RAID-6 Storage Group. In an 
unprotected state with no additional failures, read operations continue to function normally at a 
lower bandwidth. 

However, in an unprotected state, due to the distributed architecture of the ISIS file system 
(optimized for real-time performance), under certain circumstances that the system might be 
unable to correctly update the parity information when writing new data. As a result, the file 
system could return a failure status when writing. While the failure rate percentage on the total 
number of write operations is low, heavy workloads on the system would result in enough write 
failures to disrupt operations.

This issue only applies when the Storage Group is in an unprotected state and the remove 
redistribution process on the failed ISBs has not been initiated. Therefore, initiate the remove 
redistribution process of the failed ISB immediately upon confirmation of any ISB failure. This 
ensures immediate protection (RAID or mirroring) of new data being written, and full protection 
of all stored data at the earliest possible time.

Automatic Redistribution on Disk Failure

Avid ISIS performs an automatic redistribution on Disk Failure notification. Storage Managers 
continuously monitor disk status and send a “Disk Failed” notification to the System Director 
upon determination that a disk is not usable. The System Director then removes the Storage 
Manager from its associated Storage Group. The removal of the Storage Manager from the 
Storage Group initiates redistributions on all workspaces associated with that Storage Group. 
The System Director then prevents the Storage Manager that reported the disk failure from being 
added to a Storage Group.

The Automatic Removal feature is controlled by a system preference that is configured using the 
ISIS Management Console Preferences tool. The preference is called “Auto Remove 
Redistribution on Disk Failure” The default setting is “enabled.” The Storage Manager is 
removed from the Storage Group, but is not unbound from the ISIS Systems for the following 
reasons:

• The Storage Manager participates in the removal redistribution. This is required to prevent 
data loss when there are unprotected workspaces or when full redundancy has not been 
attained for all data blocks.

• The Storage Manager continues to report status, such as physically replacing the blade.
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Auto removal status is reported in the System Event Log. A sequence of event log entries is 
generated for the initial report of the failure, the decision to remove the Storage Manager, and 
subsequent success or failure. Events are also logged for the start and stop of all the workspace 
redistributions.

When using Automatic Redistribution: 

• Keep at least 7% of your Storage Group unused at all times. Failure to do so can cause the 
system to run out of space after an automatic redistribution has initiated and cause a client 
outage. 

• If an automatic redistribution of a Storage Group is started during a critical time the overall 
system performance can degrade significantly and be disruptive. For more information on 
understanding the performance characteristics during remove redistribution, see the Avid 
ISIS Performance and Redistribution Guide.

• An automatic redistribution removes the Storage Manager from the Storage Group but not 
from the file system. Once an automatic redistribution has occurred and completed, the 
removed Storage Manager should be removed from the file system. You must first remove 
the Storage Manager with the software and then physically replace it. A replacement ISB 
must then be added to the file system and then the Storage Group, triggering another 
redistribution. 

• If unmirrored workspaces are in use, the data will be damaged on those workspaces in that 
Storage Group.

Client

A client uses services provided by the Avid ISIS architecture. The client system, using a 1 Gb or 
10 Gb Ethernet connection, communicates with the ISBs through the ISS to create, modify, and 
read files stored in the actual ISB. Avid ISIS | 7500 - 7000 supports 330 clients (150 active 
clients), each using dual-stream video and up to 8 tracks of audio.

A client uses mechanisms specific to the operating system to display, create, and delete files 
within the Avid ISIS shared storage network system. For example, when viewed from a 
Windows operating system, the system sees a server containing many shares that are mapped to 
drive letters. 

Network Zone Configurations

All clients in the shared storage network are classified by zones, depending on how they connect 
to the network. The following list defines the clients in each network layer by their zone 
classification:
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n A System Director must be attached to both subnets, but can be attached only once to each 
subnet. 

• Zone 1 Client — Connected to ISIS VLANs with an ISS 1 Gb or 10 Gb port (direct connect)

• Zone 2 Client — Connected to ISIS VLANs with a 1 Gb or 10 Gb port on an Avid qualified 
layer-2 switch (non-routed)

• Zone 3 Client — Connected to an Avid qualified layer-3 switch (routed) with known Quality 
of Service (QoS); traffic routed to ISIS (one hop) and load-balanced across ISIS VLANs 
(approximately a 60/40 ratio)

• Zone 4 Client — Connected to the house network using an edge or a core switch with 
unknown QoS; traffic routed to Avid ISIS (measured by the number of hops) and 
load-balanced across ISIS VLANs (approximately a 60/40 ratio)

n Clients that can connect to one zone can run in any lower-numbered zone — for example, a 
Zone 3 client can also run as a Zone 2 or Zone 1 client.

Support for different client and device types vary by zone:

• Zone 1 — AirSpeed playout, Transfer Manager

• Zone 2 — AirSpeed ingest, editors, Interplay

• Zone 3 — Instinct, Assist, certain editors 

• Zone 4 — Instinct, Assist; typical formats include DV25, MPEG-2 proxy (2 Mb/s)

The following examples describe different types of Avid ISIS | 7500 - 7000 configurations. 

Zone 1 Clients (Direct Connected)

Any client that is connected directly to an ISIS is considered a Zone 1 or direct connected client. 
Each Integrated Switch Blade has a total of eight 1 Gb Ethernet ports and one 10 Gb Ethernet 
port. A single engine has the capacity to support 18 clients or servers, subtracting any ports that 
are to be used by the System Directors. The following table defines the total number of 1 Gb 
ports in Zone 1 based on what is available by the number of engines and System Directors in the 
configuration. In addition, each ISS2000 provides a 10 Gb Ethernet port connection for one 10 
Gb client.

n Connect TransferManagers and AirSpeed servers to Zone 1 or Zone 2.

A Zone 1 (direct connect) configuration consists of a group of clients connected directly to the 
1-Gb and 10 Gb connections of the ISS in the engine. The System Director also connects to both 
subnets through both ISS modules using a 1 Gb port. 
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Avid ISIS | 7500 - 7000 Zone 1 Network Configuration

Zone 1

Chassis 
interconnect

10 GB ethernet

Engine

Engine

Intel Pro 1000 
MT/PT boardClient systems

in Zone 1

1 GB ethernet
10 GB ethernet

10 GB board10 GB board

System Director

ISS VLAN 10 ISS VLAN 20

ISS VLAN 20ISS VLAN 10 

1 Gb Ports in Zone 1

ISS1000 and IXS1000 Switches ISS2000 and IXS2000 Switches 

Number 
of ISIS 
Engines

One System 
Director

Two System 
Directors 
(failover)

One System 
Director

Two System 
Directors 
(failover)

1 14 12 14 12

2 30 28 30 28

3 30a 28a 30a 28a

4 46 44 46 44

5 62 60 62 60

6 78 76 78 76

7 94 92 94 92

8 110 108 110 108

9 110b 108b 126 124
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10 Gb Client Support

You can connect up to the following number of clients in Zone 1 (directly connected to an ISS in 
an ISIS | 7500 - 7000 Engine). When a 10 Gb device is connected to your ISS, some of the 1 Gb 
ports cannot be used:

• High Resolution 1 Gb clients — four or fewer with one Ultra High Resolution 10 Gb client

• Medium Resolution 1 Gb clients — five or fewer with one Ultra High Resolution 10 Gb 
client

Zone 2 Clients (Indirect Connect) Configuration

Each ISS supports external switches connected through the 10 Gb port. Clients that are 
connected to an external switch are referred to as Zone 2 clients. For a list of supported switches, 
search the online Knowledge Base at www.avid.com/onlinesupport. 

A Zone 2 (indirect connect) configuration consists of group of clients connected to an Ethernet 
switch with a 10 Gb port connected to an ISS located in the engine. The System Director also 
connects to both subnets via both ISS modules using a 1 Gb port. Depending upon the switch 
configuration, each client shown connected to the external switch is connected to one of the two 
subnets through one of the two 10 Gb connections.

10 126 124 142 140

11 142 140 158 156

12 158 156 174 172

a. This is due to the use of IXS switches instead of an ISSs. 
b. This is due to the use of two more IXS1000 switches instead of an ISS.

1 Gb Ports in Zone 1

ISS1000 and IXS1000 Switches ISS2000 and IXS2000 Switches 

Number 
of ISIS 
Engines

One System 
Director

Two System 
Directors 
(failover)

One System 
Director

Two System 
Directors 
(failover)

http://www.avid.com/onlinesupport
http://www.avid.com/onlinesupport
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Avid ISIS | 7500 - 7000 Zone 2 Network Configuration

For example, you can configure a 24-port switch for three VLANs with Gigabit (Gb) Ethernet 
ports 1 to 12 and 10 Gb Ethernet port 25 reserved for VLAN 10 (default ISIS VLAN 
configuration). Gigabit Ethernet ports 13 to 23 and 10 Gb port 26 are reserved for VLAN 20 
(default ISIS VLAN configuration) and Gb port 24 is reserved for the switch’s default VLAN. 
The 10 Gb ports connected to the ISIS are also serving as uplinks to the ISIS for clients on either 
VLAN. Each VLAN on the switch is connected to the appropriate VLAN in the shared storage 
network using the 10 Gb port.

Zone 2 Switch

Each VLAN on the switch is allowed to support up to 12 connections but the size of the Storage 
Groups and engine determines the overall client count. Changing the switch configuration to 
increase the number of clients on a single VLAN is not supported and can result in unpredictable 
system performance. Client count can be scaled according to the number of available switches. 

Chassis 
interconnect

Engine

Engine

Zone 1 Zone 2

Intel Pro 1000 
MT/PT boardClient system

in Zone 1

1 GB ethernet

System Director

Intel Pro 1000 
MT/PT board

Client systems
in Zone 2

1 GB ethernet

ISS VLAN 10 ISS VLAN 20

ISS VLAN 20ISS VLAN 10 

VLAN 10 VLAN 20

10 GB ethernet

Zone 2 switch with two 10-Gb Ports

Ports 1 - 12 Ports 13 - 24

Port 24

1-Gb ports10-Gb ports

Port 25 Port 26
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The following table provides possibilities of Zone 2 client counts based on the number of ISIS 
engine and switches. Each engine configuration listed in the table has an associated 24-port 
switch, except for three engines, in which the IXS does not provide additional ports.

n The previous table does not reflect the use of Zone 1 Clients (Direct Connect), which at a 
minimum could consist of one System Director, AirSpeed devices, and TransferManagers. 
Mixing Zone 1 and Zone 2 clients in an ISIS shared storage network is discussed in the next 
section.

There is no current support for an external switch to be connected with the use of a 1 Gb 
connection as performance for multiple clients cannot be guaranteed over a single 1 Gb 
connection. 

Zone 1 and Zone 2 Clients Mixed Configuration

The number of ports available on the ISS (Zone 1) makes it necessary to add another layer of 
clients through a qualified network switch to create a Zone 2 in the ISIS shared storage network. 

A mixed configuration (Zone 1 and Zone 2) consists of clients connected directly and indirectly 
through ports on the engine’s ISS. The following figure shows two System Directors that 
connect to the engine through two separate ISS 1 Gb ports for use as a redundant System 
Director in case of a failure. Both System Directors also connect to each other through the 
onboard Ethernet connections to monitor if one System Director fails.

Available Zone 2 Ports 

Number of Engines 24-Port Switch Count External Switch Ports

1 1 23

2 2 46

3 2 46a

a. This is due to the use of an IXS board instead of an ISS. 

4 3 69



Network Zone Configurations

34

Avid ISIS | 7500 - 7000 Zone 1 and Zone 2 Mixed Network Configuration

n Although not shown in the previous figure, to ensure high availability, whenever possible, the 
System Directors should be connected to two different subnets through two different engines.

Zone 3 and Zone 4 Client Configuration

A Zone 3 (indirect connect) configuration consists of a group of clients connected to an Avid 
qualified layer-3 switch (routed) with known Quality of Service (QoS); traffic routed to ISIS 
(one hop) and load-balanced across ISIS VLANs (approximately a 60/40 ratio).

A Zone 4 (indirect connect) configuration consists of group of clients using an edge or a house 
Ethernet switch with unknown QoS; traffic routed to Avid ISIS (measured by the number of 
hops) and load-balanced across ISIS VLANs (approximately a 60/40 ratio).

This switch is normally connected to a house switch that has uplinks to the Avid Production 
Network through an Ethernet switch that contains a 10 Gb port connected to an ISS located in 
the engine. The System Director connects to the both subnets through both ISS modules using a 
1 Gb port. 

Zone 1 Zone 2

Intel Pro 1000 
MT/PT board

Client systems
in Zone 2

VLAN 10 VLAN 20

10 GB ethernet

Intel Pro 1000 
MT/PT board

Client systems
in Zone 1

1 GB ethernet

Chassis interconnect

ISS VLAN 10 ISS VLAN 20

Engine

Engine

System Director

ISS VLAN 20ISS VLAN 10 

System Director System Director
connections

1 GB ethernet

1 GB ethernet

Zone 2 switch with two 10-Gb Ports
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Avid ISIS | 7500 - 7000 Zone 3 and Zone 4 Network Configuration

Link Aggregation Support

A link aggregation configuration supports Zone 2, Zone 3, and Zone 4 clients.

Cabling

For a list of cables qualified with the Avid ISIS system, see “Supported Cabling” on page 185. 

Zone 4

Zone 3
House switch

Zone 3 client 
routed VLAN 30

Zone 4 clients 
corporate network

Zone 1

Client systems
in Zone 1Chassis 

interconnect

ISS VLAN 10 ISS VLAN 20

Engine

Engine

System Director

ISS VLAN 20ISS VLAN 10 

System Director
System Director

connections
1 GB ethernet

Zone 2

Avid Production Network (Zone 1, 2, and 3)
1 GB Ethernet

VLAN 10 VLAN 20

VLAN 30
Zone 3 layer 3 switch

VLAN 10 VLAN 20
Zone 2 Layer 2 switch

(Layer 3 routed/switched)

(Layer 2 switched)
Can be one 
multilayer switch

(Layer 2 switched)

(Layer 3 routed/switched)
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Connecting the Engine CX-4 Cable

The CX-4 cable is referred to as the Avid engine interconnect cable. It connects the engines 
through the integrated Ethernet switches (ISS and IXS) to create the Avid ISIS stack. 

To connect the cable:

t Place it in the connector at the rear of the system.

You hear a snap, and the cable is connected.

c Damage can occur when disconnecting the Avid engine interconnect cable from the switch 
board if not done properly. 

n Reduce strain on the ISS switch blades by organizing and dressing the Ethernet cables and CX-4 
cables. When dressing the cables do not block removable switch and power components.

Removing the Avid Engine Interconnect Cable

The following explanation and illustration explain how to properly remove the engine 
interconnect cable.

c If you attempt disconnect the cable by pulling the blue cable release towards you and 
pulling the cable out from the connector at the same time you can cause the cable and or 
connector to be damaged.

To remove the Avid engine interconnect Cable from the Rear Connector:

1. While the cable is in the connector, use one hand to grab the cable (or the metal portion of 
the connector) and push the cable (or metal portion of the cable) towards the connector at the 
rear of the engine.

2. While keeping the pressure towards the engine connector using the cable (or the metal 
portion of the connector), use the other hand to pull the blue portion of the cable directly 
back. This dislodges the connection of the cable from the connector.

Cable disconnect
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3. Pull back with both hands to remove the cable.

 10 Gb Link Aggregation Overview

Link aggregation is a method of combining physical network links into a single logical link for 
increased bandwidth. With Link aggregation, you can increase the capacity and availability of 
the communication channel between devices (both switches and clients) using existing Ethernet 
technologies. Two or more 10 Gb Ethernet connections can be combined to increase the 
bandwidth capability and to create resilient and redundant links. Link aggregation is sometimes 
known as “Trunking.”

Link aggregation also provides load balancing across several links so that no single link is 
overwhelmed. 

n You must disable link aggregation before creating or modifying your Avid ISIS stack. After your 
stack has been created, reconfigure your Link Aggregation Groups.

For information on creating a Link Aggregation Group, see “Configuring a 10 Gb Link 
Aggregation Group” on page 94. To configure a Hi Gb link aggregation for ten- and 
twelve-engines, see “Hi-Gig Link Aggregation Group” on page 79.

Link Aggregation Support

Avid ISIS | 7500 - 7000 supports 10 Gb link aggregation (between the ISS and the Avid 
Production Network switch) and Hi-Gig link aggregation (between two IXSes). Avid ISIS 
software supports the link aggregation standard clause 43 of 802.3-2005 (also known as 
802.3ad). 

Number of Groups Supported

A link aggregation group refers to a number of links that combine to form a single link 
aggregation. Avid ISIS | 7500 - 7000 supports five link aggregation groups. 

Pull back on blue 
cable release

Push cable or metal 
towards engine

Bottom hand 
pushing cable
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Number of Members Supported

A link aggregation group can have a maximum of eight members. This means no more than eight 
10 Gb links can be combined into one link aggregation group per VLAN. The minimum number 
of link aggregation members in a group is 2.

For performance reasons, Avid recommends that you maintain an even number of link 
aggregation members. For an eight engine stack, you can have a link aggregation group with 
two, four, and six members. For a ten or twelve engine stack, there can be two, four, six, and 
eight members in a link aggregation group.

n If a member is already part of a link aggregation group, it cannot be part of another link 
aggregation group. You also cannot create a link aggregation group with a single member.

Load Balancing

The software balances the load across multiple 10 Gb aggregated links based on source and 
destination IP addresses.

Failover

If a 10 Gb trunk link fails, the software load-balances the traffic among the remaining trunk 
links. For example in a four-way 10 Gb trunk if a single 10 Gb link fails, the traffic is 
load-balanced among the remaining three links. As a result, the average traffic distribution 
increases from 25% with four links, to 33% with three links. Therefore, it is strongly advised that 
network planners set up the trunks to handle the additional load if a link or a set of links fails in a 
trunk configuration. The traffic automatically re-balances the load when a trunk link returns.

Warning messages are sent to ISIS Management Console notifying you that a 10 Gb aggregation 
link status has changed. Switch diagnostics also provides errors when you have a failed link in a 
trunk.

The engine menu within the ISIS Management Console flashes a yellow warning triangle 
notifying you that a 10 Gb Link Aggregation link has changed. The specific engine displays a 
yellow warning circle, and the Switch Blade Status displays “1 Error(s).” Details on the engine 
switch display a status of “Link Warning.” You can open the Switch Agent page using the “info” 
button on the engines details page and look at the Port Status page to verify the 10 Gb Link 
Status.

n You can disable the failover feature functionality in the switch agent page.
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Recommended Topologies

For the best performance in stacks with two IXSs, the link aggregation members need to be 
evenly distributed between the ISSs that are connected to each IXS. For example, with a four 
link group, two are connected to ISSs that are connected to IXS A, and the other two links are 
connected to ISSs that are connected to IXS B.

Supported Functionality

From the Link Aggregation menu in the switch agent, you can:

• View current settings — This displays the current link aggregation configurations, showing 
all currently configured groups. You can also modify a group or delete a group from this 
page.

• Create a new link aggregation group

• Enable or disable the link aggregation configuration

• Restart the link aggregation configuration — This allows you to request that the stack restart 
its link aggregation configuration. This removes and rebuilds the link aggregation groups as 
defined in the current configuration.

• Delete the link aggregation configuration — This disables link aggregation and removes any 
existing link aggregation configuration. The configuration is not recoverable. This can be 
used to set link aggregation settings back to factory defaults.

Other Functionality
• Every time a switch is introduced to the stack (by connecting the stacking cable) or removed 

from the stack (by disconnecting the stacking cable), the link aggregation software clears the 
link aggregation information from the switches and reprograms them.

• If the switches are being programmed with link aggregation information for the first time, 
enable link aggregation by clicking “Enable or Disable link aggregation configuration.”



2 Avid Software and Hardware Install 
Checklist

The following checklists summarizes the major steps for upgrading your software and hardware. 
These checklists are for experienced administrators that acts as a reminder of the tasks that need 
to be done in each upgrade. If you are not experienced with Avid ISIS, you should read this 
entire book first before installing or configuring the Avid ISIS. 

c Each Avid ISIS release could have different upgrade requirements. Read the Avid ISIS 
ReadMe for each software release.

For detailed instructions on performing upgrades, see “Avid ISIS | 7500 - 7000 Upgrade 
Guidelines” on page 136.

Software Upgrade

This section list the components and procedures to follow when performing a software upgrade 
from Avid ISIS v1.4 and later to the current release. This does not include adding hardware. In 
Avid ISIS v2.1.1 and later, Avid ISIS clients need to be upgraded before you upgrade the 
infrastructure. This is necessary because ISIS client software before v2.1.1 is not supported in 
the ISIS v2.1.1 infrastructure. Although, v2.1.1 client software is supported in v1.4 and later 
infrastructures. Once the clients have been upgraded, you can upgrade Avid ISIS v2.1.1 
infrastructure. 

n If you are upgrading from a version earlier than Avid ISIS v1.4, you must first upgrade to Avid 
ISIS v1.4 before upgrading to v2.1.1, For instructions, see the v1.4 documentation.

The clients are defined as follows:

• Avid editing applications

• Interplay Assist and Instinct

• Interplay Access

• Avid Approved Applications Initiative such as Pro Tools and Final Cut Pro
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The infrastructure is defined as follows:

• System Director — System Director software and upgrade Storage Blades (ISBs) and 
Switch Blades (ISS/IXSs) in the Avid ISIS engines to the v2.1.1 firmware

• Interplay servers — Interplay Engine, Interplay Media Indexer, Interplay Transfer, and 
CaptureManager

• Capture devices — AirSpeed, AirSpeed Multi Stream, and Avid Interplay Low-Res Encoder

Use the following checklist for a software upgrade:

Avid ISIS Software Upgrade

Complete To be done

 Upgrade your Avid ISIS Clients, see “Loading Client Software” on page 94.

Before installing the new client software, save the client settings and preferences. 
Depending on your Avid ISIS version, different Preferences settings are saved when 
upgrading. For more information on what is saved per version, see the Avid ISIS 
ReadMe.

 Perform a Failover first to make sure both subnetworks are functioning and have 
updated metadata.

 Shut down the Standby System Director Service first, then shut down the Active 
System Director Service. 

n This checklist assumes you have two System Directors. Completely update one 
of the System Directors (allowing it to become the Active after it restarts), then 
repeat the procedure on the second System Director (allowing it to become the 
Standby). If you do not have two System Directors, install the software once.

 Uninstall the Avid ISIS System Director software using the Windows Control Panel > 
Add or Remove Programs.

 Uninstall the “AvidUnityISISInstallers” using the Windows Control Panel > Add or 
Remove Programs.

n If you do not uninstall the old Avid ISIS Installers, the old installers remain in 
the list with the new installers. Only the latest client software installers are 
available from the ISIS Management Console.

 Check the ReadMe to see if you need to update the Adobe® Flash® software and Intel® 
network interface driver.

 Install your Avid ISIS software on the System Director, see “Loading the Software” 
on page 84 and “Software Upgrade” on page 137.
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Hardware Upgrade

The firmware in the Avid ISIS hardware (ISBs and ISSs) is updated during the software upgrade. 
The firmware is updated using the ISIS Management Console. You select all the ISBs and click 
Upgrade Storage Blades and then select all your ISSs and click Upgrade Switch Blades. ISBs 
and ISSs can be upgrading at the same time. For more information, see “Installing Software on 
the Engines” on page 90.

If adding an engine to an existing system, see “Adding an Engine” on page 170.

New System Director and Engine Installation

Use the following checklist when setting up an Avid ISIS for the first time:

 Copy your Avid ISIS client installers on your System Director, see “Loading Client 
Software” on page 94.

 Upgrade all your ISBs, ISSs, and IXSs. Using the ISIS Management Console, select 
all the ISBs and click Upgrade Storage Blades and then select all your ISSs and IXSs 
and click Upgrade Switch Blades. You do not need to wait for the ISBs to be finished. 
ISBs, ISSs, and IXSs can be upgrading at the same time. For more information, see 
“Installing Software on the Engines” on page 90.

 Watch the upgrade in the Monitoring tool. 

Turn on the Avid ISIS engines in 1 minute intervals starting with the chassis that has 
the IXSs. This reduces stress on the stack.

After the Avid ISIS engines restart, the ISSs continue with the install (no additional 
user intervention is necessary).

For information on the Monitoring tool, see the Avid ISIS Administration Guide.

 Make the newly upgraded System Director your Active System Director. 

 Perform these same procedures on the Standby System Director.

Avid ISIS Software Upgrade (Continued)

Complete To be done
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Avid ISIS New Installation

Complete To be done

 Determine Network Address Scheme

 Configure SD IP Addresses; see “IP Addressing Overview” on page 80.

• ISIS Left

• ISIS Right

• Management Port

 In the 64-bit System Director, change your default Internet Explorer 7 Security and 
Advance tab settings:

Click Tools > Internet Options and change the Security to the following:

• Internet - Medium

• Trusted - Low

Click the Advanced tab and change the following:

• Phishing Filter - Disabled

• Use SSL 2.0 - Enabled (checked)

• Use TLS 1.0 - Disabled (unchecked)

 Install System Director and Installers; see “Software Installation” on page 84.

 Create File Systems; see the Avid ISIS Administration Guide.

• Open System Director Control Panel

• Click “Stop System Director”

• Click “Configuration File System”

• Click “Create Active File System”

 Configure the first Engine (IP Addresses); see the Avid ISIS Administration Guide.

• Start ISS Agent via Management port

• Under System > Basic set IP Address

 Connect the System Director to Engine number1; see “Connecting ISIS Hardware” 
on page 66.

 Add Additional engine; see “Adding an Engine” on page 170.

 Upgrade ISB and ISS; see “Installing Software on the Engines” on page 90.
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Switch and ISB Upgrade Utility

The Switch and ISB Upgrade Utility is a stand-alone application that allows field engineers to 
perform switch and ISB upgrades from a laptop connected to Avid ISIS through the management 
port, and monitor the upgrade progress. This utility does not replace the current upgrade process. 
Its primary function is for upgrading a switch or a pair of switches that is incompatible with an 
existing stacked network. Insertion of these switches into the network before the upgrade could 
disrupt or compromise the network’s operation.

The typical procedure for loading the firmware on switches consists of selecting them with the 
Avid ISIS Management Console and initiating an automated upgrade. This process is very useful 
when upgrading a new or very interoperable Avid ISIS switch stack; see “Installing Software on 
the Engines” on page 90. 

To start the utility, insert the Avid ISIS software USB into a laptop and double-click 
AvidUtilityISISTool.msi located in the following location.

drive:\AvidISISUtilities\ISIS 7000

For Instructions on using the utility, see “Avid ISIS Upgrade Utility” on page 151.

Recreating a File System

Deleting and creating a new file system is not common but if it is needed, this checklist provides 
the order and tasks to be completed. All of the tasks listed in this checklist are described in the 
Avid ISIS Administration Guide. 

 Bind Storage Managers, see the Avid ISIS Administration Guide.

 Create Storage Groups, see the Avid ISIS Administration Guide.

 Create Workspaces; see the Avid ISIS Administration Guide.

 Create Users; see the Avid ISIS Administration Guide.

Avid ISIS New Installation

Complete To be done



Recreating a File System

45

Deleting and Creating a File System

Complete To be done

 Delete all files in all Workspace

 Delete Workspaces

 Delete Storage Group

 Remove Storage Managers

 Delete / Create New Active



3 Installing the ISIS System

This chapter explains how to rackmount and connect the system hardware. A system installation 
check list is provided to help you perform the installation in the correct order. The check list 
contains references to information in this and other chapters in this document or the ReadMe file 
to complete the installation. 

n For information on connecting and configuring two System Directors for failover, see 
“Configuring System Director Failover” on page 114.

Rack-Mounting the Equipment

This chapter describes how to install and connect the System Director and other workgroup 
hardware. 

c Before you start the procedures in this chapter, read the previous chapters in this 
document. 

Rack-Mounting Examples

Avid supports more than one Avid ISIS rack configuration. Discuss the layout for your system 
with an Avid representative prior to purchase.

The following examples show a few of the supported rack configurations. 
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Single Rack - Two Engines - One System Director

Engines

System 
Director

ID
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Single Rack - Four Engines - One System Director
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Dual Rack - Four Engines - Failover System

Installing Rack-Mount Rails and Brackets

The System Director is designed for 19-inch (483-mm) rack configurations and requires one EIA 
rack units (1U), or 1.75 inches (44.45 mm) of rack space. The rail kit installs into rails that are 
between 23-inches (584.2-mm) to 31-inches (787.4-mm) inches deep. An optional rail kit is 
available for racks that are up to 37 inches deep.

The System Director includes rack mounting slide rails. If instructions are included with your 
rail kit, use them instead of the instructions included in this section. The standard rail 
configuration is for racks with square mounting holes. Optional brackets are included for racks 
with round holes. The rack-mounting kit requires inner slide rails be mounted to the server and 
the outer slide rails are mounted to the rack. Once both the inner and outer rails are in place, slide 
the server with the inner rails attached into the outer rails. Secure the server in the front of the 
rack using the supplied screws so it does not slide forward. 
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c The System Director is designed to be installed horizontally in a rack. Installing the System 
Director on an angle or in a sloped console causes the internal drives to wear faster than 
the intended life of the drive.

w To ensure the stability of the rack enclosure, start with heaviest equipment installed at the 
bottom of the rack enclosure. Lighter equipment goes towards the middle and top.

Review the following recommendations before rack-mounting Avid ISIS equipment:

• Avid recommends that you leave a 1U or half-U space between each piece of equipment 
mounted in the racks. This allows for better airflow and cable access, and helps stop 
vibration in any equipment being transferred to spaces above and below. 

n The 1U System Director has vent holes on the top of the enclosure. Avid has performed thermal 
testing with the top vent holes blocked, and the results indicated that even with the top vent holes 
blocked, the 1U System Director still operates within the temperature tolerances.

• Avid recommends that you leave an 8 to 12 inch space empty beneath the lowest piece of 
equipment installed in the rack. This allows for better airflow and lowers the possibility of 
dust or dirt being picked up by the devices.

• For normal operation, maintain approximately 2 feet (0.6 meters) of open space in front of 
and behind the rack. This allows free access to the components in the rack for operating 
changes or adjustments. For service, maintain approximately 3 feet (1 meter) of open space 
in front of the rack and 2 feet (0.6 meters) of open space behind the rack. This allows for the 
removal of any component that needs to be replaced.

Rack-mount Requirements

• Elevated Operating Ambient — If installed in a closed or multi-unit rack assembly, the 
operating ambient temperature of the rack environment might be greater than room ambient. 
Make sure the rack environment is compatible with the maximum ambient temperature 
(Tma) specified by the manufacturer.

• Reduced Air Flow — When installing equipment in a rack, make sure not to block the 
amount of air flow required for safe operation.

Avid ISIS airflow is from the front of the enclosure to the rear. Make allowances for cooling 
air to be available to the front panel surface and no restrictions at the rear.

• Mechanical Loading — Avoid uneven mechanical loading.

Make sure your rack enclosure is stable enough to prevent tipping over when one or more 
Avid ISIS servers are extended on the sliding rails.

• Circuit Overloading — Follow the equipment nameplate ratings to avoid overloading the 
circuits.
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• Reliable Grounding — Maintain reliable grounding of rack-mounted equipment, especially 
regarding supply connections other than direct connections to the branch circuit (for 
example, power strips).

• Inside Enclosure Access — Allow at least 0.5 in (1.3 cm) clearance on top of the enclosure 
for cover removal.

Positioning the System Director in the Rack

Use the following figure to help you decide where to install the System Director in the rack. 
Select a position where the System Director is at the proper baseline.

Separating the Slide Rails

Separate the slide rails and attach the inner “movable” section to the System Director and the 
outer “fixed” section to the rack rails. 

To separate the slide rails:

1. Slide the slide rail completely open.

2. Press the spring clip on the inner slide rail as shown in the illustration.

n The spring clip shown in the following illustration is on the bottom side of the slide rail.
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Separating the Slide Rails

3. Pull and separate the two halves.

4. Repeat these steps to separate the second slide rail.

Attaching Inner Slide Rails to the System Director

Attach the inner slide rails that were separated from the outer slide rails to the System Director.

To attach the inner slide rails:

1. Position the inner slide rail against the side of the server so that the screw holes are toward 
the rear of the server, and front of the slide rail fits over the tab at the front of the server.

2. Secure the inner slide rail to the server with two of the small screws.

n The rail kit might contain more screws than needed.
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Attaching the Inner Slide Rails

3. Repeat this procedure to attach the other inner slide rail on the other side of the server.

Attaching the Outer Rails to a Square-Hole Rack

After separating the slide rails as previously described (see “Separating the Slide Rails” on 
page 51), perform the following procedure. If your mounting rails have round holes, see 
“Attaching the Outer Rails to a Round-Hole Rack” on page 55. 

To attach the outer slide rails to the rack with square holes:

1. Align the outer slide rail bracket assembly with the front rack-mounding holes.

n Have someone help you hold the slide rails level while you position them in the rack.

2. Slide the square tabs through the holes in the front, vertical rack-mounting rail. 
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Positioning the Outer Slide Rail with the Front Rack-Mounting Rail

3. Push the outer rail towards the outside of the rack, to secure the outer rail in place

Insert the Outer Slide Rail to the Front Rack-Mounting Rail

4. Adjust the outer slide rail bracket assembly to the rear mounting rail.

5. Secure the rear outer slide rail bracket assembly to the rear mounting rail as you did for the 
front rack-mounting rail.
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Securing the Outer Slide Rail to the Rear Rack-Mounting Rail

6. Repeat this procedure to attach the second outer slide rail on the other side of the rack. 

Attaching the Outer Rails to a Round-Hole Rack

After separating the slide rails as previously described (see “Separating the Slide Rails” on 
page 51), perform the following procedure. If your mounting rails have round holes, you first 
need to clip on the round hole adapter. 

To attach the outer slide rails to the rack with round holes:

1. Locate the four round hole adapters (which ship in the accessory kit's plastic bag, not in the 
rack mount kit box) and position the adapter on the end of the outer slide rail bracket 
assembly as shown in the following illustration. 

Attaching the Round Hole Adapter to the Bracket Assembly 

Round hole adapter

Outer slide rail bracket assembly

Bracket assembly tabs
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2. With the bracket assembly tabs aligning with the cut-out in the round hole adapter, swing the 
adapter so that the holes face the front of the bracket assemble as shown in the following 
illustration. 

Positioning the Round Hole Adapter

3. Slide the outer slide rail bracket assembly onto the side rack-mounting rail so that the round 
hole adapter is over the rack rail. 

n Have someone help you hold the slide rails level while you position them in the rack.

Insert the Outer Slide Rail to the Front Rack-Mounting Rail

4. Insert the small (10-32) Phillips-head screws through the round-hole adapter and mounting 
rail into the bracket. If the rack holes are different size, you must supply the screws.
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Securing the Outer Slide Rail to the Rack-Mounting Rail

5. Adjust the outer slide rail bracket assembly to the rear mounting rail.

6. Secure the rear outer slide rail bracket assembly to the rear mounting rail as you did for the 
front rack-mounting rail.

7. Repeat this procedure to attach the second outer slide rail on the other side of the rack. 

Securing the System Director in a Rack

n Have someone help you hold the System Director while you position it in the rack.

To secure the server to the rack enclosure:

1. Lift and position the server so that the inner slide rails (secured to the System Director) are 
aligned with the outer slide rails secured to the rack.

2. Push the front of the System Director server flush against the front mounting rail. The holes 
in the server front panel align with the holes in the front mounting rail.

3. From the front of the rack enclosure, insert the large Phillips-head screw through the System 
Director and front mounting rail. 

- Square hole racks — the middle hole of the outer rail kit is where the screw anchors the 
server front panel to the vertical rail. A M6x10 screw in the parts kit is included to 
secure the front panel with square hole racks.

- Threaded hole racks — the server front panel attaches to the vertical rail of the rack. Use 
a truss head screw or hardware that come with your rack to secure the front panel with 
threaded hole racks.
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Front Panel Screws

Mounting the Engine

w Lifting the engine with the blades and power supplies installed can cause an injury. The 
engine must have the blades and power supplies removed prior to lifting. Avid recommends 
that two people be used whenever lifting the empty engine. 

To mount the engine into the rack:

1. Screw the brackets to the rear of the rack as shown in the following figure.

2. Make sure that the blades and power supplies are not in the engine.

3. Using two people, lift the engine and place the rear of the engine onto the brackets as shown 
in the following figure.

Rack enclosure 
front mounting rail

Rear
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4. Screw the engine to the front of the rack through the ears of the engine as shown in the 
preceding figure.

Installing Blades and Power Supplies

Once the engine has been mounted you can install the power supplies and blades.

w Only trained Avid technicians are permitted to remove and replace the power supply while 
power is applied to the system. Since power to the system is still on, you must always keep 
your hands outside the engine when a power supply is missing.

To place the power supplies and blades into the engine:

1. Unpack each ISB and turn it so you can properly read the Avid name. 

2. Pull open the plastic handle on the front of the ISB. (The plastic handle has the ISB model 
for example, i2000, i4000, i8000, printed on the recessed gray plastic face.The older models 
were reversed with the ISB model on the sticker on the handle and the Avid logo on the 
recessed gray plastic face.)

3. Place the ISB into the slot and slowly push the ISB completely into the slot.
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4. Push the plastic handle closed, to lock the ISB into the slot.

5. Repeat step 1 through step 4 until all blades are installed.

6. Carefully unpack each power supply.

w Avid recommends that two persons be used to install the power supplies. You could be 
injured if you dropped a power supply on any part of your body. 

7. Place the power supply into the engine as shown in the following figure and slowly push the 
power supply into the slot.

8. Turn the screws until tight. 

9. Repeat step 6 through step 8 until all power supplies are installed.

Installing IXS and ISS Switches

The location of the ISS and IXS switches in the stack is very important. If you have only one or 
two engines, install the ISS switches into the engines; see “Two-Engine Stacking” on page 69.

Screws
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For three to twelve engine configurations, install two IXSs in the first engine at the top of the 
stack.

To install your IXS or ISS:

1. Unpack the switch and insert the switch edges into the internal engine slides. 

2. Carefully push the switch into the midplane of the engine until the connection is made.

3. Tighten the thumbscrew on each side of the switch.

Connecting a Keyboard, Monitor, and Mouse

An industry standard USB keyboard, USB mouse and VGA monitor are use to access the System 
Director. When installed in a rack with several servers an optional KVM switch can also be used. 
The keyboard, monitor, and mouse connections use the same ports described in the following 
procedure. Follow the instruction supplied with your KVM switch. Supply KVM cables that are 
compatible with your KVM switch.

n The System Director has two USB ports on the rear. One of the ports is typically used for the 
application key. When you purchase your KVM switch make sure it includes a USB splitter cable 
so that both your keyboard and mouse can plug into the splitter cable and use a single USB port 
on the Engine.

To connect a keyboard, monitor, and mouse to the Avid ISIS:

1. Install your KVM switch in a suitable slot next to the System Director in the rack. 

You can also place the monitor on a shelf, and the keyboard and mouse on a sliding tray in 
the rack. These items are optional and can be purchased locally or from Avid.

c Do not place the monitor on top of the Avid ISIS.

IXS

Thumbscrews
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2. Attach the VGA connector on the monitor cable to the 15-pin video port on the back of the 
Avid ISIS. Secure the connector with the thumbscrews on the connector. For exact locations 
see “System Director Rear Panel” on page 19.

3. Insert the connector on the keyboard and mouse cables into a USB splitter cable.

n If you do not have a USB splitter cable, plug your keyboard and mouse cables directly into the 
USB ports on the rear of the System Director.

4. Insert the other end of the USB splitter cable into a USB connector on the back of the 
System Director. 

Connecting the Optional Application Key

The default way of activating your ISIS software is through the Avid License Control tool (see 
“Avid ISIS Software Licensing” on page 97), although you can purchase a USB application key 
(also called a dongle). Before you start the System Director, connect the Avid ISIS system USB 
application key. 

c Do not lose the USB application key. Your Avid ISIS system does not function without it. If 
you lose the USB application key, you must purchase another one from Avid to use your 
Avid ISIS system software.

To connect the application key to your Avid ISIS system:

1. Locate the USB application key in your Avid ISIS system kit.

2. Attach the USB application key to one of the rear USB ports of the System Director; see 
“System Director Rear Panel” on page 19. 

c Do not use the built-in USB connector on the front of the System Director. 

Connecting Power to Equipment

The Avid ISIS | 7500 - 7000 hardware includes three power supplies using an N+1 configuration 
for redundancy. The three power supplies “load share” to allow the balanced distribution of V ac 
power into each Avid ISIS | 7500 - 7000 engine. Usually, a minimum of two of the three power 
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supplies must be operational at one time for the engine to function properly. The fans in each 
power supply cool the supply and provides airflow for the engine. If a power supply fails, leave 
it in place until you have a replacement.

Each power supply is rated at 5 amps of current capacity at 120 Vac. You can have up to one 
power supply from each of the three engines on one 20-amp circuit. This allows the system to 
continue running if one of the three power supplies fails, with the two remaining load-sharing 
power supplies drawing slightly less than 10 amps. 

n Each System Director has two power supplies rated at 5.8 amps each. Avid recommends each 
power supplies be on a separated 20-amp circuit. 

An engine can operate on two power supplies for a period of time to allow you to protect data. 
The following illustration shows an example of how to connect to power to protect data. 

n Do not connect the power cords to the engines until instructed to do so in “Setting Up Network 
Addresses In the Stack” on page 67.

c Use this section to determine how to connect power to the engines. Connect the power 
cords to the engines when you rackmount them (see “Rack-Mounting the Equipment” on 
page 46), but do not plug them into the outlets until told to do so later in the document. 

Connecting Power Cords

When using two circuits, connect the System Director as follows:

To connect the power cords to the System Director:

t Plug two power cords into the back of the server and then plug the other ends into power 
outlets on separate 20 Amp circuits.

Power Connections

Three 20 Amp V AC Circuits for Three Engines

When you are using three circuits for three Engines, connect the Engines as follows:

Power supplies

System Director20 Amp

20 Amp System Director
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Basic Power Connection for Three ISIS Engines

Three 20 Amp V AC Circuits for Two Engines

When using three circuits for two Engines, connect them as follows:

Power Connection for Two ISIS Engines on Three Circuits

n The 20 Amp circuits shown for the System Directors should be the same for both the three and 
two 20 Amp circuit examples.

20 Amp20 Amp20 Amp

Engine

Engine

B CA

B CA

B CA

Engine

20 Amp 20 Amp 20 Amp

Engine

B CA

Engine

B CA
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Two 20 Amp V AC Circuits for Two Engines

c The following configuration is not recommended by Avid, but some locations might need to 
connect in this manner. 

When using two circuits for two Engines, connect them as follows:

Power Connection for Two ISIS Engines on Two Circuits

n The 20 Amp circuits shown for the System Directors should be the same for both the three and 
two 20 Amp circuit examples.

Turning System On and Off

To turn the system on or off, use the following procedures. Do not turn off the Avid ISIS 
components until they are completely on.

To turn your system on:

1. Turn on your engines one at a time by plugging at least two power cords into two power 
supplies at the same time. Plug the third power cord into the third power supply soon after 
the first two power supplies have been given V ac power. Allow enough time for all lights 
on the front panel to turn green.

2. Turn on the System Directors and start the Avid ISIS system.

3. Tell clients to restart their systems and use the Client Manager software to log on and mount 
workspaces.

20 Amp 20 Amp

Engine

B CA

Engine

B CA
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To turn your system off:

1. Exit the Client Manager on all clients.

2. Stop the Standby System Director using the System Director Control Panel (if failover is 
configured).

3. Stop the Active System Director using the System Director Control Panel.

4. Turn off the System Directors. 

5. Turn off the engines one at a time by unplugging the three power cords for each engine.

Connecting ISIS Hardware

The process of connecting the engines to the Avid ISIS network is a two step process. First you 
logically configure the addresses for the engine, then you physically make the connection to 
complete the process. To install software, see “Installing Software and Configuring 10 Gb Link 
Aggregation” on page 80.

c The engines are on when two or three power supplies are plugged into an ac power source. 
When the engines are on, and the interconnect cables are attached, the network tries to 
identify the new connection prematurely. Do not connect the interconnect cables until the 
procedure instructs you to. 

The 64-bit System Directors introduced in Avid ISIS | 7500 - 7000 v2.0 can be used with v2.x 
and v1.x generation switches in the engines. The two v2.x switches are branded with an IXS2000 
and ISS2000 silk-screen. The v2.x switches cannot be mixed in ISIS engines with earlier 
versions (v1.x) of the switches (labeled IXS1000 and ISS1000). All the switches in the engines 
need to be of the same generation. 

c You cannot mix new switches (labeled IXS2000 and ISS2000) with original switch 
hardware (labeled IXS1000 and ISS1000). All switches in the engine, and engines in the 
stack must be from the same generation of hardware.

The procedures provided in this guide describe the AS3000 System Directors and Avid ISIS 2.x 
hardware. You will need the following:

• Windows computer (laptop or System Director)

• CAT5e or CAT6 Ethernet cable to run between the Windows computer and the Management 
port of the ISS or IXS

• Two or more engine interconnect cables (when using more than one engine)

• System Director ISIS software kit
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Engine Configuration v2.x Hardware Guidelines

Although there are a few ways to physically connect and enable the engines, Avid recommends 
the process described in this section for consistency and dependability. In smaller configurations 
different switch blades are used: 

• ISS — Only the ISS blades are used when you are connecting two engines.

• IXS — When connecting three to twelve engines, two IXS2000 blades are used in the first 
engine (one for each subnet) to connect the next eleven engines. 

Engine configurations are described in the following sections:

• “Two-Engine Stacking” on page 69.

• “Three- to Twelve-Engine Stacking Summary With v2.x Switches” on page 71

n You must disable link aggregation before creating or modifying your Avid ISIS stack. After your 
stack has been created, reconfigure your link aggregation.

Use the following list to help you when you connect the System Director, laptop for 
configuration, and clients to the Avid ISIS | 7500 - 7000 system.

• A laptop (or any computer running a Windows operating system) is used in the following 
examples for configuring the engine at the beginning of the installation or for maintenance 
by an Avid representative. You can use the 1 Gb connection on the System Director for 
configuring the engine at the beginning if needed, but do not leave it connected or use it for 
a maintenance connection.

• All clients connected to the switches on the left side of the engine are connected to one 
subnet, while clients connected to the switches on right side of the box are connected to the 
second subnet. 

• When you are connecting the System Director to the ISS module using the dual port 
Ethernet board, Avid recommends that you connect the left port to the left side of the engine 
and the right port to the right side of the engine. Where the left side corresponds to the 
VLAN 10 subnet and right side corresponds to the VLAN 20 subnet. However, it also 
functions properly the other way. 

Rename the left side to “Left Side, VLAN 10” and the right side to “Right Side, VLAN 20” 
in the Network Properties of your System Director.

Setting Up Network Addresses In the Stack

Regardless of the number of engines you are planning in your Avid ISIS stack. The following 
procedure describes how to configure the first engine. 
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To configure the engine:

1. Connect the power cords that are connected to the System Director to the V ac circuit and 
turn on the System Director.

n The System Director password is preset to is-admin. Not to be confused with the System Director 
Web Page Administrator user whose default password is blank.

2. Connect the power cords from at least two of the engine’s power supplies to V ac circuit at 
the same time. Then connect the third power supply. 

It takes about 2 minutes for the engines to reach ready status. Wait for all the LEDS on the 
engine to be green.

3. Turn on all the engines in the stack.

n Power cords are plugged into the engines early in the process to speed up the installation time. 
Engines can take a minute or two to become ready. If the engines are ready when it is time to add 
them to the stack, the installation takes less time. Do not plug the interconnect cables into the 
engines until instructed to do so.

4. Using a laptop (or computer running a Windows operating system), assign a static IP address 
of 192.168.0.100 to the network adapter (NIC) and attach it to the management port of 
left switch.

5. Open a browser and navigate to the Switch Agent Web page via the following address: 
https://192.168.0.10:5015.

6. When prompted for the password, enter se-admin (default password).

The Avid ISIS | 7500 - 7000 Integrated Switch Blade page appears.

7. Type the following into the Chassis Configuration window:

- Starting IP addresses. Enter the IP addresses for both subnets, see “IP Addressing 
Overview” on page 80.

- Subnet mask

- Ending IP address (must be the last address of the engine in the system). Remember that 
each engine has 17 IP addresses on each side, for a total of 34. Set the ending address 
high enough to cover the last engine and any possible near term future needs.

If you are going to be using a Zone 3 environment you must set the default gateway 
addresses for both sides of the engine. These addresses must come from the site’s IS 
department.

n Make sure there are no DHCP servers connected to the network segments that assign addresses 
in the Avid ISIS range. 

- Date, Time, and Time Zone or Enable network time protocol
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If your network has a network time protocol (NTP) server, you can enter the IP address 
of that server in the Chassis Configuration window. NTP Server 1 is for the primary 
NTP server and if you have a secondary NTP server, enter the secondary IP address in 
NTP Server 2.

n Once the NTP is configured on a switch, the information propagates to all the other switches 
automatically. The time is also automatically synchronized onto the storage blades after the NTP 
is configured on the switch.

8. Click Submit.

A Dialog box might appear with an informational warning and can be disregarded. The first 
engine is now properly addressed.

Two-Engine Stacking

To stack two engines:

1. Complete the procedure “Setting Up Network Addresses In the Stack” on page 67.

2. Open a left-side Switch Web page.

3. Go to System > Configuration > Add/Remove chassis.
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4. Click Add and wait for the progress bar to complete.

5. Connect the interconnect cable from the left side of the stack to the new engine. The switch 
then picks up the addresses and stacking information.

Wait 5 minutes and refresh the page.

6. Verify that the serial number of the second engine is now in the Add a chassis list.

7. Attach the right interconnect cable.

8. Assign appropriate static IP address to the left and right network ports of the System 
Director.

9. Attach the System Director to the left and right switches and verify that all four switches can 
be pinged on their client IP address.

The following example shows the physical connections between two engines, a System 
Director, and clients. These are direct connections to the client system and not connected 
through switches. For a procedure of this connection, see “Setting Up Network Addresses In 
the Stack” on page 67.
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Two-Engine Connections

Three- to Twelve-Engine Stacking Summary With v2.x Switches

When connecting three- to twelve-engines, connect and add the switches to the VLAN 10 subnet 
(left side) first and then connect the engines to the VLAN 20 (right side) subnet. When accessing 
the Agent Web pages for the engines, use your laptop through the Management port or the 
Switch Agent Web through the Avid ISIS | 7500 - 7000 software on your System Director. 
Information on installing the software on the system Director is described in “Software 
Installation” on page 84. 

In three- to twelve-engine configurations with IXS2000 switches, two IXSs are installed in the 
first engine, see “Three- to Twelve-Engine Connections With v2.x Switches” on page 73. The 
IXS2000 ports 1 through 11 are referred to from left to right as shown in the following figure.

21 3 4 5 6 7 8MGMTS
TA

T
U

S

21 3 4 5 6 7 8MGMTS
TA

T
U

S

21 3 4 5 6 7 8MGMTS
TA

T
U

S

21 3 4 5 6 7 8MGMTS
TA

T
U

S

Connection 1

To client - RJ45 connector, CAT 5e or CAT 6

edis thgiRedis tfeL

System 
Director or 
laptop for 
configuring 
only

RJ 45 connector 
CAT 5e or CAT 6

Inter-engine connection 
CX-4 connector 
Avid interconnect cable

ISS



Connecting ISIS Hardware

72

IXS2000 Engine Port Numbering

Avid strongly recommends you keep your engines and IP addresses in order in conjunction with 
the order of the ports used on the IXSs. When the IP address of the engines are in order with how 
they are mounted in the rack, support personnel can better identify the connections and 
components in the network. For an overview of the recommended IP addressing, see “IP 
Addressing Overview” on page 80.

Three- to Twelve-Engine Connections With v2.x Switches 

The following procedure describes cabling up to twelve engines and might not represent your 
actual rack configuration. The cabling is the same when using IXSs regardless of the number of 
engines in your configuration.

To connect the VLAN 10 subnet (left side):

1. Loosen the thumb screws on all the right side switches (IXS and ISS) and pull the right side 
switches out about an inch of all the engines (so they are not electrically connected in the 
engine).

2. Connect the power cords from at least two of the engine’s power supplies to V ac circuit at 
the same time. Then connect the third power supply. 

It takes about 2 minutes for the engines to reach ready status. Wait for all the LEDS on the 
engine to be green.

3. Turn on all the engines in the stack.

n Power cords are plugged into the engines early in the process to speed up the installation time. 
Engines can take a minute or two to become ready. If the engines are ready when it is time to add 
them to the stack, the installation takes less time. Do not plug the interconnect cables into the 
engines until instructed to do so.

IXS module

11 Engine interconnections
Management 
connection

1 2  3 4 5  6

7  8 9 10 11

1 2 3 4 5 6

7 8 9 1010 1111

1 2  3 4 5  6

7  8 9 10 11



Connecting ISIS Hardware

73

4. Using a laptop (or computer running a Windows operating system), assign a static IP address 
of 192.168.0.100 to the network adapter (NIC) and attach it to the management port of left 
IXS.

5. Open a browser and navigate to the Switch Agent Web page via the following address: 
https://192.168.0.10:5015.

6. You are asked for the default password. Type se-admin.

The Avid ISIS | 7500 - 7000 Integrated Switch Blade Window appears.

7. Type the following into the Chassis Configuration window:

- Starting IP addresses. Enter the IP addresses for both subnets, see “IP Addressing 
Overview” on page 80.

- Subnet mask

- Ending IP address (must be the last address of the engine in the system). Remember that 
each engine has 17 IP addresses on each side, for a total of 34. Set the ending address 
high enough to cover the last engine and any possible near term future needs.

If you are going to be using a Zone 3 environment you must set the default gateway 
addresses for both sides of the engine. These addresses must come from the site’s IS 
department.

n Make sure there are no DHCP servers connected to the network segments that assign addresses 
in the Avid ISIS range. 

- Date, Time, and Time Zone or Enable network time protocol

If your network has a network time protocol (NTP) server, you can enter the IP address 
of that server in the Chassis Configuration window. NTP Server 1 is for the primary 
NTP server and if you have a secondary NTP server, enter the secondary IP address in 
NTP Server 2.

n Once the NTP is configured on a switch, the information propagates to all the other switches 
automatically. The time is also automatically synchronized onto the storage blades after the NTP 
is configured on the switch.
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8. Click Submit.

If a Dialog box appears with an informational warning, disregard it. The first engine is now 
properly addressed.

9. Click Add/Remove chassis to go to the Add a Chassis page.
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10. Click Add and wait for the progress bar to complete.

11. Immediately attach an interconnect cable from port 1 of the left IXS to the left ISS 
interconnect port of the second engine. 
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Left Subnet Twelve-Engine Connections

n You are not required to connect each engine to the exact ports shown in the illustration. The 
order used here is a suggestion to keep the stack logically organized.

12. Verify that the switch was added to the stack successfully. 

The serial number of the new engine appears in the Add/Remove Chassis list after a few 
moments when the switch is successfully added. If the new engine does not appear in the list 
(times out), see “Engine Does Not Appear in Add Engine List” on page 93. You can also 
navigate to the Tools tab and verify that IXS can ping the added switch via the expected 
client IP address. 

13. Repeat steps 9 through 11 until eleven engines are connected. Connect the third engine to 
port 2, fourth engine to port 3, and so on, until all engines are connected to ports 1 
through 11 on left subnet (VLAN 10). 

14. Attach the System Director to the client port and assign an appropriate IP address for the left 
subnet. Verify that you can ping all the switches in the left stack at the expected 
IP addresses.

15. Continue with the following procedure to connect VLAN 20 (right side).
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To connect the VLAN 20 subnet (right side)

1. Insert right IXS (right-side switch in the top engine) and tighten the thumb screws.

The IXS switch starts when inserted, allow the switch 2 minutes to power on and enter a 
ready state.

2. Insert the right side ISSs that you intend on connecting to right IXS subnet and tighten the 
thumb screws.

Allow the switches 2 minutes to power on and enter a ready state.

3. Connect the second engine to port 1, third engine to port 2, and so on, until all engines are 
connected to ports 1 through 11 on right subnet (VLAN 20).

Do not click “Add” from any IXS Agent Web page.

Right Subnet Twelve-Engine Connections

4. Attach the System Director to the client port and assign an appropriate IP address for the 
right subnet. Verify that you can ping all the switches in the right stack at the expected 
IP addresses.

All switches in the stack (left and right sides) are now reachable from the System Director.
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Hi-Gig Link Aggregation Group

Two interconnect cables and Link Aggregation are used to increase the bandwidth between the 
IXS’s. However, both interconnect cables must not be connected until Hi-Gig Link Aggregation 
is Enabled. Link Aggregation must be enabled for both sides of the network in order for clients 
on both sides to perform I/O operations. 

c If Hi-Gig Link Aggregation is not enabled, and two interconnect cables are used to connect 
the IXS’s, then traffic loops and stacking problems occur. 

To enable link aggregation:

1. Go to any left subnet Switch Agent Web page. 

2. Click the radio button to Enable Hi Gig Link Aggregation.

3. Click submit, the IXS’s restart. 

4. After the IXS has restarted, make sure that Hi Gig is “on” in the Hi Gig Link Aggregation 
column of the System page > Switch Agent > Management Domain.

5. Connect a stacking cable from one IXS port to an IXS port on another Engine.

c Currently only Port 6 and Port 7 on v1.x hardware can be used for Hi-Gig Link 
Aggregation. Do not use any other stack ports to connect the IXS’s to each other. 



4 Installing Software and Configuring 
10 Gb Link Aggregation

This chapter describes how to connect and configure the System Director and other Avid ISIS 
hardware. Since the number of different configurations is endless, this chapter describes a 
configuration with four engines and one System Director.

If you have questions, call your Avid representative or your local ACSR.

c Before you start the procedures in this chapter, you should be familiar with the 
information in previous chapters and the Avid Products and Network Site Preparation 
Guide.

IP Addressing Overview

Before you attempt to define a total IP addressing scheme for your system and configure the 
static internal IP addresses of the engine, know how the addresses are assigned within the engine 
and how the IP addresses increment between engines. 

n 192.168.10.10 and 192.168.20.10, subnet 10 and subnet 20, are used by Avid as examples 
throughout this document. Consult with your site’s networking managers for site specific 
requirements. Unless specified, you can change the addresses used in the following example to 
suit your needs. However, if static IP addresses are assigned within the engine, they must not be 
assigned by a DHCP server to any other device within the network.

The following figure shows the front and rear view of a engine. Use the following two figures 
and bulleted list to understand how static IP addresses are assigned to each engine. 
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Front and Rear of an Engine 

The following list describes the tasks to assign IP addresses to engines. Understand the 
assignment of IP addresses completely before you perform the actual configuration.

n Do not attempt to assign addresses to the engine using this list. This provides an overview, not a 
step-by-step procedure. 

• Connect Port 1 of the System Director or a port on a laptop to the Management Port of the 
ISS in the bottom engine of the rack using a CAT5 E, CAT6 cable or better. See the previous 
figure. 

• The Management Port is now on an isolated network interface on the ISS using the default 
IP address of 192.168.0.10. This IP address is used on every Management Port on the ISS 
and expansion switch blade. The address is not on the local 10 or 20 subnets Ethernet bus 
and is never used to transfer actual data. 

n When you assign subnet addresses internally and have more than one engine, all ISSs and IXSs 
on the left side of the rear of the engine are on one subnet, while all ISSs and IXSs on the right 
side of the rear of the engine are on the other subnet. 

• Two static IP addresses are assigned to the upper left-most ISB slot in the engine when 
looking at the engine from the front. The addresses are 192.168.10.10 on subnet 10 and 
192.168.20.10 on subnet 20. You are assigning the address to the slot, not the blade. The ISB 
can be physically moved, but the IP address remains with the slot.

• As the slots go sequentially from top left to right, over a row and starting at the left again, 
each slot is assigned a static IP address that is incremented by one until you reach the 
right-most bottom slot that contains addresses of 192.168.10.25 and 192.168.20.25. 

raeRtnorFUpper left
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• At this point, each ISS or IXS is assigned a base address. One ISS is assigned a subnet 10 
address of 192.168.10.26 and the other a subnet 20 address of 192.168.20.26 (unless the you 
want to change the IP scheme or subnet mask). Each side of the engine is assigned 17 
addresses on each network for a total of 34 addresses per engine.

• You then increment the subnet 10 and subnet 20 addresses by one and assign them to the 
switch blades in the next engine. 

• The ISB slots and switches are again incremented.

The following tables provide an example of the address assignments described in the previous 
bullets.

First Engine Internal Static IP Address Assignments

ISB 0

192.168.10.10 (left side)
192.168.20.10 (right side)

ISB 1

192.168.10.11 (left side)
192.168.20.11 (right side)

ISB 2

192.168.10.12 (left side)
192.168.20.12 (right side)

ISB 3

192.168.10.13 (left side)
192.168.20.13 (right side)

ISB 4

192.168.10.14 (left side)
192.168.20.14 (right side)

ISB 5

192.168.10.15 (left side)
192.168.20.15 (right side)

ISB 6

192.168.10.16 (left side)
192.168.20.16 (right side)

ISB 7

192.168.10.17 (left side)
192.168.20.17 (right side)

ISB 8

192.168.10.18 (left side)
192.168.20.18 (right side)

ISB 9

192.168.10.19 (left side)
192.168.20.19 (right side)

ISB 10

192.168.10.20 (left side)
192.168.20.20 (right side)

ISB 11

192.168.10.21 (left side)
192.168.20.21 (right side)

ISB 12

192.168.10.22 (left side)
192.168.20.22 (right side)

ISB 13

192.168.10.23 (left side)
192.168.20.23 (right side)

ISB 14

192.168.10.24 (left side)
192.168.20.24 (right side)

ISB 15

192.168.10.25 (left side)
192.168.20.25 (right side)

Switch (ISS or IXS)

192.168.10.26

Switch (ISS or IXS)

192.168.20.26
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Second Engine Internal Static IP Address Assignments

Configuration Overview

Your System Director and engines should be rack mounted with the interconnect cables 
connected to the left side of your stack as previously described before continuing. 

Do the following:

1. Configure the engine by assigning IP addresses to the engine. This provides each ISS, IXS, 
and ISB with the needed IP addresses to connect to the clients and System Director, see 
“Setting Up Network Addresses In the Stack” on page 69. 

n The ghost image on the System Directors does not set the IP addresses of the two onboard NICs 
or the dual NICs card on the PCI bus; the system is set for DHCP. 

2. Load the System Director software. This software is used to create a file system on the 
System Director, bind the ISBs to the software on the System Director, create Storage 
groups, and administer the Avid ISIS system. See “Loading the Software” on page 84.

3. Perform administrative functions: bind ISBs (Storage Managers), create storage groups, and 
do other administrative functions. See “Creating an Active File System on the System 
Director” on page 86. 

4. Load the client software; see the Avid ISIS Client Manager guide. 
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ISB 1

192.168.10.28 (left side)
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ISB 2
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ISB 3

192.168.10.30 (left side)
192.168.20.30 (right side)

ISB 4

192.168.10.31 (left side)
192.168.20.31 (right side)

ISB 5

192.168.10.32 (left side)
192.168.20.32 (right side)

ISB 6

192.168.10.33 (left side)
192.168.20.33 (right side)

ISB 7

192.168.10.34 (left side)
192.168.20.34 (right side)

ISB 8

192.168.10.35 (left side)
192.168.20.35 (right side)

ISB 9

192.168.10.36 (left side)
192.168.20.36 (right side)

ISB 10

192.168.10.37 (left side)
192.168.20.37 (right side)

ISB 11

192.168.10.38 (left side)
192.168.20.38 (right side)

ISB 12

192.168.10.39 (left side)
192.168.20.39 (right side)

ISB 13

192.168.10.40 (left side)
192.168.20.40 (right side)

ISB 14

192.168.10.41 (left side)
192.168.20.41 (right side)

ISB 15

192.168.10.42 (left side)
192.168.20.42 (right side)

Switch (ISS or IXS)

192.168.10.43

Switch (ISS or IXS)

192.168.20.43
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Software Installation

Make sure the System Director and engines are cabled and attached to both internal subnets as 
described in “Setting Up Network Addresses In the Stack” on page 69. 

Loading the Software

Avid ISIS Systems ship with one blank 8GB USB flash drive that is intended to be used for 
storing the ISIS Software Kit. Download the ISIS software kit from download center 
(www.avid.com/US/support/downloads) to your System Director using the USB flash drive 
included with your Avid ISIS. 

n In the past Avid has instructed you stop the Standby System director, upgrade the Standby, and 
restart the Standby. Once the Standby was running you were instructed to update the Active 
System Director. 

Avid has revised the upgrade process to stop the Standby System Director and upgrade the Active 
System Director first, then upgrade the Standby System Director. This process avoids replicating 
metadata between ISIS software versions.

To install your ISIS | 7500 - 7000 software on new systems:

1. Log in to the Avid ISIS | 7500 - 7000 System Director as Administrator (default password: 
is-admin). 

2. Make a folder for the software kit on your root directory (C:\) of your Active System 
Director.

3. Insert the software USB flash drive into any of USB ports on your Active System Director.

n You can run the software installer from the USB flash drive, or copy the software kit to the Avid 
ISIS | 7500 - 7000 in case you need it in the future.

If the USB flash drive does not automatically display:

a. Double-click the computer icon on the desktop. 

b. Double-click the USB flash drive icon in the window and copy the software kit into the 
new folder you created on the Avid ISIS | 7500 - 7000 system. 

4. Double-click the AvidISISSetup.exe file in the root directory of software kit.

The installer detects the existing version of the installed software (if any) and displays the 
components that need to be upgraded in the splash screen. 

n If the Package Selection menu does not allow you to select the software, click Quit and run the 
AvidISISSetup.exe again.

http://www.avid.com/US/support/downloads
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5. Select ISIS | 7500 - 7000 System Director from the “Select Software Package” menu. 

The File Gateway selection is used when loading the Avid File Gateway server. The File 
Gateway software cannot be installed on the same server as the System Director software.

6. Click Apply.

7. Follow the screen prompts accepting the defaults and License agreement.

8. Once the installation is complete, click Finish.

9. Open the Avid License Control tool, click Start > Programs > Avid > Utilities > Avid 
License Control and activate your Avid ISIS license. For detailed license activation 
instructions, see “Avid ISIS Software Licensing” on page 97. 

You will need the System ID and Activation ID card included with your new System 
Director.

n To open and use the ISIS Control Panel and Management Console see the Avid ISIS 
Administration Guide.

10. Open the ISIS Control Panel. 

11. Click Stop System Director.

12. Click the File System tab.

13. Select Create Active File System and click OK.

14. Open the Management Console. 

Log in using the Administrator user name and the default password is blank.

15. Load the ISBs and ISS/IXSs firmware. Using the ISIS Management Console > Engines 
page, select all the Engines and click Upgrade Blades and then select all your ISS/IXSs and 
click Upgrade Switches. You do not need to wait for the blades (ISBs) to be finished, you 
can upgrade ISBs and ISS/IXSs at the same time. 

You can watch the upgrade progress in your Monitoring tool.

16. Bind the ISBs. Using the ISIS Management Console > Storage Managers page, select your 
ISIS Storage Mangers in the list and click Bind.

17. Create a Storage Group, Workspaces, and add Users in the Management Console.

18. Install your Avid ISIS client software. For information, see the Avid ISIS Client Guide.

Activating the License Key

You must activate your Avid ISIS software before you can make an Active File System. After 
installing your software, see “Avid ISIS Software Licensing” on page 97. 
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n Previous versions of Avid ISIS software use an application key plugged into the System Director 
to allow clients to connected to the ISIS infrastructure. The USB application key is now available 
as an option. New ISIS systems ship with software licensing that is activated online. If you are 
already using an application key (dongle) in your ISIS infrastructure you can continue using it. 
Software licensing is only required with new ISIS installations. Clients cannot access the Avid 
ISIS software until the license key has been activated.

If configuring a Dual System Director for metadata redundancy, you will need a second 
application key with the second System Director, For more information, see “Configuring 
System Director Failover” on page 114. 

Installing the Optional Application Key

If you have purchased the optional Application Key, you do not need to use the Avid License 
Control tool software.

To install the application key (dongle):

1. Locate the application key in the Avid ISIS kit.

2. Install the application key into one of the USB ports on the System Director. For an exact 
locations, see Engine Front View or “Engine Rear View” on page 21.

Make sure the application key is seated completely in the port.

Creating an Active File System on the System Director

On new installations you must initialize your system by creating an Active File System on the 
System Director. 
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To create an Active File System:

1. In the ISIS Launch Pad, click ISIS Control Panel icon or Start > Programs > Avid > ISIS 
System Director and select Control Panel. 

2. Click Stop System Director. 

The Configure File System tab becomes active.

3. [First System Director] Click Create Active File System and click Apply. 

The Avid ISIS System Director service automatically starts when complete. In the System 
Director Control Panel, the “System Director is running” display turns green.

4. (Option) If creating a Standby System Director in an metadata redundancy configuration, 
see “Configuring System Director Failover” on page 114. 
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Binding the Storage Managers

After you have created an Active File System, bind the Storage Managers using the Management 
Console. If you have more than one Engine in your configuration, they appear in the Storage 
Manager page. You can select and bind multiple Storage Managers. 

n This procedure assumes you are creating an Active File System on a new unused Engine. If you 
attempt to create a File System on an Engine that has been used before, your Storage Managers 
might enter an Orphaned state. To remove an Orphaned state, search the Avid ISIS 
Administration Guide for instructions on “Removing Orphaned Storage Managers.”

To bind the Storage Managers:

1. Type https://IP address of System Director:5015 in your browser. 

If already logged into the System Director, click the Management Console icon in the 
Launch Pad.

2. Log into the System Director and access the Management Console.

n The default Management Console Administrator password is blank (no password).

3. Click the Storage Managers icon or double-click the unbound Status message in the System 
Status console.

4. Select the ISBs listed in the Storage Managers list. You can select and bind multiple ISBs.

5. Click Bind.

6. Click Yes to confirm the request.

7. Click Refresh to see the status circle next to the Name turn change to green when complete.
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Checking the Status of the System Director

After you have installed the System Director software, an Avid ISIS Launch Pad is displayed on 
the System Director Desktop.

To open and close the Launch Pad:

1. If the ISIS Launch Pad is not displayed on the Avid ISIS System Director Desktop, click the 
ISIS Launch Pad icon in the Taskbar’s System Tray to display or hide the Launch Pad. 

n You can also open other ISIS tools by clicking the icons in the Launch Pad.

The ISIS Launch Pad is displayed. 

2. Start or stop the System Director by clicking one of the following icons in the ISIS Launch 
Pad. 

t Click the blue square icon to stop the System Director.

t Click the blue triangle icon to start the System Director.
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Installing Software on the Engines

After you have loaded new software on the System Director, upgrade the software on the 
engines. You can use Web Administrator from anywhere to perform the following functions, but 
you usually do it from the System Director:

• Upgrade the ISS and IXS with the appropriate or latest software

• Upgrade the ISBs with the appropriate or latest software

• Create Workspaces

To upgrade the software:

1. Go to https://IP address of System Director (or virtual name):5015.

2. Log into the System Director.

n The default Administrator password is blank.

The ISIS Management Console opens. 

3. Click Engines.

4. Select all the Engines in the Engine list.
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5. Click Upgrade Switches. 

The Upgrade Switch Blades window opens. 

6. Select the upgrade .tgz file, and click Upgrade.

After all the Switch Blades are updated, upgrade the Storage Blades.

n Upgrading switches takes approximately 25 minutes for ISS1000 and IXS1000 switches, and 
10 minutes for the v2.x switch hardware (ISS2000 and IXS2000). Upgrade the switches on all 
your engines at the same time.

7. Click Upgrade Blades.

The Upgrade Storage Blades window opens. 

8. Select the upgrade .tgz file, and click Upgrade.

Each Storage Blade takes approximately 10 minutes.

9. Select the Engine and click Details.
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The Status for the upgrade is shown in the Details pane at the right of the window. Click the 
Refresh button to update the upgrade status. When the Status field in the Details pane is 
empty, the upgrade is complete.

n You can also use the Monitor Tool, the color indicator in the System Overview Toolbar, and the 
Storage Blade Status column to watch the progress of an upgrade. Select the Engine Summary in 
the left pane for each engine and click the Upgrade button to see the install status graphically 
displayed.

Engine Does Not Appear in Add Engine List

If the engine did not appear in the Add/Remove chassis page (for more information, see “Three- 
to Twelve-Engine Connections With v2.x Switches” on page 75), stop and troubleshoot the 
problem. Once the engine appears in the list, continue adding any additional engines. Perform 
the following steps one at a time and wait for the Add Engine process to time out before starting 
the next step. 
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To troubleshoot why an engine did not appear in Add/Remove page:

1. Reseat the interconnect cables; both sides of the interconnect should have a green solid link 
light when powered on. If not:

a. Remove the cable.

b. Click Add chassis.

c. Replace cable.

2. Reseat the ISS that you are adding:

a. Remove the ISS.

b. Click Add chassis.

c. Reseat ISS.

3. Try a different IXS port:

a. Disconnect interconnect cable from IXS port. 

b. Click Add chassis. 

c. Attach the interconnect to a new port on the IXS. 

4. Try a different interconnect cable:

a. Disconnect the interconnect cable. 

b. Click Add chassis. 

c. Replace the interconnect cable. 

Check Switch IP Address

Use telnet to connect to the newly added switch at the expected IP address. 

If the switch cannot be reached, try the following:

1. On the IXS Switch Agent, view “System Overview.” 

2. Click the link for the newly added chassis. If Peth0-IP is not correct, set the switch back to 
the default.

If the IP address is correct, proceed to the next step.

3. Check the State Machines in “System Overview” under “Stack Port Status.” The state for the 
newly connected port should show “SW_PORT_STACKED.” If it does not, try the 
following:

a. Reseat the interconnect cable.

b. Restart the newly connected switch.

c. Restart the IXS.
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Loading Client Software

See the Avid ISIS Client Manager guide for information on installing and configuring the Client 
Manager software. 

Configuring a 10 Gb Link Aggregation Group

The 10 Gb link aggregation connection is done using the 10 Gb port on the ISS. You can make a 
10 Gb link aggregation connection on the left, right or both subnets. The number of 10 Gb links 
you can create, depends on the number of 10 Gb ports available on your zone switch (Avid 
Production Network switch). The following procedure describes the process. For an overview of 
10 Gb link aggregation, see “10 Gb Link Aggregation Overview” on page 37.

To create a 10 Gb link aggregation:

1. Configure your Avid Production Network switch for your 10 Gb link aggregation 
connections. 

This process is not described in Avid documentation; see the documentation that comes with 
your switch. For additional information on configuring qualified switches, search the 
Knowledge Base for the Avid ISIS Ethernet Switch Reference Guide.

n Avid Production Network switches must be configured for Source Destination IP addresses in 
terms of link aggregation load balancing. This is the default both in Avid ISIS switches and the 
Avid Production Network switches that have been qualified; no other load balancing 
configurations are supported.

c If you connect the 10 Gb link cables before you configure the link aggregation in the ISIS 
Management Console, you will create network loops. 

2. Open the Switch Blade Agent (see the Avid ISIS Administration Guide).

Click Switch Blade in the Management Console and double-click on the Switch Blade to 
open the switch agent page. The default password is se-admin.

3. Click the System tab if it is not already selected. 

The System window opens.

4. In the 10 Gb Link Aggregation area, click “Create new group.”

The agent displays information for the type of group and network. A maximum of eight 10 
Gb links can be in a group.
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5. Select either the Left (VLAN 10) or Right (VLAN 20) in the Network area of the window 
and click Continue.

The ISSs on either the left or right side of the stack are listed. 

6. Select the serial number of the ISS you want to use for your new link aggregation group and 
click Continue.

A minimum of two ports must be selected. 

n If you make a mistake on your link aggregation group, click “Delete configuration” and select 
Left, Right, or Both to remove the link aggregation configuration.

c Do not click Restart in the 10 Gb Link Aggregation area unless instructed to do so by an 
Avid representative.

7. Click Enable/Disable. 

The top of the window displays the current 10 Gb link aggregation status.

8. Select Left, Right, or Both, and Enable, and then click Submit to enable the link aggregation 
that you just created. 
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9. (Option) Repeat step 3 through step 8 to create a link aggregation for the other side.

Link aggregation groups are created on the left and right sides individually. You can have a 
link aggregation just on one side if you want. 

10. Connect the interconnect cable between the 10 Gb ports on the ISS switch you have 
configured.
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5 Avid ISIS Software Licensing

When installing a new Avid ISIS system, you must activate the ISIS software with the Avid 
License Control tool. If you have a dual System Director environment, repeat the procedure for 
each System Director. 

n If you are upgrading from an earlier version of Avid ISIS software which uses the USB 
application key (dongle), you can continue to use that application key with your software 
upgrade. New ISIS software continues to support existing USB application keys. USB 
application keys are available as an option.

c If you change your system configuration — for example, replacing a network adapter or 
upgrading your operating system — you must first deactivate your Avid software. For 
information on deactivation, see Deactivating the License.

• New installations — if you are a new user and have never installed the Avid software on 
your system, use the following instructions.

n Your network administrator might need to open a few ports that are used during the licence 
activation. The Avid License Control tool uses both port 3443 and port 443 for license request 
and response communication. Port 3443 is the primary port, but if this port is blocked, the 
Activation Service tries port 443 (which is more likely to be open for web communication).

• Existing installations — if you are upgrading from a previous version of the Avid ISIS 
software and have previously activated your license (or have a valid ISIS application key 
connected) your Avid ISIS software license remains activated. 

• Host name changes — if you change the host name of your system Director you must first 
deactivate your license, delete the license binding file, and reactivate the license with the 
new name; see “License Requirement with Host Name Change” on page 103.

What You Need to Activate the ISIS Software License

Identification (ID) Numbers Where you can find them:

Activation ID The Activation ID is provided on an Activation ID and System ID card 
shipped with your new ISIS system. The Activation ID is used to activate the 
software license and has been linked to your System ID.
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License Activation Using an Internet Connection
To activate the ISIS software license from the System Director with an Internet connection:

1. Locate your System ID and Activation ID card included with your new System Director. 

2. Open the Avid License Control tool, click Start > Programs > Avid > Utilities > 
Avid License Control.

The Avid License Control tool opens. 

System ID The System ID is provided on an Activation ID and System ID card shipped 
with your new ISIS system. The System ID is used for expediting warranty 
verification and customer service.

Once activated, the License Profile tab of the Avid License Control tool 
displays information about your system. Click “Copy to Clipboard” to copy 
the information to your Clipboard. You can then cut and paste from the 
clipboard to an email or create a text file to save for your records or to send to 
Avid Customer Support.

Device ID The Device ID is only needed if you are activating your software on a system 
that is not connected to the Internet. This is provided through the Avid License 
Control tool during activation.

Identification (ID) Numbers Where you can find them:
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n After your Avid software is activated, the License Profile tab displays your System ID, 
Activation ID, and Device ID. 

3. Click Activate next to the Avid ISIS software.

4. Select “I want to activate my product using the Internet connection on this computer” and 
then click Continue. 

n IfTo activate the license using another computer’s Internet connection, see “License Activation 
Without an Internet Connection” on page 100.

5. Enter your system identification number in the System ID text box. 
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6. Enter your activation identification number in the Activation ID text box. 

7. Click Activate.

The Activation tool confirms your system information. When the activation is complete, a 
message indicates that your software has been successfully activated and the button changes 
to Deactivate.

8. (Option) If you are planning a dual System Director configuration, repeat this procedure to 
Activate your software license on your second System Director.

n If you have purchased a “failover” System Director for the ISIS | 7500 - 7000, both System 
Directors use the same System ID in a dual System Director configuration. Each System Director 
requires a separate Activation ID.

License Activation Without an Internet Connection

When you do an indirect activation, you are given a “.bin” activation file. This file is only good 
for a single activation. If you have done an indirect activation, and deactivate your license for 
any reason, you cannot use the same activation file to reactivate your license. You must repeat 
the “License Activation Without an Internet Connection” procedure and obtain a new “.bin” 
activation file.

To activate the ISIS software license from a separate computer:

1. Locate your System ID and Activation ID card included with your new System Director. 

2. Open the Avid License Control tool, click Start > Programs > Avid > Utilities > Avid 
License Control.

The Avid License Control tool opens. 

3. Click Activate next to the Avid ISIS software.

4. Select “I want to activate my product using the Internet connection on another computer.” 
then click Continue. 

5. Enter your system identification number in the System ID text box. 

6. Enter your activation identification number in the Activation ID text box. 

7. Click Next.

8. Follow the instructions in the Avid License Control tool, then click Next.

n Your System ID, Activation ID, and Device ID are displayed on the Activation tab, write these 
numbers down to use later. These IDs are displayed in the License Profile tab after your Avid 
software is activated. 
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9. On a computer with an Internet connection, open a Web browser and navigate to 
http://avid.com/license.

10. Follow the onscreen instructions on the web page.

The website creates a license.bin file. This file contains license information needed to 
activate your Avid ISIS software.

11. Copy the license.bin file to the ISIS System Director you want to activate (for example, on a 
USB flash drive).

12. Close the Web browser on the computer with the Internet connection. 

13. Return to the ISIS System Director where you left off in the Avid License Control tool (see 
the illustration in step 8) and click Next. 

14. Click Browse and navigate to the license.bin file on your ISIS System Director, then click 
Open. 

http://avid.com/license
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The Activation tool confirms your system information. When the activation is complete, a 
message indicates that your software has been successfully activated and the button changes 
to Deactivate.

15. (Option) If you are planning a dual System Director configuration, repeat this procedure to 
Activate your software license on your second System Director.

n If you have purchased a “failover” System Director for the ISIS | 7500 - 7000, both System 
Directors use the same System ID in a dual System Director configuration. Each System Director 
requires a separate Activation ID.

Deactivating the License

You must deactivate your ISIS software license when replacing the System Director so you can 
use the license on your new System Director. You must have an Internet connection to deactivate 
the software and its options. 

Deactivating the ISIS System Director software:

1. Stop your Avid ISIS System Director.

2. Open the Avid License Control tool, click Start > Programs > Avid > Utilities > Avid 
License Control.

The Avid License Control tool opens. 

3. Next to the Avid ISIS software, click Deactivate.

4. Click Yes.

The system deactivates and the button changes to Activate.
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5. Click Done to close the window.

License Requirement with Host Name Change

If you want to change the host name of your System Director, you must deactivate your ISIS 
software license, delete the license binding file, and reactivate the license after changing the host 
name. 

When changing the System Director host name:

1. Deactivate the Avid License on your Avid ISIS System Director (see “Deactivating the 
License” on page 103).

2. Browse to the following location on the System Director and delete the “binding.dat” file.

c:\ProgramData\Avid\Common\binding.dat 

3. Change the System Director host name.

4. Restart the System Director.

5. Reactivate the Avid License on your Avid ISIS System Director (see “What You Need to 
Activate the ISIS Software License” on page 98).



6 Configuring Two Stacks of ISIS Engines

This chapter explains how to configure your ISIS engines into two Management Domains 
(stacks); typically when setting up your ISIS environment with more than twelve engines. The 
standard ISIS configuration supports up to twelve engines with one or two System Directors. 

n ISIS environments typically are configured with two System Directors for redundancy protection 
against data loss. For information on connecting and configuring two System Directors, see 
“Configuring System Director Failover” on page 114.

The following are the guidelines when planning two stacks of ISIS engines:

• Each stack can contain a maximum of twelve engines; therefore all configurations larger 
than twelve engines must be configured for two Management Domains (two stacks)

• Each stack, regardless of the number of engines, is configured into two subnets (in this 
chapter, former VLAN 10 and VLAN 20 subnets are now VLAN 100 and VLAN 200 with a 
Subnet Mask of 255.255.252.0 to accommodate the possible IP addresses needed for 24 
engines)

• When adding more than twelve engines, you increase the amount of shared storage. The file 
and client counts are the same regardless of the number of engines and whether you have 
one or two stacks 

• An Avid ISIS configuration with two Management Domains can be managed by a single 
Avid Interplay configuration

• Maximum Storage Group size is capped at twelve engines; you cannot increase the size of a 
Storage Group that already has twelve engines by adding an engine in a different 
Management Domain

n Storage Groups cannot expand across Management Domains.

• Multiple Storage Groups are supported in each Management Domain; a minimum of two 
Storage Groups are required with more than twelve engines (or at least one Storage Group 
per stack)

• Configurations with more than twelve engines or two stacks require generation 2 hardware 
(ISS/IXS2000)

• Configurations with more than twelve engines or two stacks require the SR2500 or AS3000 
System Directors. For information on updating your System Directors see “Replacing the 
System Director” on page 174
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• Two stacks are linked by 10 Gb Ethernet connections using external switches (EXS)

For a list of supported external Ethernet switches, see the Avid ISIS ReadMe

• Each VLAN must use the same number of 10 Gb connections on the external switches 
between each stack

ISIS Two Stack Configuration

Each stack, regardless of the number of engines, is configured into two subnets (VLAN 100 and 
VLAN 200). The following illustration shows the division, and the 10 Gb Link Aggregation 
used to link the two Management Domains. 
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Two Stack Configuration
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External Switch Link Aggregation Connection Guidelines

The following table provides the recommended number of 10 Gb link aggregation connections 
between ISIS Management Domains when configuring more than twelve engines. Typically, you 
would not use more than one stack if your site has twelve engines or less. If planning on more 
than twelve engines, Avid recommends that you set up your initial ISIS environment with two 
stacks. Then when you expand to more than twelve engines, the additional engines can be added 
without reconfiguring your single stack environment and IP Address scheme. For information on 
10 Gb link aggregation connections, see “Configuring a 10 Gb Link Aggregation Group” on 
page 94.

For best performance each Management Domain should have the same number of engines in 
both stacks. A 10 Gb link aggregation connection goes from VLAN 100 of the first stack to the 
external switch and then another 10 Gb link aggregation connection goes from that external 
switch to VLAN 100 on the second stack. VLAN 200 has a 10 Gb link aggregation connection 
from the first stack to a second external switch and then another 10 Gb link aggregation 
connection that goes from the second external switch to VLAN 200 on the second stack. A 
diagram of these connections is shown in “Two Stack Configuration” on page 106.These four 
connections are considered one 10 Gb link aggregation connection described in the following 
table. You must have the same number of 10 Gb link aggregation connections on both VLANs 
between the Management Domains. These connections are bidirectional (full duplex) between 
the Management Domains. 

Each 10 Gb link aggregation connection provides 600 MB/s bandwidth. To get the best full 
bandwidth possible, make the 10 Gb link aggregation connections between the Management 
Domains as listed in the following table. For more details on the bandwidth between 
Management Domains, see the Avid ISIS Performance and Redistribution Guide.

Number of Engines 
in First Stack

Number of Engines 
in Second Stack

Number of 10 Gb Link Aggregation 
Connections per Subnet

Up to 12 engines 1 engines One 10 Gb Link Aggregation

Up to 12 engines 2 or 3 engines Two 10 Gb Link Aggregations

Up to 12 engines 4 engines Three 10 Gb Link Aggregations

5 or more engines 5 or more engines Four 10 Gb Link Aggregations
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IP Address Classes

You need a subnet with enough IP addresses to accommodate the number of engines, clients, and 
devices you are connecting to your ISIS shared storage environment. A Class C network 
typically provides 254 usable addresses. Your shared storage environment might need a larger 
block of IP addresses than a Class C network provides. The pool of addresses in a Class B 
network would be much larger than required. 

A 24 engine ISIS configuration uses a minimum of 408 IP addresses. If you plan on over 170 
clients, use a /22 or larger Network range (a /22 can accommodate 1024 addresses). The subnet 
examples shown in this chapter use VLAN 100 and VLAN 200 with a Subnet Mask of 
255.255.252.0 to accommodate the possible IP addresses needed for 24 engines. The other 
chapters in this guide use VLAN 10 and VLAN 20 with a Subnet Mask of 255.255.255.0 which 
does not include enough IP addressed for all the ISIS blades and maximum client count. 

IP Addressing With Two Stacks

The IP addressing scheme engines are described in “IP Addressing Overview” on page 80. This 
section expands the system and configuration to include up to 24 engines. The first table 
provides a review of the engine numbering scheme. The second table is an example on the 
engines configured into two stacks. 

Example of a Single Engine IP Address Assignments

ISB 0

192.168.100.10 (left side)
192.168.200.10 (right side)

ISB 1

192.168.100.11 (left side)
192.168.200.11 (right side)

ISB 2

192.168.100.12 (left side)
192.168.200.12 (right side)

ISB 3

192.168.100.13 (left side)
192.168.200.13 (right side)

ISB 4

192.168.100.14 (left side)
192.168.200.14 (right side)

ISB 5

192.168.100.15 (left side)
192.168.200.15 (right side)

ISB 6

192.168.100.16 (left side)
192.168.200.16 (right side)

ISB 7

192.168.100.17 (left side)
192.168.200.17 (right side)

ISB 8

192.168.100.18 (left side)
192.168.200.18 (right side)

ISB 9

192.168.100.19 (left side)
192.168.200.19 (right side)

ISB 10

192.168.100.20 (left side)
192.168.200.20 (right side)

ISB 11

192.168.100.21 (left side)
192.168.200.21 (right side)

ISB 12

192.168.100.22 (left side)
192.168.200.22 (right side)

ISB 13

192.168.100.23 (left side)
192.168.200.23 (right side)

ISB 14

192.168.100.24 (left side)
192.168.200.24 (right side)

ISB 15

192.168.100.25 (left side)
192.168.200.25 (right side)

Switch (ISS or IXS)

192.168.100.26

Switch (ISS or IXS)

192.168.200.26
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Each engine uses 17 IP addresses on two subnets. The following table shows an example of the 
starting and ending IP addresses for 24 engines on two VLANs.

Starting and Ending Engine IP Addresses for Two Stacks

VLAN 100 Subnet 
Stack 1

VLAN 220 Subnet 
Stack 1

VLAN 100 Subnet 
Stack 2

VLAN 200 Subnet 
Stack 2

Engine 1 
192.168.100.10
192.168.100.26

Engine 1
192.168.200.10
192.168.200.26

Engine 1
192.168.101.10
192.168.101.26

Engine 1
192.168.201.10
192.168.201.26

Engine 2
192.168.100.27
192.168.100.43

Engine 2
192.168.200.27
192.168.200.43

Engine 2
192.168.101.27
192.168.101.43

Engine 2
192.168.201.27
192.168.201.43

Engine 3
192.168.100.44
192.168.100.60

Engine 3
192.168.200.44
192.168.200.60

Engine 3
192.168.101.44
192.168.101.60

Engine 3
192.168.201.44
192.168.201.60

Engine 4
192.168.100.61
192.168.100.77

Engine 4
192.168.200.61
192.168.200.77

Engine 4
192.168.101.61
192.168.101.77

Engine 4
192.168.201.61
192.168.201.77

Engine 5
192.168.100.78
192.168.100.94

Engine 5
192.168.200.78
192.168.200.94

Engine 5
192.168.101.78
192.168.101.94

Engine 5
192.168.201.78
192.168.201.94

Engine 6
192.168.100.95
192.168.100.111

Engine 6
192.168.200.95
192.168.200.111

Engine 6
192.168.101.95
192.168.101.111

Engine 6
192.168.201.95
192.168.201.111

Engine 7
192.168.100.112
192.168.100.128

Engine 7
192.168.200.112
192.168.200.128

Engine 7
192.168.101.112
192.168.101.128

Engine 7
192.168.201.112
192.168.201.128

Engine 8
192.168.100.129
192.168.100.145

Engine 8
192.168.200.129
192.168.200.145

Engine 8
192.168.101.129
192.168.101.145

Engine 8
192.168.201.129
192.168.201.145

Engine 9
192.168.100.146
192.168.100.162

Engine 9
192.168.200.146
192.168.200.162

Engine 9
192.168.101.146
192.168.101.162

Engine 9
192.168.201.146
192.168.201.162

Engine 10
192.168.100.163
192.168.100.179

Engine 10
192.168.200.163
192.168.200.179

Engine 10
192.168.101.163
192.168.101.179

Engine 10
192.168.201.163
192.168.201.179
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Static IP Addresses Available

Configure any unused IP addresses as static IP addresses to avoid interfering with the ISIS 
engines. The following table demonstrates where the available IP addresses are located in the 
ISIS network. Your IP addresses depend on the address scheme you use to configure the ISIS 
network. 

Connecting Two Stacks of Engines

The process of connecting multiple stacks of Engines to the Avid ISIS network starts with 
cabling and connecting single stacks as described in “Configuration Overview” on page 83. First 
you logically configure the addresses for the engine, then you physically make the connection to 
complete the process. To install software, see “Installing Software and Configuring 10 Gb Link 
Aggregation” on page 80.

Engine 11
192.168.100.180
192.168.100.196

Engine 11
192.168.200.180
192.168.200.196

Engine 11
192.168.101.180
192.168.101.196

Engine 11
192.168.201.180
192.168.201.196

Engine 12
192.168.100.197
192.168.100.213

Engine 12
192.168.200.197
192.168.200.213

Engine 12
192.168.101.197
192.168.101.213

Engine 12
192.168.201.197
192.168.201.213

VLAN 100 Subnet 
Stack 1

VLAN 220 Subnet 
Stack 1

VLAN 100 Subnet 
Stack 2

VLAN 200 Subnet 
Stack 2

IP Addresses Used
VLAN 100

IP Addresses Used 
VLAN 200

First stack of twelve engines Engine one 192.168.100.10 to 
Engine twelve 192.168.100.213

Engine One 192.168.200.10 to 
Engine twelve 192.168.200.213

Available static IP Address 
block 

192.168.100.214 to 
192.168.100.254

192.168.200.214 to 
192.168.200.254

Second stack of twelve 
engines

Engine one 192.168.101.10 to 
Engine twelve 192.168.101.213

Engine One 192.168.201.10 to 
Engine twelve 192.168.201.213

Available static IP Address 
block 

192.168.101.214 to 
192.168.101.254

192.168.201.214 to 
192.168.201.254

Available DHCP IP Address 
block 

192.168.102.1 to 
192.168.102.254

192.168.202.1 to 
192.168.202.254
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Setting Up Two Stacks

Regardless of the number of engines you are planning in your Avid ISIS stack. The following 
procedure summarizes the required tasks after you have decided on your IP address scheme with 
your Network administrator (see “IP Addressing With Two Stacks” on page 108).

To setup two stacks of engines:

1. Setup and configure each stack separately as you would in a single stack configuration (see 
“Connecting ISIS Hardware” on page 66. 

Each for the two stacks connect to the same System Directors.

2.  Once the two Management Domains are configured, set the appropriate 10 Gb Link 
Aggregation between the stacks with external switches (see “Configuring a 10 Gb Link 
Aggregation Group” on page 94).

3. Upgrade your software if you are currently on an earlier ISIS | 7500 - 7000 software version 
before setting up the Storage Groups in the separate Management Domains (see “Avid ISIS | 
7500 - 7000 Upgrade Guidelines” on page 136).

4. See the Avid ISIS Administration Guide for setting up your Storage Groups and Workspaces. 
The two stacks of engines are identified using a Domain ID in the Storage Manager page of 
the Management Console.

n The two stacks cannot be part of the same Storage Group. Each stack must have at least one 
Storage Group. 

Reconfiguring One Stack into Two Stacks

In many cases you do not have to delete your data if you are splitting your stack of engines into 
two Management Domains. If you have one large Storage Group and there is enough available 
space in your existing stack, you can remove engines, triggering a redistribution of the data to 
other engines, see “Replacing an Engine” on page 172. This will make the chassis available to be 
moved to the other Management Domain where they can be made into a new Storage Group, or 
adding to an existing Storage Group in that Management Domain. If you added that engine to an 
existing Storage Group in the new Management Domain, a Redistribution will be incurred. 

If you have several Storage Groups in your current stack, you can select the complete Storage 
Group by removing the engines with that Storage Group to start the new stack.

The following procedure summarizes the tasks to break a one-stack configuration into two 
Management Domains. First establish your IP address scheme with your Network administrator 
(see “IP Addressing With Two Stacks” on page 108), then complete these tasks.
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To disassemble the existing stack:

1. Upgrade to the latest ISIS software on the existing stack.

2. Remove all 10 Gb Link Aggregation cables (if needed).

3. Disable all 10 Gb Link Aggregation groups (“Enable/Disable”) in the stack, see 
“Configuring a 10 Gb Link Aggregation Group” on page 94.

4.  Delete all 10 Gb Link Aggregation groups (“Delete configuration”) in the stack, see 
“Configuring a 10 Gb Link Aggregation Group” on page 94.

5. Remove the engines from stack by unplugging the engine interconnect cables.

6. Use the “Reset Local Chassis ID” command in the ISIS Switch Blade Agent Page to 
renumber the engines in the new Management Domain (see the Avid ISIS Administration 
Guide).

7. Avid recommends running the Switch Diagnostics on stack 1 to make sure there are no 
errors.

8. Create the 10 Gb Link Aggregation groups in the stack that will be used to connect to the 
external switches (EXS).

9. Connect to the EXS to each VLAN EXS after it is configured.

c Make sure the ports on the EXS to which you are connecting these groups are configured 
for link aggregation, otherwise you will end up with a loop.

To assemble the new stack:

1. Access the switch management port on one of the new engines that will be added to the new 
stack (see “Setting Up Network Addresses In the Stack” on page 67).

2. Go to System > Configuration > Basic page and update the IP configuration of the engines 
that were removed from the old stack (see “Connecting ISIS Hardware” on page 66).

3. Reset the IP address scheme for each new or reconfigured engine (see “Setting Up Network 
Addresses In the Stack” on page 67).

4. Access the switch management port of one engines from the old stack.

5. Go to System > Configuration > Add/Remove chassis and update the IP configuration of the 
old stack

6. Use the “Reset Local Chassis ID” command in the ISIS Switch Blade Agent Page to 
renumber the engines that were removed from the old stack (see the Avid ISIS 
Administration Guide).

7. Repeat step 4, 5, and 6 until all chassis have been reconfigured.

8. Cable the engines for stack 2 using the engine interconnect cables that were removed from 
stack 1.
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9. Avid recommends running the Switch Diagnostics on stack 2 to make sure there are no 
errors.

10. Create the 10 Gb Link Aggregation groups in the stack that will be used to connect to the 
external switches (EXS).

11. Connect to the EXS to each VLAN EXS after it is configured.

c Make sure the ports on the EXS to which you are connecting these groups are configured 
for link aggregation, otherwise you will end up with a loop.



7 Configuring System Director Failover

This chapter explains how to enable the software for a failover using two System Directors.

n For true redundancy Avid recommends connecting the second System Director to a different 
engine than the first System Director. The Active and the Standby System Directors must be the 
same model server; you cannot mix SR2500s and AS3000 servers.

n This feature requires an Application Key or software licensing software be installed on both the 
Active and Standby System Directors. 

System Director Failover

When using two System Directors, one is referred to as the Active System Director and the other 
one is the Standby System Director. The file system on the Standby System Director is 
synchronized with the Active System Director. There might be a brief interruption in client 
connectivity but all clients re-connect automatically when the Standby System Director becomes 
active. This procedure uses the following nomenclature:

• When adding a new System Director to an existing Avid ISIS system or creating a failover 
system configuration, the original System Director is called the existing System Director 
and the new System Director is called new. 

• When installing two new System Directors to create a failover system configuration, one 
System Director is called Active and the other Standby. 

Each System Director must connect to right and left sides of the engine to allow both of the 
System Directors to reach the two internal subnets. Connect the two System Directions under the 
following conditions:

• After you have physically configured the system and loaded the Avid ISIS software on both 
System Directors. 

• When the System Director service is stopped on both systems.

• Connect the Ethernet port of the Active System Director to connection 1 on the left side of 
the engine (from the rear). Connect the Ethernet port of the Standby System Director to 
connection 1 on the right side of the engine (from the rear).
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Enabling a System Director

To enable a failover system for Avid ISIS:

1. Connect two System Directors (using straight or crossover cable) as shown in the following 
figure. 

2. Enable the software on both systems, see “Configuring System Director Failover” on 
page 114.

n The configuration information for the notification service (SMTP information, contacts, and 
filters) is stored in the registry on the System Director. This information is not currently 
replicated to the failover System Director and must be entered manually on both System 
Directors. For information on setting up the notification service, see Setting up Error 
Notification in the Avid ISIS Administration Guide.

Setting IP Addresses for Crossover Link

Avid recommends the System Director IP addresses for failover configurations that are listed 
below. If you use different addresses, be sure to note them and have them available before 
proceeding. You set the IP addresses in the Network Connections dialog box, which you access 
from the Windows Control Panel. For information on setting Windows IP addresses, see the 
documentation that came with your operating system.
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To set IP addresses:

1. Go to Start > Control Panel > Network Connections for each System Director.

2. Set the Existing System Director to the following TCP/IP addresses for ports 1 and 2:

- Onboard Ethernet port 1 (ETH1) - 192.168.1.1 netmask 255.255.255.0

- Onboard Ethernet port 2 (ETH2) - 192.168.2.1 netmask 255.255.255.0

3. Set the New System Director to the following TCP/IP addresses for ports 1 and 2:

- Onboard Ethernet port 1 (ETH1) - 192.168.1.2 netmask 255.255.255.0

- Onboard Ethernet port 2 (ETH2) - 192.168.2.2 netmask 255.255.255.0

Configure a Failover Connection

Setting up the ISIS system for a System Director failover is done on two System Directors. The 
first System Director is referred to as the Active System Director and the second System 
Director is referred to as the Standby System Director. 

n Notify all clients that you are stopping the System Director.

In the procedure below, the following example IP addresses are used:

To set up a failover connection on the Active System Director:

1. Load the ISIS software on the Active System Director as described in “Loading the 
Software” on page 84.

2. In the ISIS Launch Pad, click ISIS Control Panel icon or Start > Programs > Avid > ISIS 
System Director and select Control Panel. 

Example IP Addresses for Dual System Director Failover Configuration

Active System Director Standby System Director

Virtual IP Address 192.168.10.253 192.168.20.253

Local Interface 192.168.10.100 192.168.20.100

Local Machine First Path 192.168.1.1 192.168.1.2

Local Machine Second Path 192.168.2.1 192.168.2.2

Remote Machine First Path 192.168.1.2 192.168.1.1

Remote Machine Second Path 192.168.2.2 192.168.2.1
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3. Click Stop System Director. 

4. Click Change Virtual System Director Name and type a name in the Virtual System Director 
Name text box, then click OK.

n You must assign the same virtual name to both System Directors.

5. (First new System Director) Select Create Active File System and click OK. 

c If you already have a running System Director do not create a new file system. If you create 
a new file system on a System Director that already has a file system all of your existing 
data will be lost.

The Avid ISIS System Director service automatically starts when complete. In the System 
Director Control Panel, the “System Director is running” display turns green.

6. Click Stop System Director.

7. Click the Dual System Director tab.

8. Select “Enable Dual System Director Configuration.”
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9. Configure the Virtual Addresses on both systems by doing the following:

a. Choose two unused static IP address that are used as the Virtual IP addresses for both 
System Directors.

b. Map the Virtual IP address to the corresponding real IP address for each of the System 
Directors.

c. Register both of the Virtual IPs in DNS with the Virtual System Director Name.

10. In the Local Machine area, do the following:

a. Leave the Monitor port set to 5000. If you have another application that uses port 5000, 
change the Monitor port to an available port number. This port number must be the same 
on both the existing and the new System Directors.

b. Set the Local Machine First and Second Path IP addresses; for examples, see .

c. Set the Local Machine Second Path IP address to local IP 2.

d. Set the Remote Machine First Path IP address.

e. Set the Remote Machine Second Path IP address.

The Active System Director has now been configured. Leave the Active System 
Director as is; stopped and with the ISIS Control Panel and Dual System Director 
Configuration window open. On the Active System Director, the Dual System Director 
tab should look like the following:

11. [Standby System Director] Load the ISIS software as described in “Loading the Software” 
on page 84.

12. [Standby System Director] Click System Director Control Panel from the ISIS Launch Pad 
or Start > Programs > Avid > ISIS System Director and select Control Panel.
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13. [Standby System Director] Click Stop System Director.

14. [Standby System Director] Click Change Virtual System Director Name and type a name in 
the Virtual System Director Name text box, then click OK.

n You must assign the same virtual name to both System Directors.

15. [Standby System Director] Click the Dual System Director tab.

16. [Standby System Director] Select “Enable Dual System Director Configuration.”

17. [Standby System Director] Configure the Virtual Addresses on both systems by doing the 
following:

a. Choose two unused static IP address that are used as the Virtual IP addresses for both 
System Directors. 

b. Map the Virtual IP address to the corresponding real IP address for each of the System 
Directors. 

c. Register both of the Virtual IPs in DNS with the Virtual System Director Name.

18. In the Local Machine area, do the following:

a. Leave the Monitor port set to 5000. If you have another application that uses port 5000, 
change the Monitor port to an available port number. This port number must be the same 
on both the existing and the new System Directors.

b. Set the Local Machine First Path IP address to local IP 1.

c. Set the Local Machine Second Path IP address to local IP 2.

d. Set the Remote Machine First Path IP address.

e. Set the Remote Machine Second Path IP address.

The Standby System Director has now been configured. Leave the Standby System 
Director as is; stopped and with the ISIS Control Panel and Dual System Director 
Configuration window open. On the Standby System Director, the Dual System Director 
tab should look like the following:
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19. Validate the crossover connections as follows:

a. On the standby (receiving) System Director, click Validate Receive.

b. On the active (sending) System Director, click Validate Send.

n Make sure to click Validate Receive on the standby System Director before you click Validate 
Send on the active System Director. Clicking Send first can result in errors.

20. On the active (sending) System Director, the Validate Send dialog box opens. 
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At first, the dialog box indicates that it is setting up the communication between the two 
System Directors and waiting for a response. When communication is established, the dialog 
box message alternates between Sending out inquiry and Valid response. The number of 
Successful Round Trips indicates the number of packets sent between the System Directors.

On the receiving System Director, the Validate Receive dialog box displays the packets 
received, incrementing for as long as you run the validation test.

21. On each system, close the Validate Send or Validate Receive dialog box.

22. Validate the crossover connections in the other direction.

Make sure that the sending and receiving systems show similar results. 

23. Click the File System tab on the Standby System Director.

24. Select Create Standby System Director and click Apply. 

The Avid ISIS System Director service automatically starts when complete. In the System 
Director Control Panel, the “System Director is running” display turns green.

25. Click Start System Director on both the Active and Standby System Directors and close the 
ISIS Control Panels on each system.

Stopping and Restarting the System Directors

In all ISIS failover configurations, you can stop the Active System Director and watch the 
Standby System Director become the Active System Director. When you restart the System 
Director that was previously Active, that System Director now becomes the Standby System 
Director. If you stop and restart the Standby System Director it remains the Standby System 
Director. The following procedures describes how you to stop and start the System Directors. 

n If the System Director fails, stop and restart that System Director. Very often a single stop and 
start of the System Director corrects the problem. 
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To stop and start the System Director using the Launch Pad:

1. If the ISIS Launch Pad is not displayed on the Avid ISIS System Director Desktop, click the 
ISIS Launch Pad icon in the Taskbar’s System Tray to display or hide the Launch Pad. 

n You can also open other ISIS tools by clicking the icons in the Launch Pad.

The ISIS Launch Pad is displayed.

2. Start or stop the System Director by clicking one of the following icons in the ISIS Launch 
Pad. 

t Click the blue square icon to stop the System Director.

t Click the blue triangle icon to start the System Director.
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To stop and start the System Director using the ISIS Control Panel:

1. In the ISIS Launch Pad, click ISIS Control Panel icon or Start > Programs > Avid > ISIS 
System Director and select Control Panel. 

2. Start or stop the System Director by clicking the appropriate buttons in the ISIS Control 
Panel. 

t Click Stop System Director to stop the System Director.

t Click Start System Director to start the System Director.



8 Status LEDs and Stacking Problems

This chapter provides an explanation of the light-emitting diodes (LEDs) located on the different 
sections of the Avid ISIS engines. It also provides a information on how to recover from a 
stacking problem.

The ISS and IXS have activity and link LEDs for each port. The location of these LEDs are 
shown in “Integrated Ethernet Switches” on page 22. These LEDs provide the following 
functions: 

• Activity — The activity LED indicates that the port is in use.

• Link — The link LED indicates an active connection on the port.

LED Locations and Colors

The status LEDs are used to indicate errors and provide status on the different phases of the 
software installation. The LED colors and blinking indicate the following functions:

• Green-blinking — System or section is getting ready or System is operation as expected

• Green-on solid — System or section is operation as expected and operational 

• Amber-blinking — Minor failures occurring, but not fatal

• Amber-on solid — Fatal or almost fatal error has occurred, system or section is not 
operational.

21 3 4 5 6 7 8
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LED Summaries

When determining errors, the status LED blinks at one of the following three rates or stays 
On (on solid). 

• Slow: 0.5 Hz

• Medium: 2.0 Hz

• Fast: 5.0 Hz

The following table provides a description of the ISS status LEDs.

The following table provides a description of the ISB status LEDs.

ISS LED Summary

Color and Blink Speed Status

Green – slow Starting the Operating System

Green – on with 50 ms of black each second Master is operation as expected

Green – on with 50 ms of amber each second Backup is operation as expected

Amber – fast High temperature (> 60C) 
Temperature critical (> 70C) 
Waiting for temperature to drop

Amber – on solid Temperature OK/Not booting yet
Errora (followed by restart, but restart might not 
work)

a. Possible errors include: missing critical application, low level code problem, or temperature is critical.

ISB LED Summary

Color and Blink Speed Status

Green – slow Starting the operating system

Green – fast Degraded state

Green – on solid System is operation as expected

Amber – slow, all ISBs asynchronously No engine configuration
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The following table provides a description of the Engine LEDs.

The following table provides a summary of the Engine LEDs during software installations.

Amber – fast High temperature (> 60C) 
Temperature critical (> 70C) 
waiting for temperature to drop

Amber – on solid ISB has been taken offline in the user interface or 
Temperature OK/Not booting yet Error (followed by restart, 
if restart not working)

Possible errors include: missing critical application, low 
level code boot problem, or temperature is critical.

Amber and Green – alternating fast flashing 
(irregular)

ISB cannot boot because of a memory failure

The ISB needs to be replaced.

ISB LED Summary (Continued)

Color and Blink Speed Status

Engine LED Summary (Master ISS and All ISBs Synchronously)

Color and Blink Speed Status

Green – slow External request via ISS agent

Green – medium Stacking failure (error or collision)

Green – medium Engine error (anywhere)

Software Installation LED Reporting

Color and Blink Speed Status

Green – on solid No installation in progress

Amber – ½ second interval Installation starting, installing in phase 0

Amber – 1 second interval Installation in phase 1

Amber – 2 second interval Installation in phase 2

Amber – 3 second interval Installation in phase 3

Amber – fast Installation failed
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Recovering from Stacking Problems

If your Avid ISIS shared storage network has a serious problems as a result of the setup, it might 
necessary to recover the stack. Here are a few possible problems:

• Traffic loops were introduced

• Switch does not have the right IP address 

• IP addresses seem to flipping; sometimes belonging to one switch, and then belonging to 
another switch

Set One Switch Back to Default

The problem might only be with one particular switch or engine. If you think this is the case (for 
example, a switch that was added does not have the right IP address), then perform the 
following.

To set a switch back to the default:

1. Disconnect the interconnect cables to both switches in the chassis of the problem switch. (If 
the problem switch is an IXS, disconnect all stacking cables from each switch in the 
chassis.)

2. In the Add/Remove Chassis page of the IXS, click Delete for the problem chassis.

3. Connect through the management port to the problem switch.

4. Use the management IP to go to the Switch Agent of the problem switch. For example 
https://192.168.0.10:5015/.

5. Navigate to the “Advanced” page.

6. Under Switch Blade, click “Reset to factory defaults.”

7. Enter the password when prompted to reset the switch to defaults.

The switch and storage blade password is se-admin and the System Director password is 
is-admin.

8. The switch restarts.

When the switch starts up, it has IP address “192.168.10.26” and the password is reset to 
default.

9. If the problem switch is an:

- IXS — Click Add from another IXS, or, if none is available, click Add from another 
ISS.

- ISS — Click Add from the IXS to which this switch will connect.

10. Connect the interconnect cable from the problem switch to the IXS. 
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- If the problem switch is an IXS, connect an interconnect cable to another ISS.

- If the problem has been resolved, connect the interconnect cable from the switch on the 
other VLAN subnet to the IXS on fixed subnet. If the problem switch was an IXS, 
re-connect all other interconnect cables in the engine.

Rebuilding the Stack

The following procedure summarizes how to rebuild the entire stack of engines. 

To rebuild the stack:

1. Disconnect all interconnect cables between all switches.

2. Pull each switch by removing them from the engine. 

This clears any traffic loop problems.

3.  Reseat the first IXS in the engine and connect through the management port of the first IXS.

4. Use the management IP address to access the switch’s Agent Page (for example 
https://192.168.0.10:5015/).

5. Navigate to the Advanced Web page.

6. Under Switch Blade, click “Reset to factory defaults.”

n The switch and storage blade password is se-admin and the System Director password is 
is-admin. The System Director Web Page Administrator default password is blank.

7. Enter the password when prompted to reset the switch to defaults.

8. The switch restarts.

When the switch starts, it has IP address “192.168.10.26” and the password is reset to the 
default. Through the Switch Agent, configure the switch with the proper IP address range, 
netmasks, time zone, passwords, see “Setting Up Network Addresses In the Stack” on 
page 67.

9. Perform the appropriate procedure for connecting your engines, see “Connecting ISIS 
Hardware” on page 66.
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Information

Gather the following information before the upgrade. This information is critical to 
troubleshooting an Avid ISIS. 

• Current Avid ISIS software version

• Avid ISIS Administrator password

• Switch agent password

• Number of Avid ISIS engines

• ISB Size: 500 GB ____ 1 TB____ 2 TB____ 4 TB____ 8 TB____

• Number of Storage Groups

• Number and type of editing clients: (Windows or Macintosh, and using what zones) 

• Number of AirSpeeds

• Other workgroup server details (for example Interplay; host names, passwords, and 
versions)

Zone 2 Switch Information

Note the following switch information:

• Type of switch (Cisco/Foundry)

• Number of switches

• Location of configuration files

System Director Information

Note the following System Director information:

Virtual Network Name and IP Addresses

Virtual IP Left
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ISIS Engine/Switch Information

Fill out the following engine and switch information for the on site equipment.

Are any engines using Link Aggregation on the 10 Gb links? ______________

Note what engines that are using 10 Gb links and the configuration (a maximum of eight 10-Gb 
links are supported):

Virtual IP Right

Virtual ISIS Name

Attribute System Director 1 System Director 1

Host name

Administrator Password

IP address

Left ISIS IP Address 

Left Default Gateway 

Right ISIS IP Address 

Right Default Gateway

First failover IP address

Second failover IP address

Virtual Network Name and IP Addresses

Engine #1 Serial Number: ______________________

Left IXS/ISS IP: Right IXS/ISS IP:

First Left ISB IP: First Right ISB IP:

Left IXS IP: Right IXS IP:
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Engine #2 Serial Number: ______________________

Left IXS/ISS IP: Right IXS/ISS IP:

Left External Zone 2 
switch IP address (if 
configured):

Right External Zone 2 
switch IP address (if 
configured):

Engine #3 Serial Number: ______________________

Left IXS/ISS IP: Right IXS/ISS IP:

Left External Zone 2 
switch IP address (if 
configured):

Right External Zone 2 
switch IP address (if 
configured):

Engine #4 Serial Number: ______________________

Left IXS/ISS IP: Right IXS/ISS IP:

Left External Zone 2 
switch IP address (if 
configured):

Right External Zone 2 
switch IP address (if 
configured):

Engine #5 Serial Number: ______________________

Left IXS/ISS IP: Right IXS/ISS IP:

Left External Zone 2 
switch IP address (if 
configured):

Right External Zone 2 
switch IP address (if 
configured):

Engine #6 Serial Number: ______________________

Left IXS/ISS IP: Right IXS/ISS IP:

Left External Zone 2 
switch IP address (if 
configured):

Right External Zone 2 
switch IP address (if 
configured):
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Engine #7 Serial Number: ______________________

Left IXS/ISS IP: Right IXS/ISS IP:

Left External Zone 2 
switch IP address (if 
configured):

Right External Zone 2 
switch IP address (if 
configured):

Engine #8 Serial Number: ______________________

Left IXS/ISS IP: Right IXS/ISS IP:

Left External Zone 2 
switch IP address (if 
configured):

Right External Zone 2 
switch IP address (if 
configured):

Engine #9 Serial Number: ______________________

Left IXS/ISS IP: Right IXS/ISS IP:

Left External Zone 2 
switch IP address (if 
configured):

Right External Zone 2 
switch IP address (if 
configured):

Engine #10 Serial Number: ______________________

Left IXS/ISS IP: Right IXS/ISS IP:

Left External Zone 2 
switch IP address (if 
configured):

Right External Zone 2 
switch IP address (if 
configured):

Engine #11 Serial Number: ______________________

Left IXS/ISS IP: Right IXS/ISS IP:

Left External Zone 2 
switch IP address (if 
configured):

Right External Zone 2 
switch IP address (if 
configured):
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On Site Spares

List all Avid ISIS spare parts that are onsite:

Engine #12 Serial Number: ______________________

Left IXS/ISS IP: Right IXS/ISS IP:

Left External Zone 2 
switch IP address (if 
configured):

Right External Zone 2 
switch IP address (if 
configured):

Spare Components and Cables

Part Quantity Firmware Version (if known)

ISBs

ISSs v1.x or v2.x (ISS2000) hardware

IXSs v1.x or v2.x (IXS2000) hardware

XFP, X2, and SFP+ 
(used with external switches)

N/A

Intel® network boards

10 Gb fiber cable N/A

CAT5e/6 cable N/A

Xenpack® (if Cisco)

3rd party switches

Additional Parts Available
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Spares Checklist

Use the following list to assure that you have the correct parts onsite when performing any Avid 
ISIS upgrade. This can be a mix of customer spares and parts brought onsite by upgrade 
technicians.

• 1 — IXS and IXS2000

• 1 — ISS and ISS2000

• 2 — ISBs

• 1 — XFP and SFP+ (used with external switches)

Additional spares for a comprehensive spares parts list:
• If Cisco switches are in use: 1 Xenpack, 1 SC-LC cable

• If Foundry switches are in use: 1 additional XFP, 1 LC-LC cable 



10 Avid ISIS | 7500 - 7000 Upgrade 
Guidelines

All Avid ISIS upgrades are to be performed by Avid ISIS Avid Certified Support Representatives 
(ACSR). 

• If you have not already noted the host names, passwords, IP address, and other important 
network details, see “Avid ISIS | 7500 - 7000 Pre-Upgrade Information” on page 130. 

• Do not perform an Avid ISIS system upgrade if your network is not in optimum working 
order; see “Health Check” on page 136.

• If you have documented the preupgrade information and your Avid ISIS is healthy, you can 
start the Avid ISIS system upgrade; see “Software Upgrade” on page 137.

• After you finish the upgrade, confirm everything is functioning properly; see “Post Upgrade 
System Verification” on page 147.

Health Check

Before changing the system, perform the following quick checks to verify that the system is in 
good working order. Do not perform an upgrade if there are any issues with the system. Correct 
all problems before performing the upgrade.

Before upgrading:

1. Log into the ISIS Management Console and click Storage Managers. If any Storage 
Managers are not green, investigate any error statuses. For details on troubleshooting 
Storage Managers error statuses, search the Knowledge Base at 
www.avid.com/onlinesupport for “ISB Error Status Glossary.”

2. Open a command window and ping your switch. Make sure you can ping the switch and can 
access any client on the switch.

3. Ping each System Director on both subnets (left and right, not the crossover paths). Each 
System Director is accessible from both paths from any client or switch on the Avid ISIS 
system. 

4. Ping the default gateway on the left and right network from System Director and ISSs. This 
is accessible from any point in the network. You can ping directly from and ISS/IXS from 
the Tools tab on the switch web page.

http://www.avid.com/onlinesupport
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5. Log into each System Director and open the System Director’s Control Panel. Make sure 
both paths are up, and standby is receiving and replicating metadata. Check the Metadata 
Status tab in the System Director’s Control Panel on the standby, and make sure the date 
stamp in the saved and replicated fields is current and updating frequently. Standby 
instructions apply only if there is a failover machine present.

6. Check the system event logs on the System Directors for recent error events. 

7. Perform a thorough physical inspection of the network cables:

- Find and fix all missing retainers, strains, sharp bends, signs of physical abuse. 

- Make sure that labels are visible, physically firmly in place, and legible. 

- Confirm that all fans and ventilation areas are free of obstructions, dirt, lint, and debris. 

- Make sure that there is clearance front and rear to allow components to be replaced 
without obstructions for their full chassis travel length. 

- Make sure cables are not zip tied to the power supplies or the switches. 

8. (Dual System Director Configuration) Perform System Director Active to Standby Failover 
— Turn off one of the System Directors and verify in the System Director Control Panel that 
the Active Mode indicator has turned red. Turn the System Director back on and see that 
Active Mode displays Standby.

9. Check the system drive status on the System Director. 

- On the AS3000, click Start > Programs > Intel -> Intel Rapid Storage Technology 
right-click the Intel Rapid Storage Technology icon in the task bar. The icon is a green 
check mark when the drives are healthy. 

- On the SR2500, click Start > Programs > RAID Web Console 2 > Start UI and see that 
the Server Heath is green. If not, search www.Intel.com and search for Intel® RAID 
Software User’s Guide for corrective actions.

Software Upgrade

The following is a generalized procedure for upgrading an ISIS. 

To upgrade Avid ISIS | 7500 - 7000 v2.1.1 and later, upgrade the clients before you upgrade the 
infrastructure. This is necessary because ISIS client software before v2.1.1 is not supported in 
the ISIS v2.1.1 and later infrastructure. However, v2.1.x client software is supported in v1.4 and 
later infrastructures. After you upgrade the clients, you can upgrade the Avid ISIS infrastructure. 

The clients are defined as follows:

• Avid editing applications

• Interplay Assist and Instinct

http://www.Intel.com
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• Interplay Access

• Avid Approved Applications Initiative such as Pro Tools and Final Cut Pro

The infrastructure is defined as follows:

• System Director — System Director software and upgrade Storage Blades (ISBs) and 
Switch Blades (ISS/IXSs) in the Avid ISIS engines

• Interplay servers — Interplay Engine, Interplay Media Indexer, Interplay Transfer, and 
CaptureManager

• Capture devices — AirSpeed, AirSpeed Multi Stream, and Avid Interplay Low-Res Encoder

Component Requirements From Previous ISIS | 7500 - 7000 Releases

You might need to update components outside the ISIS system depending on the current version 
of your ISIS software. If you are on a version prior to 4.0, Avid recommends that you update 
your System Director Storage Blades (ISBs) and switches (ISSs and IXSs) to v4.2.x prior to 
updating to v4.7 or later. If you are setting up a new ISIS system or updating an ISIS 
environment that is already at v4.0, continue with ISIS | 7500 - 7000 Upgrades.

For the supported upgrade paths from earlier versions of Avid ISIS, see the v4.7 or later 
ReadMe.

ISIS | 7500 - 7000 Upgrades

The following process summarizes the upgrade process to v4.7 or later. Avid ISIS | 7500 - 7000 
v4.7 and later infrastructure software requires Avid ISIS v4.7 or later Client Manager software. 

Considerations when upgrading System Directors and the ISIS file system metadata: 

• The preferred method of upgrading the file system metadata is using Partition0 and 
Partition1. These are copies of the in-memory file system and the most accurate accounting 
of the ISIS. 

• The PartitionDump.bin file is a very different representation of what Avid believes to be the 
important parts of the file system that should persist. Do not be tempted to import 
PartitionDump.bin, although this may be necessary if problems are seen with loading both 
Partition0 and Partition1. Since only the active System Director writes out 
PartitionDump.bin any PartitionDump.bin on the standby is out of date. Never use the 
PartitionDump.bin from the standby System Director in an upgrade.

• Sometimes one of the Partition files fails to load but the other succeeds. This is considered a 
successful upgrade and is still the preferred method of upgrading.

• There have been cases of loading old PartitionDump.bin files and losing data. Always 
contact your support team before attempting to import PartitionDump.bin.
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Preparing for the Upgrade

1. Download the ISIS v4.7 software kit from the Avid Download Center 
(www.avid.com/US/support/downloads) to your Active System Director.

2. Create a new “test” workspace in a storage group. (This will be used later to verify that the 
upgrade completed successfully.)

3. Log into the Administrator account on the Standby System Director and open the System 
Director Control Panel. Wait for the indication that metadata changes have been received 
and saved. Allow this to happen twice. Stop the Standby System Director using the System 
Director Control Panel.

4. Log into the Active System Director and do the following:

a. Open the System Director Log Viewer

b. Stop the System Director using the System Director Control Panel

c If there are any errors please stop and contact your support team.

5. Check the modify date time of the files Partition0, Partition1 and PartitionDump.bin. Make 
sure the Date Modified times are identical or at most, one minute apart, and should reflect 
the current date and time. If the times differ by more than a minute, or are more than 
one minute old, stop and contact your support team. 

Upgrading from a 4.x to a newer v4.x:

1. Create a new folder on the D: drive and copy the following files to the new folder prior to 
installing the v4.x kit:

a. Partition0 

b. Partition1

c. PartitionDump.bin (Used only when the normal partition files fail to load)

2. Load the ISIS v4.x software kit on the Active System Director.

a. Double-click AvidISISSetup.exe.

3. After the kit install completes, open the System Director Log Viewer. If there are problems 
upgrading the metadata please stop and contact your support team.

http://www.avid.com/US/support/downloads
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Completing the Upgrade

1. After the new Active System Director has started, log into the management console and 
make sure the “test” workspace exists on the Workspaces page. If it does not please stop 
the System Director and contact your support team.

2. Upgrade the Standby System Director. Make sure that there are no Partition files in the v4.x 
directory as they are not needed. If you are upgrading on the same system then move these 
files to a temporary folder and do the following:

a. Load the ISIS v4.x software kit on the Standby System Director.

b. Double-click the AvidISISSetup.exe file in the software kit.

c. Open the System Director Log Viewer.

d. Open the System Director Control Panel and stop the System Director.

e. Select Configure File System.

f. In the File System Configuration dialog select Create Standby System Director. If there 
are problems creating the new Standby please contact your support team.

g. Once the new Standby System Director starts it will receive a complete copy of the 
metadata from the Active Director.

3. The first replication between the active and standby System Directors copies the entire heap 
over and can take several minutes. Because this first replication takes so long you will see a 
message in the active System Director Log Viewer “Remote meta data save did not 
complete.” This is normal and does not indicate a problem with the upgrade. The System 
Director Control Panel on each system will indicate that the replication is in progress.

4. Once the initial replication between the System Directors is complete you can close the 
System Director Log Viewer on both System Directors.

Copying the Metadata to the New Default Location On the System 
Director 

The ISIS v4.x software is installed in a different path and folders than in previous ISIS releases. 
After upgrading your System Director to the ISIS v4.x software, you must copy your metadata to 
the new location to get access to your existing data. 

To copy the existing metadata to the new installation directory:

1. Install the ISIS v4.x software on your 64-bit System Director as previously described.

2. Stop the System Director Service.

3. Copy the files listed below from their old location and replace the files in the new location 
on drive D: 

- Partition0
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- Partition1

- PartitionDump.bin

Old v2.x metadata location 
D:\Program Files\Avid Technology\AvidUnityISISSystemDirectorx64

New v4.x metadata location 
D:\Program Files\Avid\ISIS System Director

4. Start the System Director Service.

n If there is an error upgrading the metadata, the System Director restarts and then fails again. 
Import the metadata as described in the following procedure.

To import the existing metadata to the new installation directory:

1. Start the Avid ISIS and click System Director Control Panel from the Launch Pad or Start > 
Programs > Avid > ISIS System Director and select Control Panel. 

2. Click Stop System Director.

 The Configure File System button becomes active.

3. Click Configure File System.

The File System Configuration dialog box opens.

4. Select Create Active File System From Import and click OK. 

5. Navigate to the PartitionDump.bin file.

c Verify that the time stamp on all metadata files is current. These files must be up-to-date 
before importing them. Importing out-of-date metadata can result in media loss. Contact 
Customer Success immediately if encountering any issues with importing metadata. 

The old v2.x metadata location is:
D:\Program Files\Avid Technology\AvidUnityISISSystemDirectorx64

The file is copied to a location used by the Active System Director and its extension is 
changed from bin to import.

D:\Program\Avid\ISIS System Director\PartitionDump.import

The Active System Director creates a new file system and imports the metadata from the 
file. It may take a few minutes to import PartitionDump.bin depending on how much 
metadata you have. Once it finishes, you will see “COMPLETING SAVE AND IMPORT 
OPERATION (SUCCESS).” 

6. Verify that the System Director is now running and Active. Start the Management Console 
and verify that all workspaces are listed. If not, call customer support before continuing.
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Avid ISIS Software Installation From the USB Flash Drive

Avid ISIS Systems ship with one blank 8GB USB Drive that is intended to be used for storing 
the ISIS Software Kit. Download the ISIS software kit from download center 
(http://www.avid.com/US/support/find-support/category/updates) and copy it to this USB drive

The second (16GB) USB drive contains a bootable recovery image. Use this to re-image the 
server Operating System. 

If upgrading your software from an earlier release, download the software from the Avid 
Download Center (www.avid.com/US/support/downloads) to your System Director. 

To install your Avid ISIS software on new installs:

1. Log in to the Avid ISIS as Administrator (default password: is-admin). 

2. Make a folder for the software kit on your root directory (C:\) of your Active System 
Director.

3. Insert the USB flash drive with software kit into any of USB ports on your Active System 
Director.

n You can run the software installer from the USB flash drive, or copy it to the Avid ISIS for the 
future.

If the USB flash drive does not automatically display:

a. Double-click the computer icon on the desktop. 

b. Double-click the USB flash drive icon in the window and copy the software kit into the 
new folder you created on the Avid ISIS system. 

4. Double-click the AvidISISSetup.exe file in the software kit.

The installer detects the existing version of the installed software (if any) and displays the 
components that need to be upgraded in the splash screen. 

5. Select ISIS | 7500 - 7000 System Director from the “Select Software Package” menu. 

The File Gateway selection is used when loading the Avid File Gateway server. The File 
Gateway software cannot be installed on the same server as the System Director software.

6. Click Apply.

7. Follow the screen prompts accepting the defaults and License agreement.

8. Once the installation is complete, click Finish.

9. Install the Application Key or apply your software license.

http://www.avid.com/US/support/find-support/category/updates
http://www.avid.com/US/support/downloads
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10. Load the ISBs and ISS/IXSs firmware. Using the ISIS Management Console, select all the 
ISBs and click Upgrade Storage Blades and then select all your ISS/IXSs and click Upgrade 
Switch Blades. You do not need to wait for the ISBs to be finished, you can upgrade ISBs 
and ISS/IXSs at the same time. 

You can watch the upgrade progress in your Monitoring tool.

n To open and use the ISIS Control Panel and Management Console see the Avid ISIS 
Administration Guide.

11. Open the ISIS Control Panel. 

12. Click Stop System Director.

13. Click Configure File System.

14. Open the Management Console. 

Log in using the Administrator user name and the default password is blank.

15. Select Create Active File System and click OK.

16. Click the Storage Managers icon.

17. Select your ISIS ISBs in the list and click Bind.

18. Create a Storage Group, Workspaces, and add Users in the Management Console.

19. Repeat these steps if you are setting up a Standby System Director.

20. Install your Avid ISIS client software. For more information, see the Avid ISIS Client 
Manager Guide.

Intel Network Driver and BIOS Update

Avid has qualified an Intel system BIOS upgrade on the 64-bit System Director (SR2500). This 
BIOS and Intel Pro driver upgrade combination corrects a condition where the network 
connection fails during a restart. The following sections describe the updates. 

n If you reimage the System Director, you must also update the network driver. The BIOS is not 
affected when you reimage your server.

64-bit System Director BIOS Upgrade

Avid is recommending you update the BIOS on the 64-bit System Director and File Gateway. To 
do that, you can visit the Intel web site and follow their instructions, or use the files and 
instructions posted on the Avid Download Center 
(http://www.avid.com/US/support/downloads).

http://www.avid.com/US/support/downloads
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The procedure on the Avid Download Center requires you to create an Intel Deployment 
Assistant DVD and use a USB flash drive to load the BIOS update package on the System 
Director and File Gateway. Instructions for running the Intel BIOS Upgrade Utility and installing 
the BIOS are included with the image for the utility and the BIOS package. 

n Check your current BIOS version before upgrading the BIOS. If your BIOS is at version 98, you 
have the recommended BIOS version for this release. Enter BIOS Setup by pressing the F2 Key 
during POST and the version is displayed as S5000.86B.12.00.0098 in the Main tab.

Intel RAID Controller Driver Update

This section describes the process for updating the Intel driver and registry key for the internal 
RAID controller on the Intel SR2500 server using the SROMBSAS18E Intel hardware RAID 
controller. This RAID controller is used in the Avid ISIS SR2500 System Director and the Avid 
Interplay 64-bit Media Indexer. This driver does not apply to the other SR2500 configurations 
using the embedded SATA RAID ESRTII.

n The majority of the Intel SR2500 Avid ISIS System Directors use a 64-bit operating system. Avid 
did ship some Intel SR2500 System Directors with a 32-bit operating system before the 64-bit 
operating systems were released. All Avid ISIS System Directors using the Intel SR2500 server 
require this RAID controller driver update. 

The RAID controller update requires a driver update and a registry change. Access the update 
package from one of the following locations. Create a new folder on the server that you are 
updating and place the update files in it.

This RAID controller driver is available from two locations:

• Download the Intel hardware RAID controller SROMBSAS18E update package from 
(http://www.avid.com/US/support/downloads).

• This version of the Intel driver has been added in the Avid ISIS software installer kit in 
\Firmware\ISIS 7000\Intel\SR2500_Intel_Disk_Controller_Driver
\IntelSROMBSAS18E_Raid_Controller\Intel_Raid_v3.11.0.xx folder.

To upgrade the SROMBSAS18E Intel driver:

1. Access the Standby System Director and stop the System Director service using the ISIS 
Control Panel.

2. Right-click on My Computer and select Manage. The Computer Management Window 
opens.

3. Select Device Manager. The Device Manager opens

4. Click the plus sign (+) next to SCSI and RAID Controllers.

5. Right-click on the Intel RAID Controller SROMBSAS18E and select Properties.

http://www.avid.com/US/support/downloads
http://www.avid.com/US/support/downloads
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6. Click the Driver tab in the Properties window.

7. Click Update Driver in Driver tab.

8. In Hardware Update Wizard, do not let Windows select the driver:

a. Select “No, not at this time” and click Next.

b. Select “Install from a list of specific location (Advanced)” and click Next.

c. Select “Don’t search. I will choose the driver to install” and click Next.

d. Click “Have Disk.”

e. Click Browse and locate the oemsetup.inf file in the package you copied to the server.

64-bit System Director and Media Indexer — IntelSROMBSAS18E_Raid
_Controller\Intel_Raid_v3.11.0.xx\W2K3X64 folder

f. Click Open, in the Locate File dialog box.

g. Click OK, in the Install From Disk dialog box.

h. Click Next in the Hardware Update Wizard.

9. Once you complete the driver install, click No when prompted to restart the server.

10. Close the Properties window.



Software Upgrade

146

11. Apply the registry key by browsing to the RegKey_Updates folder in the package you 
copied to the server.

Double-click the w2k3.reg file to apply the registry key change.

The following two entries are added to the System Director registry location: 
KEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\msas2k3\
Parameters\Device 

DriverParameters = flushrequest= 3
DriverParameter = flushrequest= 3

12. Restart the Standby System Director.

13. After the Standby System Director has restarted, turn off the Active System Director to 
failover to the updated Standby System director. Repeat this procedure on the second 
System Director. 

Record IP Addresses on the System Director

Before you update your Intel Pro network driver, Avid recommends you record the current IP 
address used on the System Directors. This precaution allows you to restore the IP addresses to 
the current settings if your network configuration is accidently lost. 

To record the current IP addresses used by the System Director:

1. Open a command window on the System Director. Click Start > Programs > Accessories > 
and select Command Prompt.

2. Type ipconfig /all > c:\ip.txt in the Command Prompt window. 

This command saves a text file (named ip.txt) to the root directory on the System Director. 
Open this text file if need to reconfigure the IP addresses to the addresses used before 
performing this network configuration update. 

System Director Intel Pro Driver Configuration

The Avid ISIS installer automatically sets the Intel Pro/1000 NIC for correct operation in an ISIS 
system. The following settings are provided for reference only. 

1 Gb Network Settings On The Engine  

Option Setting

Flow Control Disabled

Interrupt Moderation Disabled

Interrupt Throttling Rate Disabled (OFF)
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Post Upgrade System Verification

After upgrading a system verify that all upgraded components are functioning optimally.

To verify the upgrade:

1. Verify network connectivity for all components:

a. Ping all ISSs and IXSs on left and right stack.

b. From any client, ping Active System Director and Standby System Director on left and 
right sides.

c. Ping the virtual System Director on left and right side.

2. Verify both System Directors are functioning properly by checking the following:

a. Check if any new errors are getting generated in the event logs.

b. Both paths are up and all green lights in System Director’s Control Panel on both 
System Directors. If no failover, some lights will be blue.

c. Metadata is replicating between the two System Directors. The Standby is toggling 
between receiving and replicated. Check the Metadata Status tab on the standby. The 
date stamp in the saved and replicated fields is current and updating frequently. 

d. Check the RAID status on the System Directory.

- On the AS3000, click Start > Programs > Intel -> Intel Rapid Storage Technology 
right-click the Intel Rapid Storage Technology icon in the task bar. The icon is a 
green check mark when the drives are healthy. 

- On the SR 2500, click Start > Programs > RAID Web Console 2 > Start UI and see 
that the Server Heath is green. If not, search www.Intel.com and search for Intel® 
RAID Software User’s Guide for corrective actions.

3. Perform System Director Primary to Secondary Failover — Turn off one of the System 
Directors and verify in the System Director Control Panel that the Active Mode indicator 
has turned red. Turn the System Director back on and see that Active Mode displays 
Standby.

Receive Buffers 1024

Transmit Buffers 1024

1 Gb Network Settings On The Engine  

Option Setting

http://www.Intel.com
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4. Check all clients for proper operation using Path Diag. Run Path Diag on a couple of clients 
and verify consistent performance. To set the PathDiag Tool:

a. Do one of the following.

- (Windows) Select Start > All Programs > Avid > ISIS Client > PathDiag.

- (Macintosh) Select Go > Applications > AvidISIS folder. In this folder, double-click 
the PathDiag.app file.

b. Click Setup.

c. Set “Path to Test” to a mounted ISIS workspace letter. Make sure to select an ISIS 
workspace and not the internal C: drive. 

d. Set the duration to 10 minutes. 

e. Click Custom Test and set the following parameters:
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f. Click Ok and Start.

- 1 Gb clients that are not bandwidth limited can expect at least 65 MB/sec in the Path 
Diag tool.

- 10 Gb clients that are not bandwidth limited can expect at least 500 MB/sec for 
reads and at least 200 MB/sec for writes in the Path Diag tool.

5. While Path Diag is running check the system to make sure that there are no Network 
Degraded status indications. Check the following:

a. In the ISIS Management Console, click Storage Managers. All ISBs are green and not 
displaying any Network Degraded states.

b. Spot check a couple ISBs by browsing to the ISB web page and click Statistics. Select 
the bottom network tab. None of the error columns is incrementing. Press F5 to update 
the page a few times. 

For details on troubleshooting Storage Managers error statuses, search the Knowledge 
Base at www.avid.com/onlinesupport for “Troubleshooting the Network Degraded 
Status on ISIS 1.0-1.1” Tech Alert.

6. Run Switch Infrastructure Diagnostics:

a. Navigate to any switch agent web page (in the ISIS Management Console, click Chassis 
from the list on the left, click Details tab and then double-click on a switch IP address).

b. In switch web page, click Advanced tab.

c. Click Switch Infrastructure Diagnostics from the list on the left.

d. Click Select All under System Tests.

e. Select Both in Select Network section.

f. Select All chassis in Select Chassis menu.

g. Click Run Diagnostics. 

Custom Test 
Settings

1 Gb client
(not bandwidth limited)

10 Gb Client
(not bandwidth limited)

File Access Method Automatically select Automatically select

Reads vs Writes Writes, then Reads (Sequential) Writes, then Reads (Sequential)

Transfer Size 4096 16384

Transfer Rate Unlimited Unlimited

Max File Size 1000 1000

http://www.avid.com/onlinesupport
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Let the diagnostics run, when the Switch Diagnostics - Reported Result/System 
Overview displays, the results from all switches in both stacks are available in the 
summary page. 

h. Click Switch Diagnostics Results Summary Page.

i. Any errors report as red and warning conditions are amber. Click headings to investigate 
any error or warning statuses. No red statuses are present.

7. Check all other zones in use for proper operation. Check Zone 2 and 3 with clients running 
Path Diag:

a. Run a Path Diag client for left and right side for each Zone 2 switch in place.

b. Run a couple of Zone 3 path diag clients and verify consistent performance.

n A Zone 3 client might not have the bandwidth of a Zone 1 or 2 client.



11 Avid ISIS Upgrade Utility

The Avid ISIS Upgrade Utility (AvidISISTools.msi) can be found on the Avid  ISIS software kit 
in the \AvidISISUtilities\ISIS 7000\ folder. This utility is an application for upgrading 
the ISS and ISB firmware. It offers an alternative to the normal online upgrade utilities when the 
switching infrastructure cannot be maintained during the upgrade.

n The original documented procedure for upgrading the ISS and ISB firmware is located on the 
Avid Web site under the name: Loading Firmware on Avid ISIS Switches. The original procedure 
has been replaced by the Avid ISIS Upgrade Utility.

Overview and Requirements

This stand-alone application allows field engineers to start and monitor the installation of switch 
and ISB upgrades from a laptop connected to Avid ISIS through the management port. This 
utility does not replace the current software upgrade process. Its primary function is for 
upgrading a switch or a pair of switches that is incompatible with an existing stacked network. 
Insertion of these switches into the network before the upgrade could disrupt or compromise the 
network’s operation. 

Functional Description

The Avid ISIS Upgrade Utility is a Windows based application that:

• Provides a self-configuring FTP service.

• Picks up the install packages via a browse window.

• Discovers all the existing devices (switches and blades) on the network via broadcasting and 
displays the information in a table.

• Displays the existing version, status, and package version already installed on each device.

• Provides the capability of issuing the firmware install command to one or more of the 
displayed devices at the same time.

• Provides the capability of monitoring the install status of every device currently in install 
process.

• Provides the capability of viewing the install log information of each device individually.

http://www.avid.com/onlineSupport/supportcontent.asp?browse=go&productID=172&contentID=9666
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Software Component Design

The Avid ISIS Upgrade Utility is composed of the following components:

• The GUI Component — provides the Graphical User Interface of the application

• The Avid ISIS Upgrade Utility application programming interface (API) handles the low 
level functions such as: 

- Configure and start the FTP server thread.

- Discover available Avid ISIS systems connected to the network.

- Manage and monitor the various Avid ISIS install threads.

- Manage the command requests and responses between the Avid ISIS Upgrade Utility 
and the Avid ISIS agent.

• FTP Server — provides the file transfer service necessary for the devices to retrieve the 
install package.

Avid ISIS Upgrade Utility Components

ISIS Upgrade Tool GUI 

Laptop 

ISIS Upgrade Tool API 

ISIS 
Device 

ISIS Agent 

FTP 
Server
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Software Interface

The software interfaces with the storage devices through the switch agents with HTTP requests. 
The application is provided with a graphical user interface which is described in this chapter. The 
Avid ISIS Upgrade Utility main window displays when the application is started and is divided 
into three sections:

• FTP Server section provides the function of managing the install packages and displaying 
FTP related activities. 

• Install Control section displays the storage device information table, performs a variety of 
operations on the element table and of instantiating the install process. 

• Monitoring section is the section where the Device Upgrade status is asynchronously 
displayed every 2 seconds for monitoring the status for the installation.

Avid ISIS Upgrade Utility Window
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FTP Server Section

The FTP Server Section contains the following functions:

• Add installer package to the FTP root directory

• Remove installer from the FTP root directory

• Select installer to be sent to the storage device

• Display FTP Log information. 

Install Control Section

The Install Control Section contains the following functions:

• The device information table:

- IP Address

- Device type

- Install Status

- Version

- Revision

- Current version of the firmware package running on the device

• Table operation buttons:

- Add button adds new entries to Device Information table.

- Update Status button reloads status, version, and packages information of the selected 
device entries in the table.

- Discover button retrieves and displays information on all the devices that respond to the 
application broadcast.

- Reboot button sends a restart command to the selected device entries in the table.

- Remove Entry button removes all the devices entries that are selected in the table.

- Start Install button issues the command that starts installing the selected package to the 
selected devices. 

This button is enabled when an install package is selected from the Install Packages list 
and at least one device entry is selected from the device information table.

• Install Operation Command is composed of the following items:

- URL field displays the command text that is passed to the device.

- Option field displays the options associated with the command.
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Monitoring Section

The Monitoring section contains the following functions:

• Install Status Monitoring table displays the upgrade status of the devices currently 
upgrading.

• Remove Entry button removes the selected entries from the Install Status table.

Running the Avid ISIS Upgrade Utility

The Avid ISIS software kit includes the Avid ISIS Upgrade Utility application and runs on the 
Avid ISIS System Director.

To install an upgrade package:

1. Insert the USB with the Avid ISIS software into a laptop and double-click 
AvidUtilityISISTool.msi located in the following location.

drive:\AvidISISUtilities\ISIS 7000\

The installer file installs the application on your laptop.

2. After the installation has completed, removed the USB and click Start > Programs > 
AvidUnityISIS > Unity ISIS Upgrade Utility from your laptop.

The Avid ISIS Upgrade Utility Window opens.

3. Click Add in the FTP Server section of the window.

A browser dialog box opens.

4. Browse to the location where the new (or old) install package is located.

5. Select the package you want added and click Open. 

The dialog box closes and the selected package is added to the Install Packages list. 
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6. Click Discover to retrieve information on all the available devices.

7. Select the devices you want to update. (Click the check-box beside the IP Address device 
entries in the table.)

8. Click Start Install to begin installing the selected package to the selected devices. 

n The Start Install button is enabled only when an install package and at least one device entry are 
selected.

The Install Status is displayed in the Monitoring section of the window. After the Install 
Status shows complete, you can close the Avid ISIS Upgrade Utility.

To remove a package from the Install Package list:

1. Select the package you want to remove from the Install Packages list.

2. Click Remove.



12 Avid ISIS Recommended Maintenance

The following maintenance recommendations are not meant to be a troubleshooting guide but 
more of a care and monitoring checklist for Avid ISIS. Typically the Avid ISIS does not need to 
be power cycled. All components of the ISIS stack can be replaced or restarted individually 
without interfering with the operation of ISIS stack. 

c Power cycling the entire stack (all the components at the same time) could risk the stability 
of the ISIS stack. 

For information on using the tools described in this section, see the Avid ISIS Administration 
Guide. 

Minimum Storage Space Requirement

The recommended amount of space you must maintain for background functionality and failures 
is 7% of free space in each Storage Group. Exceeding 93% used space can produce severe 
performance issues in some situations. 

To calculate the right amount of free space, log into the ISIS management Console and navigate 
to the Storage Group window. For each Storage Group, multiply the Effective number by 0.07 to 
determine the recommended free space in GBs. Create a new workspace in this Storage Group 
with the same size and label it “Headroom” and do not give anyone access to this workspace. 

Daily Maintenance 

Perform the following steps daily (estimated time: 15 minutes).

• Check the Storage Managers status: Open the ISIS Management Console and click Storage 
Managers.

- Verify there is a green circle beside the storage blade in the Name column

- Check the Status column for errors or Network Degraded 

The Status column in the Storage Managers report the status of the Storage Manager 
logged by the System Director. (The Status line in the Details area reports the same 
information.) When the Storage Manager maintains a working status, the Administrator 
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tool displays no entries in the Status field. If a problem arises, or when the status of the 
Storage Manager changes, the Administrator tool updates the Storage Managers dialog 
box. 

• Check the Storage Blade Status and Switch Blade Status: Open the ISIS Management 
Console and click Chassis.

- Verify there is a green circle beside each chassis in the Serial Number column

- Check the both Status columns for errors

When the chassis, switches and Storage Managers maintain a working status, the ISIS 
Management Console displays no entries in the status field. If a problem arises, or when 
the status changes, the ISIS Management Console updates the status column and the 
Details area.

• Start the Monitor Tool and check the front (ISBs) and back (ISSs, IXSs, and power supplies) 
for errors.

You can hover your mouse pointer over a component and status details are displayed. Errors 
display as red or yellow components, or as a warning icon on the component.

• Check System Director Control Panel on the Active System Director for errors. On the 
System Director Status tab, make sure there are no red indicators in the status box. 

- Check for green indicators beside the “System Director is running” and “Both paths are 
up”

- Check that a blue or green indicator is displayed beside “Replicated” on the Active 
System Directory

- If the event log indicator is not green, check the Windows Event logs on the Active 
System Director

• Check System Director Control Panel on the Standby System Director for errors. 

- Verify the Standby System Director is “Started” and in “Standby” Mode. Check for 
green indicators beside the “System Director is running” and “Both paths are up”

- Check that a blue or green indicator is displayed beside “Receiving” 
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- If the event log indicator is not green, check the Windows Event logs on the Standby 
System Director 

• Check that the Avid ISIS Workspaces have “Free Space” available: Open the ISIS 
Management Console and click Workspaces, see “Minimum Storage Space Requirement” 
on page 157.

Weekly Maintenance

Perform the following tasks weekly (estimated time: 30 minutes).

• Review Windows Event logs on the Active and Standby System Directors

• Check the ISB network connections between the ISBs using the ISB Connection Analyzer. 
Verify that all Storage Managers are green.

• In the Avid ISIS Switch Blade Agent, run the Switch Infrastructure Diagnostics located in 
the Advanced tab. Select all tests, both the left and right networks, and all chassis. 

n Do not run the switch diagnostics during heavy usage or critical network production times. 
Some tests burden the system’s bandwidth and resources.

In the results page, save the diagnostic results by clicking the Download link and save the file 
using the date as part of the file name.

• Check the RAID status on the System Director.

- On the AS3000, click Start > Programs > Intel -> Intel Rapid Storage Technology 
right-click the Intel Rapid Storage Technology icon in the task bar. The icon is a green 
check mark when the drives are healthy. 

- On the SR 2500, click Start > Programs > RAID Web Console 2 > Start UI and see that 
the Server Heath is green. If not, search www.Intel.com and search for Intel® RAID 
Software User’s Guide for corrective actions.

• Make sure you have at least one Storage Manager worth of free space (depending on the size 
of your storage blades) for each storage group, see “Minimum Storage Space Requirement” 
on page 157. If a storage blade fails, you need enough space to remove the failed storage 
blade.

http://www.Intel.com
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Monthly Maintenance

Test failover operations monthly (estimated time: 1 hour).

• Take a snapshot — The ISIS Snapshot tool collects information currently displayed by the 
ISIS Management Console and the Avid ISIS System Director Control Panel. Open the ISIS 
Management Console and click Logging > ISIS Snapshot in the Advanced section. Select 
Create new snapshot.

• Perform System Director Primary to Secondary Failover — Turn off one of the System 
Directors and verify in the System Director Control Panel that the Active Mode indicator 
has turned red. Turn the System Director back on and see that Active Mode displays 
Standby.

Before you turn off either System Director, verify that the metadata date stamp in the 
Metadata Status tab in the saved and replicated. Fields are current and updating frequently.

• Check the Redistribution status: Open the ISIS Management Console and click Workspaces.

- The Redistribution column for each workspace is blank, and has fewer than 10 
configuration changes (see Config Changes column)

- If you have 10 or more configuration changes, the status is highlighted in yellow and 
displays “Requires Full Redistribution” in the Redistribution column

Do a full redistribution at the next maintenance interval. Schedule a time when the 
system is not heavily used, as this will allow the full redistribution to complete in the 
shortest amount of time. 

Redistribution Guidelines

Do not perform an ISB firmware upgrade while a Redistribution is in process. Make sure all 
firmware upgrades are completed before any redistribution is started. The following events 
trigger redistribution:

• Moving a Workspace

• Clicking “Full Redistribution” on a Workspace

• Adding a Storage Manager to a Storage Group

• Removing a Storage Manager from a Storage Group

• Changing the state of a Workspace to mirrored or unmirrored 
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If a firmware upgrade must be done and a redistribution in progress, do the following:

1. Suspend the active redistribution using the Advanced Commands in Workspace window.

2. Verify that the Workspace displays “redistribution suspended” in the Status column and all 
other workspaces do not have “redistribution in progress” displayed.

3. Perform the firmware upgrade on the ISB(s) that must be upgraded.

4. Wait until the firmware upgrade is completed successfully.

5. Resume the redistribution using the Workspace window.

Saving ISIS Metadata

This procedure describes how to save the metadata stored on the system drives for the data 
drives. Use this procedure if both System Director system drives are not going to stay with the 
data drives. 

Regardless of the number of Engines, all the metadata for all the data drives, in all of the 
Engines, are saved on the System Director. The Engines do not store any metadata. 

To save the System Director metadata:

1. Stop the System Director service using the ISIS Control Panel. 

n The System Director is constantly writing metadata. Metadata files are always open and locked, 
so the best way to copy the metadata files is to stop the System Director service so the files are 
closed.

2. Copy the Partition0 and Partition1 files from the following location on the System Director:

D:\Program Files\Avid\ISISSystemDirector

n If possible, include PartitionDump.bin with the two Partition metadata files.

Do one of the following:

- Use a USB flash drive that has the capacity for the Partitionx files.

- Create a network share on a client system on the network and copy the Partitionx files to 
that shared folder. 

3. Verify that you have the current copy of the Metadata by comparing the date in the Metadata 
tab of the ISIS control Panel.

4. Start the System Director service using the ISIS Control Panel.



Available Utilities

162

Available Utilities

See the Avid ISIS Administration Guide for information about other utilities and tools for 
monitoring and troubleshooting.

Client Manager Maintenance

If you suspect a poor connection between your client system and a mounted workspace, you can 
test the Avid ISIS shared storage network connection between each client system and the shared 
storage network using the Avid PathDiag tool. This tool informs you if there is sufficient 
read/write throughput for read and write operations needed by the client system. For more 
information on using the Avid PathDiag tool, see the Avid ISIS Client Guide, which also 
describes the following Administrative tasks:

• Clearing Cached Data

• Using Logs and Messages

Status Indicators and Troubleshooting

If the LEDs on the ISSs or ISBs are indicating a problem, identify the problem using the 
information under, “Status LEDs and Stacking Problems” on page 124. 

Complete Server Room Shutdown

There is usually no need to turn the entire Avid infrastructure off and back on, but if you need to 
turn off all the equipment (such as a relocating the server room), turn off the components in the 
following order. When turning on the components use the reverse order.

To shut down the entire Avid network (server room):

1. Shut down all Avid editing system and attached media I/O equipment, for example Avid 
Mojo and Avid Adrenalines.

2. Shut down all capture and playout servers such as AirSpeeds.

3. Shut down CaptureManager Server.

4. Shut down Interplay Transfer Server.

5. Shut down Avid Interplay Media Services and Providers.

6. Shut down Interplay Engine and Avid Interplay Archive Engine.

7. Shut down Media Indexers — Do not stop the Media Indexer while it is indexing storage.

8. Shut down Systems running Interplay Framework Multicast Repeaters.

9. Shut down Systems running the Interplay Framework Lookup Service.
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10. Invoke failover on Avid ISIS System Directors.

11. Shut down Standby Avid ISIS System Director.

12. Shut down Primary Avid ISIS System Director.

13. Shut down Avid ISIS Engines.

14. Shut down the network switches.

n Power up the entire rack of equipment in reverse order and verify all clients have mounted the 
necessary ISIS Workspaces.

False Link Aggregation Alerts

The following sections explain false link alerts caused by a slow Link Aggregation and provides 
a procedure for correcting the issue.

Symptoms

If you experience problems with Link Aggregation during a power up, or if all the ISIS Engines 
are restarting, the following could be happening.

• Slow Link Aggregation (Trunking) setup — When the Link Aggregation feature is taking a 
longer than expected to complete. To view the setup process open the Avid ISIS Switch 
Blade Agent page > System tab, and click the “View current settings” in the left pane. When 
the process is complete, the status message “Enabled Fully Operational” is displayed for any 
VLAN that has a correctly defined and enabled Link Aggregation (trunk) group. 

While the Link Aggregation is setting up, the ISIS ports that are in the Link Aggregation 
group form an open loop in the network that can cause problems with the connecting 
Ethernet switches. When using the Cisco 4900, the longer the Link Aggregation feature 
takes to come up, the longer the loop exists and is more likely to cause a problem.

• Fake Link Alert — A link alert is a message sent to the ISIS agent page and the Management 
Console letting you know that the given 10 Gig port is not functioning as expected. A fake 
link alert is when this link alert message is display when the port is working correctly. This 
could also be thought of a false positive. This fake link alert can occur in ISIS v 2.4 and 
earlier, this fix in the ISIS v4.0 release an later.

Displayed Link Alert Message

Use the following methods to determine if the displayed link alert message is a real problem or a 
false positive.
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To verify the link alert message:

1. Run diagnostics and look at the “Details for test: (18) port link information.” The 
information in this section of the diagnostic output comes directly from the hardware and 
tells you the correct status on whether the switch port is up or down for all the ports in the 
stack.

2. Check the stacking data for the Engine displaying the link alert message. The information in 
the stacking display comes directly from the hardware and tells you the correct status on 
whether the switch port is up or down for the port in question. 

a. Go to the ISIS Switch Blade Agent page.

b. Click System tab.

c. Click Overview in the left pane.

d. Click on the chassis (Engine) that is displaying the link alert message.

e. Scroll down to the stacking information. See the following example:

Switch slot 0 is the left side of the Engine, and switch slot 1 is the right side of the Engine. 
Look in the 10 Gb Port Map column:

- If “0X1” is displayed, the port is up. 

- If “0X0” is displayed the port is down. 

If the right side of an Engine is reporting a link alert message, and “0X1” is displayed for 
Switch slot 1, the port is up and this is a fake link alert. If the right side of an Engine is 
reporting a link alert message, and “0X0” is displayed for Switch slot 1, the port is down, 
and this is a real link alert.

Restart All Procedure

The following two-part procedure helps you to correctly and safely restart all of the Engines.

Part 1 gets the Engine correctly up and running, however it triggers the fake link alert problem. 
You can use the ISIS after you have completed part 1, however the link alerts you see are fake. 
Part 2 corrects the fake link alert messages. Wait until you complete part 2 of the procedure 
before you use the ISIS.

Switch Slot State Master Collisions Failures 10 Gb port Map Hi Gb Port Map

0 Ready No None None 0X1 0X0

1 Ready No None None 0X1 0X0
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Part 1 — Restart or power cycle all of the Engines:

1. Telnet into the connecting Ethernet switches (Cisco 4900’s) and use the “shut” command to 
shut down all ports that connect to the ISIS stack. (Currently there is no reason to shut down 
the ports that connect one 4900 to the another 4900). Shutting down the ports connected to 
the ISIS causes a link alert message to be displayed. This is a real alert message because the 
ports have been shut down.

2. Restart all the Engines (or power cycle them). Allow all Engines to come up.

3. Go to the ISIS Switch Blade Agent page, and every few seconds select the Overview 
display. This updates the Overview display with the latest information.

4. Watch the request busy entry, and wait for it to display “No.”

5. Watch the Request state column, and wait for every state to display “Done.”

6. Go to the “view current setting” display and watch the information in the column labeled 
“10 Gb Link Aggregation Current Configuration State.” This step takes several minutes. 
Every few seconds select the “View current settings” to update the display with the latest 
information. Continue watching until the “Enabled Fully operational” message is displayed 
for the VLANs (left and right sides) that have a Link Aggregation group defined and 
enabled. Once the “Enabled Fully operational” messages are displayed, continue to the next 
step.

7. Telnet into the connecting Ethernet switches and one by one, enter the command “no shut” 
to each one of the ports that are connected to the ISIS.

Part 2 — To remove the fake link alert messages:

1. Restart the Chassis Manager on each switch displaying the fake link alert using one of the 
following methods:

t Restart the Engine – ISIS Switch Blade Agent page > System tab and click “Reboot a 
chassis.”

t Restart the local host (switch) – ISIS Switch Blade Agent page > Advanced tab and 
click “Reboot.”

t Restart the Chassis Manager – ISIS Switch Blade Agent page > Advanced tab and click 
“Restart Chassis manager.” 

t Telnet into the switch and enter the “reboot” command.

2. Each time you restart the Chassis Manager (step 1), watch for the stack (VLAN) to come 
back up correctly. Follow steps 3, 4, 5,and 6 of the Part 1 procedure.

After you complete Part 1 and Part 2 the ISIS stack, including Link Aggregation, is up and 
running.
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10 GbE Link Aggregation Maintenance

Follow this section when rebooting the ISIS Engine, during power cycles, or other Engine 
maintenance, when ISS blades are configured with link aggregation connections to a Cisco 
switch.
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Disabling Link Aggregation During Engine Maintenance or Reboots

The ISIS link aggregation connections to a Cisco switch use Ether-channel protocols to establish 
a bundle of two or more links between ISIS and a Cisco switch. During an ISS reboot or power 
cycle, there is a delay in establishing the link-aggregation bundle which may create a temporary 
spanning-tree loop. In some situations, there may be significant packet errors detected by the 
Cisco interfaces that cause the interfaces to shut down automatically (known as “err-disable” 
state). To avoid these situations, follow this procedure during ISS reboots or power cycles.

To prevent the “err-disable” message:

1. Before rebooting or turning on an ISIS Engine (ISS or IXS), disable all interfaces on the 
Cisco switches that are connected to ISIS link aggregation groups.

2. Log on to both core switches using Telnet: 

a. Type en to enter enable mode.

b. Type conf t to enter configuration mode.

3. On each core switch, specify the interfaces to disable, as follows: 

core-1(config)#int range te1/1 , te1/2 , te1/5 , te1/6

core-1(config-if)#shut

core-2(config)#int range te1/1 , te1/2 , te1/5 , te1/6

core-2(config-if)#shut

4. Type exit twice to return to the command prompt. 

The show interface status command now shows “connected” for the interfaces connected to 
the ISIS.

5. Restart or turn on the ISIS blades. 

6. Verify the ISIS link aggregation state for all groups. Make sure the status says “Loaded” and 
“Enabled Fully Operational.” The ISIS will display “link warning” because the Cisco ports 
are still disabled.

7. On each core switch, re-enable to interfaces, as follows: 

core-1(config)#int range te1/1 , te1/2 , te1/5 , te1/6

core-1(config-if)#no shut

core-2(config)#int range te1/1 , te1/2 , te1/5 , te1/6

core-2(config-if)#no shut

8. Type exit twice to return to the command prompt. Wait about 15 seconds. 

The interface status command now shows “connected” for the interfaces connected to the 
ISIS.



13 Adding and Replacing Hardware

This appendix provides procedures for adding and replacing components in your Avid ISIS. Avid 
ISIS hardware additions and replacements are to be performed by Avid ISIS Avid Certified 
Support Representatives (ACSR). 

Do not add any hardware if there are any issues with the system. Correct all problems before 
adding new hardware and making changes to the system and verify that the system is in good 
working order; see “Health Check” on page 136.

Adding Hardware

Use the following guidelines if a switch must be replaced. Typically hardware replacement is 
performed after the software upgrade to avoid unnecessary downgrade and upgrades of the 
firmware.

Not all switch firmware is compatible. Incompatible firmware does not stack together and 
therefore cannot be upgraded in the normal manner. As a general rule, v1.0x firmware switches 
do not stack with v1.1, v1.2, v1.3 and later switches and vice versa. Older v1.1x switches will 
usually stack with newer rev 1.1x switches.

Avid ISIS ships with a standalone firmware Avid ISIS Upgrade Utility which is suitable for 
upgrading (or downgrading) any firmware version of switch. Keep this utility in case the normal 
upgrade procedure fails. This utility can be found in the Avid ISIS software kit in a folder called 
\AvidISISUtilities\ISIS 7000\. For details on the use of this utility, see “Running the Avid 
ISIS Upgrade Utility” on page 155.

For more details on compatibility between firmware versions, search the online Knowledge Base 
at www.avid.com/US/support for “ISIS firmware matrix.” 

If you are replacing an existing switch in the stack, you do not need to add/remove chassis or do 
anything to the stack. Use the following procedure to swap a switch.

http://www.avid.com/US/support


Adding an Engine

170

Adding an Engine

This section covers the simplest configuration on adding an engine to a system (1 engine, 2 
switches and 16 ISBs). If you are expanding a system with v1.x hardware, see the v2.1.1 (or 
earlier) Avid ISIS Setup Guide for detailed procedures.

c You must disable link aggregation before creating or modifying your Avid ISIS stack. After 
your stack has been created, reconfigure your Link Aggregation Groups.

To add an engine:

1. Rack the engine in the proper position.

2. Install the power supplies, switches, and ISBs.

3. Apply power to the engine.

4. Allow the chassis to boot fully, about two minutes.

5. Update the firmware on each switch if necessary (see “Replacing an Engine Switch” on 
page 171).

6. Add the left switch to the stack:

a. Open the switch web page on any switch on the left stack.

b. Click add/remove chassis. You will see the existing stack with the same number of 
chassis as are currently in the system.

c. Click add chassis and then click OK. Wait for the request to get to all switches (all bars 
turn green). Then immediately attach the stacking cable from the left IXS to the switch. 
Wait for the state to display ready before clicking OK.

d. Wait up to 5 minutes.

- If the stacking procedure is successful, the new chassis is now listed in the chassis 
list (verify by serial number).

- If you do not see it listed there after waiting and pressing F5 a few times, disconnect 
the stacking cable and repeat steps c and d until the chassis is successfully added to 
the stack.

7. Verify that the new switch is at the expected IP address by pinging the new switch from 
another switch (not management IP). You can get the IP address from the ISIS Management 
Console; click Chassis in the list on the left and then click the Details tab on the new chassis 
serial number.

8. Attach the stacking cable to the right switch and verify that the new switch is at the expected 
IP address by pinging the new switch from another switch (not management IP). 
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9. Update the ISB firmware and add the ISBs to the filesystem.

a. Highlight the new chassis in the ISIS Management Console Chassis window and click 
Upgrade Storage Blades.

b. Add the new ISBs to the filesystem. When added they become Storage Managers listed 
as a Spare in the Type column.

c. Select all the new Storage Managers and add them to the Storage Group. Once in a 
Storage Group they become Active in the Type column and a redistribution is initiated. 
This can take several hours. The upgrade and client activity can continue during this 
process.

n Do not go through the add chassis procedure a second time. The chassis has already been added 
to the stack. 

Replacing an Engine Switch
To replace an ISS or IXS switch:

1. Disconnect all network interconnect cables and remove old switch. (Power remains on at all 
times.)

2. Insert new switch but do not attach the stacking cable yet.

3. Update the switch to the correct firmware (if necessary) using the Avid ISIS Upgrade Utility, 
see “Avid ISIS Upgrade Utility” on page 151.

a. Install the Avid ISIS Upgrade Utility on a spare computer or laptop.

b. Load the firmware package on your spare computer or laptop that matches the firmware 
on your Avid ISIS.

c. Assign the IP address on the laptop to 192.168.0.100.

d. Connect the Ethernet cable to the Management Port of the new switch.

e. Start the Avid ISIS Upgrade Utility. In the Install packages section select Add and 
navigate to the correct firmware package that you loaded on your spare computer or 
laptop.

f. The utility detects the switch on 192.168.0.10 automatically. If not, you can enter the IP 
address manually.

g. Check the switch and select Start Install.

h. Monitor the upgrade via the Avid ISIS Upgrade Utility until complete. This takes about 
20 minutes. 

4. Attach the stacking cable. 
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5. Verify that the switch is pingable via the correct stack IP address from another switch on the 
same side of the stack (subnet). 

Replacing an Engine

Use the following procedure when replacing an ISIS engine. In this procedure, the engine to be 
replaced is referred to as the “old chassis” and the replacement engine as the “new chassis.”

To replace an ISIS engine:

1. Note the engine serial number on the front of the old chassis. Serial numbers are adhered on 
the rack-mount ears of the Avid ISIS Engine (under the plastic screw covers, if installed). 

n If you have not already noted the host names, passwords, IP address, and other important 
network details, see “Avid ISIS | 7500 - 7000 Pre-Upgrade Information” on page 130.

2. Log into the ISIS Management Console and get details on the old chassis (use the serial 
number that you record on the front) and note the left and right IP addresses.

3. Disconnect the CX-4 interconnect cables from the old chassis.

4. Disconnect the 1 Gb connections and any 10 Gb (optical) connections from old chassis.

5. Open a Switch Agent Web page of any Zone 1 client on the left side. 

n Open the Switch Agent page via the Info button on the engines details page. For more details, 
see the Avid ISIS Administration Guide.

a. Click Switch Blade in the Management Console.

b. Select the Switch Blade in the Switch Blade page and click Show Info. 

c. Log into the Switch Agent page (se-admin is the default password).

6. Click the System tab > Add/Remove chassis.

7. Find the serial number of the old chassis in the Serial Number list and click the “Delete” 
button for that chassis.
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8. Wait for the operation to be completed (all chassis in the list displays green and “The 
configuration request completed successfully” is displayed).

The old chassis serial number is no longer listed in the Serial Number list.

9. Turn off the old chassis by unplugging a single power cord and then unplugging the 
remaining two power cords simultaneously.

10. Carefully remove the following items, in this order, and put them in a safe place:

a. All ISBs

b. Both switches, noting which side each came from

c. All three power supplies

d. The chassis from the rack

11. Install the new chassis into the rack (without the ISBs, switches, and power supplies).

12. Carefully reinsert the following items, in this order:

a. All ISBs

b. All three power supplies

c. Both switches, in the same relative places they came from (do not reconnect any cables 
yet). Make sure all thumb screws are secure and snug.

13. Turn on the new chassis by simultaneously inserting two of the power cords and then the 
third.
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Give the new chassis at least 3 minutes to initialize; continue when all ISBs have solid green 
LEDs.

n After 3 minutes if the ISBs are all blinking green in unison, call Avid Customer Support.

14. Reattach the CX-4 interconnect cables to the left and right switches.

15. Return to the Switch Agent Web page (use any left switch other than the one being added). 
Select Configuration > Add/Remove chassis. The new chassis serial number is listed in the 
Serial Number list. 

16. Go to tools and select ping. Enter the left IP address noted in step 1. Make sure the ping 
command can reach both switches. 

17. Reconnect any 1 Gb and 10 Gb cables that were disconnected earlier.

18. Verify the proper operation of both stacks by running the Path Diag from a client in each of 
the following locations: Zone 1 left, Zone 1 right, Zone 2 left, Zone 2 right, and Zone 3.

19. Perform a full redistribution. 

When permanently adding or removing a chassis from an ISIS configuration, Avid 
recommends performing a full redistribution after the chassis addition or removal is 
complete. 

Doing a full redistribution minimizes the chances of running into issues if a full 
redistribution is required in the future; for example, storage blades getting full during a full 
redistribution and requiring the user to delete files to allow the redistribution to complete.

This recommendation does not apply when removing and then replacing failed storage 
blades. For other examples of symmetric and non-symmetric redistributions, see the Avid 
ISIS Performance and Redistribution Guide on the Knowledge Base at 
www.avid.com/US/support. 

Replacing the System Director

Use the following procedure if you are replacing your System Director to a newer model server. 
This includes updating from a 32-bit System Director to a 64-bit System Director, or updating 
the Intel® SR2400 or SR2500 to the AS3000. Before you start the System Director replacement 
procedure:

• Install the new System Director into the rack. If planning a Standby System Director, also 
install the second System Director into the rack. 

n The new Standby System Director is configured after this new Active System Director is running, 
see “Configure a Failover Connection” on page 116. 

http://www.avid.com/US/support
http://www.avid.com/US/support
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• Install the Avid ISIS software on the new System Director; see “Software Installation” on 
page 84.

• Make sure your existing Active and Standby System Directors are healthy, verify that the 
system is in good working order. Do not upgrade to the new System Director if there are 
issues with the old System Director, see “Health Check” on page 136. 

• Update the software on existing Active and Standby System Directors to the same Avid ISIS 
version as the new System Director, see “Software Upgrade” on page 137.

Avid has shipped the Intel SR2500 System Director with a 32-bit operating system and 9 MB of 
memory. If you have this model System Director and want to upgrade to a 64-bit operating 
system, you must purchase a Windows 64-bit operating system license and re-image the 32-bit 
Intel SR2500 System Director. 

• Save your current version of the metadata; see “Copying the PartitionDump Files from the 
Old Servers” on page 175.

• Load the Windows operating system; see “Reinstalling the Windows Storage Server 2008 
R2 Operating System” on page 181. This is not necessary if you have purchased a new 
System Director.

• Import the current version of the metadata; see “Moving the PartitionDump files to the New 
Active System Director” on page 176.

Copying the PartitionDump Files from the Old Servers

1. Identify the existing Standby System Director and stop the System Director service in the 
ISIS Control Panel. 

2. Identify the existing Active System Director and stop the System Director service in the 
ISIS Control Panel. 

3. On the Active System Director, locate and preserve the “PartitionDump.bin” file.

This file is an exported version of the metadata.

v2.x metadata location 
D:\Program Files\Avid Technology\AvidUnityISISSystemDirectorx64

v4.x metadata location 
D:\Program Files\Avid\ISIS System Director

4. Copy the PartitionDump.bin file into a temporary directory on what will become the new 
Active System Director.

The Avid System Director software prevents you from creating a shared folder on the 
System Directors. To move the PartitionDump.bin files, do one of the following:

- Use a USB flash drive that has the capacity to move the PartitionDump.bin file.
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- Create a network share on a client system on the network and copy the 
PartitionDump.bin file to that shared folder. From the new System Director copy the 
PartitionDump.bin file into the temporary folder.

Moving the PartitionDump files to the New Active System Director

1. Verify that you have the current copy of the PartitionDump.bin file from the old Active 
System Director.

2. Start the Avid ISIS and click System Director Control Panel from the Launch Pad or Start > 
Programs > Avid > ISIS System Director and select Control Panel. 

3. Configure the virtual name and IP address on the new Active System Director to match the 
old Active System Director.

Configure the virtual name and IP address using the functions in the Configuration tab of the 
ISIS System Director Control Panel.

4. If using the same IP addresses as the old System Director, make sure to shut down the old 
System Director first to prevent an IP conflict.

n You can change the IP address scheme of the new System Director. However, Avid does not 
recommend changing the virtual ISIS name.

5. Click Stop System Director.

 The Configure File System button becomes active.
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6. Select Create Active File System From Import and click OK. 

7. You are prompted to navigate to the PartitionDump.bin file you saved on the Active new 
System Director.

The file is copied to a location used by the Active System Director and its extension is 
changed from bin to import.

D:\Program\Avid\ISIS System Director\PartitionDump.import

The Active new System Director creates a new file system and imports the metadata from 
the file.

8. Deactivate the Avid software license or move the Application Key (dongle) from the old 
System Director to the new System Director.

9. Verify that the System Director is now running and Active. Start the Management Console 
and verify that all workspaces are listed. If not, call customer support before continuing.
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10. Configure the new Standby System Director, see “Configure a Failover Connection” on 
page 116.

Replacing the Network Switch

If replacing a switch in the ISIS environment: 

• Have a backup copy of the switch configuration file.

• Disable any Link Aggregation that might be set in your ISIS environment. This prevents odd 
network behavior and the inevitable trunking errors.

• Disable any trunking to other switches before removing the switch. Any trunking involved 
with the switch is part of the configuration file and helps when reconfiguring the trunk on 
the new switch. 

• You do not have to shut down the System Director or Engines when replacing a switch, 
particularly if you have a redundant switch configuration.

To replace a switch you will need a console connection to the switch and a TFTP server. The 
following are high level steps that assumes the failed switch is still capable of making a TFTP 
backup. If the switch is completely dead, restore the configuration from a previous backup or 
manually.

To capture the switch configuration file:

1. Copy the startup configuration of the failed switch to the TFTP server.

2. Install the replacement switch.

3. Configure a temporary interface on the new switch to connect to the TFTP server (best to 
use a no switchport interface with IP address on same subnet as TFTP server).

4. Copy the backup copy of the old switch startup configuration to the new switch (copy TFTP 
startup-config).

5. Reload the switch configuration and restore the old switch configuration on the new switch.

The specific commands differ between Cisco and Dell Networking but all are in the switch 
configuration guide.

If a TFTP server is not available:

t Use a console/telnet client such as PUTTY to list the configuration and copy it to a text file, 
which you can then use to configure the new switch.

n Increase the PUTTY scroll back buffer from the default 200 to at least 2000. If you increase it to 
50000 and make the screen longer and wider you can capture “show tech-support” output.
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To replace a switch:

1. Disconnect all network cables. 

2. Pull out the power cables from the back of the switch.

3. Replace the failed switch with a new switch in the rack.

4. Replace the power cables in the back of the switch to turn the switch on.

5. (Option) If you have transceivers in the failed switch, move the working transceivers into 
the new switch.

6. (Option) If you have modified Avid’s default Dell Networking switch configuration, Telnet 
or HyperTerminal into switch.

Avid ships Dell Networking switches configured for ISIS | 7500 configurations. Reapply 
any changes you have made to the default configuration. 

Avid provides sample Cisco switch configurations in the ISIS software kit. Reapply any 
changes you have made to the default configuration. 

7. Reconnect all network cables in the front of the switch.



A Using the Product Recovery USB for 
64-bit System Directors

This section describes the procedures to recover your Avid ISIS system drive by reinstalling 
Windows Storage Server 2008 and Avid-specific additions and changes.

This procedure restores only the Windows operating system and the hardware drivers. It does not 
restore the Avid ISIS software. The Avid ISIS software must be reinstalled separately, after the 
operating system recovery is complete. The version number of the image can be found in the 
C:\IMAGE.TXT file on the root directory of the system drive.

c The Avid ISIS ships with a backup product recovery image USB flash drive. 

n After reimaging the server the Administrator password is set to is-admin.

You might need to reinstall the Windows Storage Server 2008 operating system on your Avid 
ISIS System Director if you are directed to do so by Avid Customer Support. The reinstallation 
offers you two options:

• Perform a Windows Storage Server 2008 R2 installation to the entire system. This replaces 
all the data from all the available partitions on your system drive. Perform this operation if 
you are initializing your system drive.

c You lose metadata if you restore all the partitions of the drive.

• Perform this operation to replace only the operating system on your system drive. Typically 
this removes the first partition (C:); the other partitions are not changed. 

Reinstalling the Windows Storage Server 2008 R2 
Operating System

To reinstall the Windows Storage Server 2008 R2 operating system from the Avid Product 
Recovery flash drive:

1. Make sure all clients stop any activity, unmount their workspaces, and exit Client Manager.

2. Locate the Product Recovery Image USB flash drive with the Avid ISIS image.

3. Use the System Director Control Panel to stop the System Director.
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4. Insert the USB flash drive into the USB port in the system.

n You must enter the BIOS with USB flash drive plugged-in to set correct drive boot order.

5. Select Start > Shut Down. 

The Shut Down Windows dialog box opens.

6. Select Restart, and click OK. 

The Windows Storage Server 2008 R2 operating system restarts.

7. Press the Delete key several times during startup until you see “Entering Setup.”

8. Set the USB Drive to boot first. Navigate to the Boot tab > Hard Disk Drives > 1st Drive and 
select the default USB setting detected by the BIOS. The 2nd Drive setting changes to the 
“RAID: Intel Volume.”

n Depending on the manufacturer of the USB flash drive, this USB selection in the BIOS changes.

9. Select the Advanced tab > CPU Configuration, and make sure the hyper thread option “Intel 
HT Technology” is Disabled.

10. Select the Advanced tab > IPMI Configuration, make sure “Restore on Power Loss” is set to 
[Last State].

11. Press F10 to exit and save your changes.

The system continues to start from the USB flash drive.

Wait until two windows appear; click the blue window and select one of the available 
options:

- Recover only the OS partition.

- Recover the entire system disk.

- Exit without doing a recovery.

12. At the prompt, type the number of the operation you want to perform: 

t If you type 1 or 2, a warning screen opens, informing you that you are about to recover 
the operating system. Continue with step 13.

t If you type 3, the recovery quits to the Main menu. Type 3 again to open a command 
window. Press Ctrl+Alt+Delete to quit in any of these windows. 

13. A yellow screen appears: type Y.

14. A red screen appears: type Y.

The reimaging takes 20 to 30 minutes.
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c Do not remove the USB flash drive while performing the product recovery. If you remove 
the USB flash drive an error is displayed stating it cannot write the Ghosterr.txt file, and 
you cannot continue the process by re-installing the USB flash drive. You must start the 
recovery process from the beginning.

15. A gray screen prompts you to reboot. Type R, and quickly remove the USB flash drive from 
the system.

Configure the operating system as described in the following section. The Apply Computer 
Setup message is displayed for 3 to 5 minutes.

Configuring the System Drive Using Windows 2008 
Storage Server Setup

After you recover the Windows Storage Server 2008 R2 operating system, several system 
parameters are set including a system Disk Check. The system restarts, and you are prompted to 
enter the Windows activation key. This number is on the Windows Certificate located on the 
right side of the Engine top cover. 

To set up the Windows operating system:

1. (If removed) Reconnect all the network Ethernet cables.

2. When the Product Key screen opens, type the Product Key from the Certificate of 
Authenticity in the Product Key text box. The certificate is on the top of the Avid ISIS 
Engine. 

c The Product Key Authenticity is verified with Microsoft through an Internet connection. If 
you do not have the Avid ISIS connected to an in-house network, phone in your Product 
Key and get an Authenticity number back from Microsoft.

The Windows Storage Server 2008 R2 Setup utility starts, and the a dialog box opens 
showing the License Agreement screen.

3. Select “I accept the agreement.”

4. Click Next. 

The Avid ISIS Engine restarts (potentially more than once). 

5. Log on as Administrator (default password: is-admin).

6. After your system restarts for the last time, customize the system and local settings. See the 
Windows documentation for more information.

t If you are outside the United States, customize the system and local settings.

t Optionally, create a new system administrator name and password.
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t Enter your company name and organization.

t Set the correct date and time settings.

t Configure network workgroup and computer domain settings.

c When the operating system is restored in the Avid ISIS Engine, a unique computer host 
name is created based on the MAC ID of the system board. Each time you re-image your 
Avid ISIS Engine, the same name is generated. If you had previously changed the computer 
host name of your Avid ISIS Engine, reapply your computer host name. 

7. Start the system and install Avid ISIS software; see “Loading the Software” on page 84.



B Specifications and Notices

This section provides information on the dimensions and weight, the environmental, the 
electrical, and the power cord specifications for the Avid AS3000 when used as the ISIS | 7500 
System Director. It also recommends the use of an Uninterruptible Power Supply and supported 
network cabling.

Dimensions and Weight

Environmental

Component Dimensions and Weight  

Component Height Width Depth Weight

AS3000 System Director 1.75 in (44.4 mm) 19 in (482.6 mm) 27 in (685.8 mm) 40.0 lb (18.1 kg)
with drives installed

Environmental Specifications  

Component
Operating 
Temperature

Operating
Humidity

Storage 
Temperature

AS3000 System Director 32°F to 104°F 
(0°C to 40°C)

5% to 95% (at 38°C) 
non-condensing

–4°F to 140°F 
(–20°C to 60°C)
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Electrical

Uninterruptible Power Supply (UPS)

Avid highly recommends you create a separate derived power system for your ISIS | 7500 
System Director. This provides protection against sudden power surges or losses that could cause 
you to lose files or experience data corruption.The power outlets need to be from the same 
distribution panel. This helps prevent ground loops that can be caused by plugging equipment 
into power sources with different ground potentials. Make sure there is adequate, dedicated 
power for the UPSs.

w Have all the electrical work at your site done by a licensed electrician. The electrical 
changes must meet country, state, and local electrical codes.

The ISIS | 7500 System Director supports UPS devices that are connected using network 
connections, USB connections, and serial connections. Install the software from the UPS 
manufacturer for advanced shutdown behavior, calibrate the UPS device. These software 
packages also allow for a connected Windows server to send alerts to other Windows servers to 
perform actions.

If your ISIS | 7500 System Director is connected to a network, network policy settings might 
also prevent you from completing this procedure. Make sure there is adequate power and the 
correct receptacle type for each hardware component, the rack power strips, and the UPSes. Do 
not use extension cords to plug in any of the hardware components. 

Supported Cabling

Avid supports the following cable types for connecting an ISIS | 7500 system.

n If you need run your cable greater distances, call Avid Customer Support for supported cable 
and accessory information. 

Electrical Specifications  

Component Voltage Frequency Watts (Max. U.S.)

 AS3000 System Director 100 to 240 Vac

Two hot-swap redundant 
AC power supplies

50 to 60 Hz 650 W
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Supported Cables

Cable Connection 
Type Function

Connector Style and Maximum Cable 
Length

Avid engine interconnect 
CX-4 cable. Only available 
from Avid.

Connect engines. See “Removing 
the Avid Engine Interconnect 
Cable” on page 36 for proper 
removal.

CX-4 connector

The currently supported lengths are 1, 3, and 5 
meters.

Ethernet network cable, 
CAT5e, CAT6, or CAT6a

Connects:

• Ethernet Avid ISIS clients

• System Directors and clients 
to 1 Gb ports

• Avid Interplay servers to 
shared storage networks 

• Avid AirSpeed capture and 
playback servers to shared 
storage networks

RJ45 connector

100 Meters; If using CAT5e the cable must be rated 
for 350 MHz for maximum length. 

The minimum GigE cable length for Avid network 
products is 6 feet or 2 meter.

Optical cables Connects:

• 10 Gb port of switch to 
optical 10 Gb port on the Avid 
ISIS Engine.

• 10 Gb optical port to switch 
port

• 10 Gb optical port to 10 Gb 
Ethernet Client

• 10 Gb Client to 10 Gb Switch 
port

• 10 Gb Ethernet switch to 10 
Gb Ethernet Switch

The maximum length for 10 Gb Ethernet cable is 
defined by the core diameter (measured in microns) 
and modal bandwidth (in units of MHz*km). 

Avid supports multi-mode fiber cable using 850 nm 
transceivers (short distances). Specifications for 
these cables can be found in the ISO 11801 
structured cabling document.
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Optical cables, continued MMF 62.5 micron cable Modal Bandwidth of: 
(Overfilled Launch (OFL) Bandwidth, typical of 
OM1 cable)

• 160 MHz*km at 26 meters

• 200 MHz*km at 33 meters

MMF 50 micron cable Modal Bandwidth of: 

• 500 MHz*km at 82 meters (Overfilled Launch 
Bandwidth, typical of OM2 cable) 

• 2000 MHz*km at 300 meters (Effective Modal 
Bandwidth, typical of OM3 cable)

Avid supports single-mode fiber cable using 
1310 nm transceivers (long distances):

• SMF ITU G.652.A/B 9 micron cable up to 10 km

c When connecting to the 10 Gb port, follow two rules: 
– Make sure that the cable has the required modal bandwidth for the distance of the run.
– Make sure that all multimode cables between an switch port and the other end of the cable run are of 
the same diameter (for example, 50/125 um or 62.5/125 um).

w Single mode transceivers are Class 1 laser product per IEC 60825-1 Amendment 2(2001) and IEC 
60825-2 1997. Operating this product in a manner inconsistent with intended usage and specification 
may result in hazardous radiation exposure. 

Supported Cables

Cable Connection 
Type Function

Connector Style and Maximum Cable 
Length
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Avid ISIS 
X2 optical transceivers

Transceiver used in:

Cisco® 4948 and 4900M

SC connector

X2 = Cisco X2-10GB-SR for MMF 
X2 = Cisco X2-10GB-LR for SMF

n The minimum cable length for -LR and -SR 
transceivers is 2 Meters.

Avid ISIS 
XFP optical transceivers

Transceiver used in:

Dell Networking S60 switches 

ISIS 7000 (ISS1000)

LC connector

XFP = 10G-XFP-SR for MMF
XFP = 10G-XFP-LR for SMF

XFP = 10G-XFP-SR 
or Picolight XXL-SC-S45-21 for MMF

XFP = 10G-XFP-LR 
or Bookham 10G-BASE-LR for SMF

n The minimum cable length for -LR and -SR 
transceivers is 2 Meters.

Avid ISIS 
SFP+ optical transceivers

Transceiver used in:

ISIS | 7500 - 7000 (ISS2000)

ISIS | 2500 - 2000 (System 
Director)

Dell Networking S4810 switches

LC connector

• SFP+ multi-mode short range (SR) 850nm

JDS – PLRXPL-SC-S43-21-N
JDS – PLRXPL-SC-S43-22-N
Avago – AFBR-700SDZ
Avago – AFBR-703SDZ

• SFP+ long range (LR)

Finisar FTLX1471D3BCL for SMF
Avago AFCT-701SDZ for SMF
JDSU JSH-01LWAA1 for SMF

n The minimum cable length for -LR and -SR 
transceivers is 2 Meters.

Avid ISIS 
SFP optical transceivers

Transceiver used in:

Dell Networking optical switch

LC connector

• SFP 1000BASE-SX short range (SR) 

Dell Networking GP-SFP2-1S 

n The minimum cable length for -LR and -SR 
transceivers is 2 Meters.

Supported Cables

Cable Connection 
Type Function

Connector Style and Maximum Cable 
Length



C Safety and Regulatory Information

This document contains safety and regulatory information for Avid hardware.

• Warnings and Cautions

• Proposition 65 Warning

• FCC Notice

• Canadian Notice (Avis Canadien)

• LED Safety Notices

• European Union Declaration of Conformity

• Disposal of Waste Equipment by Users in the European Union

• Argentina Conformity

• Australia and New Zealand EMC Regulations

• Japan EMC Regulations

• Korean EMC Regulations

• Taiwan EMC Regulations

Warnings and Cautions

c This equipment is intended only for installation in a RESTRICTED ACCESS 
LOCATION.

c Never install equipment if it appears damaged.

c Disconnect the power cord before servicing unit.

c Only perform the services explicitly described in this document. For services or procedures 
not outlined in this document, speak with authorized Avid service personnel.

c Follow all warnings and cautions in the procedures.

c Operate the device within its marked electrical ratings and product usage instructions.
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c If you need to replace a battery in an Avid hardware unit, be sure to use the correct battery 
type. There might be a risk of explosion if a battery is replaced by an incorrect type. 
Dispose of used batteries according to the manufacturer's instructions.

c For products with a power switch the main power switch should remain accessible after 
installation.

Proposition 65 Warning
This product contains chemicals known to the State of California to cause cancer and birth 
defects or other reproductive harm. 

FCC Notice
Part 15 of the Federal Communication Commission Rules and Regulations has established Radio 
Frequency (RF) emission limits to provide an interference free radio frequency spectrum. Many 
electronic devices produce RF energy incidental to their intended purpose. 

Class A Equipment

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used 
in accordance with the instructions, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference, in which 
case the user will be required to correct the interference at personal expense.

Modifications

The FCC requires the user to be notified that any changes or modifications made to Avid 
hardware that are not expressly approved by Avid Technology may void the user’s authority to 
operate the equipment.

Cables

Connections to Avid hardware must be made with shielded cables with metallic RFI/EMI 
connector hoods in order to maintain compliance with FCC Rules and Regulations.



Canadian Notice (Avis Canadien)

191

Canadian Notice (Avis Canadien)

Class A Equipment

This Class A digital apparatus meets all requirements of the Canadian Interference-Causing 
Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel 
brouilleur du Canada.

LED Safety Notices

Avid hardware might contain LED or Laser devices for communication use. These devices are 
compliant with the requirements for Class 1 LED and Laser Products and are safe in the intended 
use. In normal operation the output of these laser devices does not exceed the exposure limit of 
the eye and cannot cause harm.

Standard to which conformity is declared: (Class 1 LED Product per IEC 60825-1:2007)

European Union Declaration of Conformity

Declaration of conformity
Konformitätserklärung
Déclaration de conformité
Declaración de Confomidad
Verklaring de overeenstemming
Dichiarazione di conformità

We/Wir/Nous/WIJ/Noi:



European Union Declaration of Conformity

192

Avid Technology
75 Network Drive
Burlington, MA, 01803 USA

European Contact: Nearest Avid Sales and Service Office or
Avid Technology International B.V.
Sandyford Industrial Estate
Unit 38, Carmanhall Road
Dublin 18, Ireland

declare under our sole responsibility that the product,
erklären, in alleniniger Verantwortung,daß dieses Produkt,
déclarons sous notre seule responsabilité que le produit,
declaramos, bajo nuestra sola responsabilidad, que el producto,
verklaren onder onze verantwoordelijkheid, dat het product,
dichiariamo sotto nostra unica responsabilità, che il prodotto,

Product Name(s): ISIS | 7500

Model Number(s): 7020-30088-XX

Product Option(s): This declaration covers all options for the above product(s).

to which this declaration relates is in conformity with the following standard(s) or other 
normative documents.
auf das sich diese Erklärung bezieht, mit der/den folgenden Norm(en) oder Richtlinie(n) 
übereinstimmt.
auquel se réfère cette déclaration est conforme à la (aux) norme(s) ou au(x) document(s) 
normatif(s).
al que se refiere esta declaración es conforme a la(s) norma(s) u otro(s) documento(s) 
normativo(s).
waarnaar deze verklaring verwijst, aan de volende norm(en) of richtlijn(en) beantwoordt.
a cui si  riferisce questa dichiarazione è conforme alla/e seguente/i norma/o documento/i 
normativo/i.

The requirements of the European Council:

Safety: Directive 2006/95/EC

UL 60950-1, 2nd edition
CAN/CSA-C22.2 No. 60950-1-07; 2007
IEC 60950-1, 2nd edition
EN 60950-1:2006

EMC: Directive 2004/108/EC
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EN55022:2006 /A1:2007
EN55024:1998 /A1:2001 /A2:2003
EN61000-3-2:2006
EN61000-3-3:2008

Gerrett Durling, VP of Engineering, Shared Services

Issued In Burlington MA, USA 2010

Disposal of Waste Equipment by Users in the 
European Union

This symbol on the product or its packaging indicates that this product must not be disposed of 
with other waste. Instead, it is your responsibility to dispose of your waste equipment by handing 
it over to a designated collection point for the recycling of waste electrical and electronic 
equipment. The separate collection and recycling of your waste equipment at the time of disposal 
will help conserve natural resources and ensure that it is recycled in a manner that protects 
human health and the environment. For more information about where you can drop off your 
waste equipment for recycling, please contact your local city recycling office or the dealer from 
whom you purchased the product.

Argentina Conformity

Made in USA

Australia and New Zealand EMC Regulations
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Ken Hopkins
Avid Technology (Aust) Pty Ltd
c/o – Elliot House
Suite 810, Level 8
140 Arther St
North Sydney
NSW – 2060

Japan EMC Regulations

Class A Equipment

This is a Class A product. In a domestic environment this product may cause radio interference 
in which case the user may be required to take corrective actions. VCCI-A

Korean EMC Regulations

Class A Equipment

Please note that this equipment has obtained EMC registration for commercial use. In the event 
that it has been mistakenly sold or purchased, please exchange it for equipment certified for 
home use.
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Taiwan EMC Regulations
Taiwan EMC Regulations BSMI Class A EMC Warning

Warning Statement

1. UV ray radiation

- Following statement or equivalent:

- Following marking or other equivalent marking:

2. Operator touchable area protection

Operation manual should have following statement and statement should be shown on 
device, or put on similar sentence:

3. Heat-related hazards
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Injury may result from high temperatures under normal operating conditions, causing:

- Burns due to contact with hot accessible parts

- Degradation of insulation and of safety-critical components

- Ignition of flammable liquids

Examples of measures to reduce risks include:

- Taking steps to avoid high temperature of accessible parts

- Avoiding temperatures above the ignition point of liquids

- Provision of marking to warn USERS where access to hot parts is unavoidable

High temperature warning marking — you may use the following high temperature warning 
marking:

4. Mechanical hazards

Injury may result from:

- Sharp edges and corners

- Moving parts which have the potential to cause injury

- Equipment instability

- Flying particles from imploding cathode ray tubes and exploding high pressure lamps

Examples of measures to reduce risks include:

- Rounding of sharp edges and corners

- Guarding

- Provision of SAFETY INTERLOCKS

- Providing sufficient stability to free-standing equipment

- Selecting cathode ray tubes and high pressure lamps that are resistant to implosion and 
explosion respectively

- Provision of markings to warn USERS where access is unavoidable

5. Radiation

Injury to USERS and to SERVICE PERSONS may result from some forms of radiation 
emitted by equipment.
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Examples are sonic (acoustic), radio frequency, infra-red, ultraviolet and ionizing radiation, 
and high intensity visible and coherent light (lasers).

Examples of measures to reduce risks include:

- Limiting the energy level of potential radiation sources

- Screening radiation sources

- Provision of SAFETY INTERLOCKS

- Provision of markings to warn USERS where exposure to the radiation hazard is 
unavoidable

6. Chemical hazards

Injury may result from contact with some chemicals or from inhalation of their vapors and 
fumes.

Examples of measures to reduce risks include:

- Avoiding the use of constructional and consumable materials likely to cause injury by 
contact or inhalation during intended and normal conditions of use

- Avoiding conditions likely to cause leakage or vaporization

- Provision of markings to warn USERS about the hazards

7. Safety warning statement for equipment that is under hazardous voltages

8. Equipment with touch current exceeding 3.5 mA

One of the following labels, or a label with similar wording, shall be affixed adjacent to the 
equipment AC MAINS SUPPLY connection:

9. An EUT that provides TELECOMMUNICATIONS NETWORK connection ports for 
connection of multiple items of other telecommunications equipment shall not create a 
hazard for USERS and TELECOMMUNICATIONS NETWORK SERVICE 
PERSONS due to summation of TOUCH CURRENT
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10. Replaceable batteries

If an equipment is provided with a replaceable battery, and if replacement by an incorrect 
type could result in an explosion (for example, with some lithium batteries), the following 
applies:

- If the battery is placed in an OPERATOR ACCESS AREA, there shall be a marking 
close to the battery or a statement in both the operating and the servicing instructions

- If the battery is placed elsewhere in the equipment, there shall be a marking close to the 
battery or a statement in the servicing instructions

The marking or statement shall include the following or similar text:
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11. Warning to service persons

Suitable markings shall be provided on the equipment or a statement shall be provided in the 
servicing instructions to alert a SERVICE PERSON to a possible hazard, where both of the 
following conditions exist:

- Where a fuse is used in the neutral of single-phase equipment either permanently 
connected or provided with a non-reversible plug

- Where, after operation of the fuse, parts of the equipment that remain energized might 
represent a hazard during servicing

The following or similar wording is regarded as suitable:
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10 GbE link aggregation maintenance 167

A
Access to system 50
Activating software 98

without Internet connection 100
Activation ID 98
Adding an engine 170
Adding hardware 169
Addresses, virtual 118, 119
Administrator

password 180
password (Management Console) 88

Application key
install 86
see License key 85

Argentina Conformity 194
Australia EMC regulations 195
Avago, SFP+ 188
Avid

online support 13
training services 14

AvidISISSetup.exe file 84, 142

B
Bind Storage Managers 88
Boards, space for changing 50
Button

NMI 19
power 19
system reset 19, 19

C
Cables

Category 5 or 6 186
connecting 36
CX-4 186
described 35
interconnect 22
length 186
micron 186
multi-mode fiber 186
OM2, OM3 186
optical 186
removing interconnect 36
space for connecting 50
specifications 186
supported 185

Canadian notice 191
Category 5 or 6 cables 186
Chassis See Engine
Checklist

health of system 136, 169
new install 42
preupgrade 130
software 40

Cisco 188, 188, 188, 188
Cisco switches and link aggregation 167
Clearance 50
Client

architecture 28
maximum 28
Zone 1 29
Zone 1 and 2 33
Zone 2 31
Zone 3 and 4 34

Client Manager
documentation 13

Index
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Client Manager maintenance 163
Complete shutdown 163
Components, space for changing 50
Configure

System Director Control Panel 87, 117, 119, 123, 
176

Virtual Addresses 118, 119
virtual name 87, 117, 119, 123, 176
Windows operating system 182

Connecting cables 36, 50
Connector

interconnect 23
USB 18

Control panel
System Director 18, 87, 117, 119, 123, 158, 176

Create
New Active file system 87, 118, 121, 141, 177

Create New Active 87, 117, 119, 123, 176
Crossover connection validation 120
CX-4 cable 186

D
Daily maintenance 158
Deactivate License software 103
Dell Networking

connectors and cables 188
Device ID 98
Diagnostics

switch 159
switch infrastructure 149

Dimensions 184
Documentation

client software 13
Drive

activity 19
flash 180

Dump metadata 87, 117, 119, 123, 176

E
EIA rack units 49
Engine

adding 170
front view 20
interconnect 23
interconnect cable removal 36

power supplies 21
rear view 21
replacement 172

Environmental requirements 184
Ethernet switches 22
European Union notice 192

F
Failover

described 20
System Director 160

Fans 22
FCC notice 190, 190
File system 44
Firmware

incompatible 169
utility 151

Flash drive, recovery 180
Foundry 22
Front panel controls, System Director 18
Full Redistribution 160, 160

G
Green LEDs 19

H
Hardware, adding components 169
Health check 136, 169
Host name change, System Director 103

I
Indirect license activation 100
Infrastructure diagnostics 149, 159
Installation, in a rack 49
Integrated switch 22
Interconnect

cable 22
connectors 23

ISB (ISIS Storage Blade)
described 16
function 20, 20
password 68, 74
slot positions 20
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ISS (ISIS Integrated Switch)
described 16
LED 22
location 21

IXS (ISIS Expansion Switch)
described 16, 23
function 20
LEDs 23
location 21

J
Japan notice 195
JDSU 188
JDSU, SFP+ 188, 188

K
Korean notice 195
KVM switch 61

L
Launch pad icon 89, 122
LED

IXS (ISIS Expansion Switch) 23
system drive 19
system ID 19
system status 19

Length, cable 186
License key

activation 85
License software

activation 98
deactivate 103
host name change 103

link aggregation
Cisco switches 167

link aggretation
maintenance 167

Log in 88, 88

M
Maintenance

check system health 136, 169
Client Manager 163

daily 158
monthly 160
weekly 159

Management connection 22
Management Console

bind 88
password 88

Maximum
number of clients 28

Maximum capacity 23
Maximum length 186
Micron cable 186
Modal bandwidth 187
Monitor, VGA connector 61
Monthly maintenance 160
Multi-mode fiber cable 186

N
Naming convention 15
Network

activity LEDs 19
zones 29

New install checklist 42
New Zealand EMC regulations 195
NMI (non-maskable interrupt) button 18
Nomenclature 15

O
Online support 13
Operating system

configure 182
reinstall 181

Optical cable 22, 186
Optical transceivers 188, 188, 188

P
Packets received 121
Password

administrator 180
ISB 68, 74
Management Console 88
storage blade 128
switch 128
System Director 17, 68, 128
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PathDiag Tool 148
Picolight 22
Port, management 22
Power

button 19
cord connection 63
specifications 185

Power supply
described 22
location 21

Preupgrade information 130
Product descriptions 15
Product recovery, flash drive 180

R
Rack

installation 57
mounting instructions 49
position 51
rack units 51
requirements 50

Rear panel, System Director 19
Received packets 121
Recommended maintenance 157
Recovery flash drive 180
Recreating file system 44
Red LED 19
Redistribution 160, 160
Regulatory information 190, 190
Reinstall Windows 181
Replace

engine 172
switch 171, 179

Requirements for rack mounting 50

S
Safety information 190, 190
Server room shutdown 163
Servicing, space for 50
SFP+ 22, 188, 188, 188, 188, 188, 188
Shutdown server room 163
Snapshot tool 160
Software

license 98
Software upgrade 40

Space for changing components 50
Specifications

dimensions and weights 184
environmental 184
power 185

Status messages
Storage Managers 158

Stop System Director 87, 117, 119, 123, 176
Stop/Start server 87, 141, 176
Storage blade password 68, 74, 128
Storage Groups

adding ISBs 24
size 24

Storage limit 23
Storage Managers 24

See also ISB
status 158

Supported cables 185
Switch

adding 169
described 22
diagnostics 149
firmware utility 151
infrastructure diagnostics 159
KVM 61
replacement 169, 171, 179

Switch Agent page 172
Switch blade password 128
System

drive LED 19
ID LED 19
reset button 19, 19
status LED 19

System Director
2U rack size 17
Control Panel 87, 117, 119, 123, 158, 176
Create New Active file system 87, 118, 121, 141, 

177
failover 160
front control panel 18
front view 18
host name change 103
log in 88, 88
password 17, 68, 88, 88, 128
rear panel 19
recovery 180
second 20
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stop/start service 87, 141, 176
System disk 18
System error 19
System ID 98

T
Taiwan EMC regulations 196
Task bar icon 89, 122
Training services 14
Transceivers 22, 187, 188, 188
Troubleshooting 13

check health 136, 169
recommended maintenance 157

U
Upgrade

checklist 40
firmware utility 151
post upgrade verification 147
preupgrade checklist 130
See also Upgrade Utility
software 40

Upgrade utility
functional description 151
location 155
main window 153
overview 151
procedure for running 155
software interface 153

USB (universal serial bus)
connector 18
flash drive 180
keyboard and mouse 61
port described 18

Utility
upgrade firmware 151

V
Validate crossover connection 120
Verification of upgrade 147
VGA monitor 61
Virtual Addresses, configure 118, 119
Virtual name 87, 117, 119, 123, 176

W
Weekly maintenance 159
Weight 184
Windows

event logs 159
reinstall 181

X
XFP 22
XFP transceivers 188

Z
Zone 1 and 2 (mixed) clients 33
Zone 1 clients 29
Zone 2 clients 31
Zone 3 and 4 clients 34
Zone examples 29
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Technical Support (USA)
Visit the Online Support Center at 
www.avid.com/support

Product Information
For company and product information, 
visit us on the web at www.avid.com
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